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The 20th century brought us the dawn of the digital information age and
unprecedented changes in information technology. There is no indication
that this rapid rate of change will be slowing—it may even be increasing.
As we begin the 21st century, computer literacy is undoubtedly becoming
a prerequisite in whatever career you choose.

The goal of the O’Leary Series is to provide you with the necessary
skills to efficiently use these applications. Equally important is the goal to
provide a foundation for students to readily and easily learn to use future
versions of this software. This series does this by providing detailed step-
by-step instructions combined with careful selection and presentation of
essential concepts.

Times are changing, technology is changing, and this text is changing
too. As students of today, you are different from those of yesterday. You
put much effort toward the things that interest you and the things that are
relevant to you. Your efforts directed at learning application programs and
exploring the Web seem, at times, limitless.

On the other hand, students often can be shortsighted, thinking that
learning the skills to use the application is the only objective. The mission
of the series is to build upon and extend this interest by not only teaching
the specific application skills but by introducing the concepts that are
common to all applications, providing students with the confidence,
knowledge, and ability to easily learn the next generation of applications.

Instructor’s Resource CD-ROM

The Instructor’s Resource CD-ROM contains a computerized Test Bank,
an Instructor’s Manual, and PowerPoint Presentation Slides. Features of
the Instructor’s Resource are described below.

e Instructor’s Manual CD-ROM The Instructor’s Manual, authored by
Harry Knight of Franklin University, contains lab objectives, concepts,
outlines, lecture notes, and command summaries. Also included are
answers to all end-of-chapter material, tips for covering difficult mate-
rials, additional exercises, and a schedule showing how much time is
required to cover text material.

e Computerized Test Bank The test bank, authored by Harry Knight,
contains over 1,300 multiple choice, true/false, and discussion ques-
tions. Each question will be accompanied by the correct answer, the
level of learning difficulty, and corresponding page references. Our
flexible Diploma software allows you to easily generate custom exams.

Preface
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e PowerPoint Presentation Slides The presentation slides, authored
by Linda Mehlinger of Morgan State University, include lab objectives,
concepts, outlines, text figures, and speaker’s notes. Also included are
bullets to illustrate key terms and FAQs.

o Online Learning Center/Web Site

Found at www.mhhe.com/oleary, this site provides additional learning
and instructional tools to enhance the comprehension of the text. The
OLC/Web Site is divided into these three areas:

e Information Center Contains core information about the text, sup-
plements, and the authors.

e Instructor Center Offers instructional materials, downloads, and
other relevant links for professors.

e Student Center Contains data files, chapter competencies, chapter
concepts, self-quizzes, flashcards, additional Web links, and more.

Simnet Assessment for Office Applications

Simnet Assessment for Office Applications provides a way for you to test
students’ software skills in a simulated environment. Simnet is available
for Microsoft Office 2007 and provides flexbility for you in your
applications course by offering:

Pre-testing options

Post-testing options

Course placement testing

Diagnostic capabilities to reinforce skills
Web delivery of test

MCAS preparation exams

Learning verification reports

For more information on skills assessment software, please contact your
local sales representative, or visit us at www.mhhe.com.

O’Leary Series

The O’Leary Application Series for Microsoft Office is available separately
or packaged with Computing Essentials. The O'Leary Application Series
offers a step-by-step approach to learning computer applications and is
available in both brief and introductory versions. The introductory books
are MCAS Certified and prepare students for the Microsoft Certified
Applications Specialist exam.



o Computing Goncepts

Computing Essentials 2008 offers a unique, visual orientation that gives
students a basic understanding of computing concepts. Computing
Essentials encourages “active” learning with exercises, explorations, visual
illustrations, and inclusion of screen shots and numbered steps. While
combining the “active” learning style with current topics and technology,
this text provides an accurate snapshot of computing trends. When
bundled with software application lab manuals, students are given a
complete representation of the fundamental issues surrounding the
personal computing environment.



GUIDE TO THE O’LEARY SERIES

The O’Leary Series is full of features designed to make learning productive and hassle free. On the following
pages you will see the kind of engaging, helpful pedagogical features that have helped countless students mas-

ter

Microsoft Office Applications.

EASY-TO-FOLLOW INTRODUCTORY MATERIALS

INTRODUCTION TO
MICROSOFT OFFICE 2007

Each text in the O’Leary Series opens with
an Introduction to Office 2007, providing

a complete overview of this version of the
Microsoft Office Suite.

Overview of Microsoft Office Word 20

What Is Word Processing?

Office Word 2007 is a word processing software application whose pr
is to help you create any type of written communication. A word pr
can be used to manipulate text data to produce a letter, a report, a
an e-mail message, or any other type of correspondence. Text data|
letter, number, or symbol that you can type on a keyboard. The grou
the text data to form words, sentences, paragraphs, and pages
results in the creation of a document. Through a word processor,
create, modify, store, retrieve, and print part or all of a document.

Word processors are one of the most widely used application software
programs. Putting your thoughts in writing, from the simplest note to the
‘most complex book, is a time-consuming process. Even more time-consuming
is the task of editing and retyping the document to make it better. Word
processors make errors nearly nonexistent—not because they are not made,
but because they are easy to correct. Word processors let you throw away the
correction fluid, scissors, paste, and erasers. Now, with a few keystrokes, you
can easily correct errors, move paragraphs, and reprint your document.

Word 2007 Features

‘Word 2007 excels in its ability to change or edit a document. Editing involves
correcting spelling, grammar, and sentence-structure errors. In addition, you
can easily revise or update existing text by inserting or deleting text. For
example, a document that lists prices can easily be updated to reflect new
prices. A document that details procedures can be revised by deleting old
procedures and inserting new ones. This is especially helpful when a
document is used repeatedly. Rather than recreating the whole document,
you change only the parts that need to be revised.

Revision also includes the rearrangement of selected areas of text. For
example, while writing a report, you may decide to change the location of
a single word or several paragraphs or pages of text. You can do it easily
by cutting or removing selected text from one location, then pasting or
placing the selected text in another location. The selection also can be
copied from one document to another.

To help you produce a perfect document, Word 2007 includes many
additional support features. The AutoCorrect feature checks the spelling
and grammar in a document as text is entered. Many common errors are
corrected automatically for you. Others are identified and a correction
suggested. A thesaurus can be used to display alternative words that have
a meaning similar or opposite to a word you entered. A Find and Replace
feature can be used to quickly locate specified text and replace it with
other text throughout a document. In addition, Word 2007 includes a

1.2
‘Word 2007

What Is the 2007 Microsoft Office System?

Microsoft’s 2007 Microsoft Office System is a comprehensive, integrated
system of programs, servers, and services designed to solve a wide array of
business needs. Although the programs can be used individually, they are
designed to work together seamlessly, making it easy to connect people and
organizations to information, business processes, and each other. The
applications include tools used to create, discuss, communicate, and
manage projects. If you share a lot of documents with other people, these
features facilitate access to common documents. This version has an
entirely new user interface that is designed to make it easier to perform
tasks and help users more quickly take advantage of all the features in the
applications. In addition, the communication and collaboration features
and integration with the World Wide Web have been expanded and refined.

The 2007 Microsoft Office System is packaged in several different
combinations of programs or suites. The major programs and a brief
description are provided in the following table.

Program Description

Word 2007 Word Processor program used to create text-
based documents

Excel 2007 Spreadsheet program used to analyze
numerical data

Access 2007 Database manager used to organize, manage,
and display a database

PowerPoint 2007 Graphics presentation program used to create
presentation materials

Outlook 2007 Desktop information manager and messaging
client

InfoPath 2007 Used to create XML forms and documents

OneNote 2007 Note-taking and information organization
tools

Publisher 2007 Tools to create and distribute publications for

print, Web, and e-mail

Visio 2007 Diagramming and data visualization tools

SharePoint Designer 2007 Web site development and management for
SharePoint servers

Project 2007 Project management tools

Groove 2007 Collaboration program that enables teams to
work together

The four main components of Microsoft Office 2007—Word, Excel,
Access, and PowerPoint—are the applications you will learn about in this
series of labs. They are described in more detail in the following sections.

Introduction to Microsoft Office 2007 o T

INTRODUCTION TO
WORD 2007

Each text in the O’Leary Series
also provides an overview of the
specific application features.




ENGAGING LAB INTRODUCTIONS

Revising and Refining
a Document

Objectives

Aftr completing thislab, you wil know how o

Use the Spelling and Grammar tool and the Thesaurus.

Q050

love, cut, and copy fext and formats.

Control document paging.

(=]

ind and replace text.

(]

sert the current date.

(-]

hange indents, line spacing, and margins.

reate a tabbed table.

o

=

dd color highlighting and underlines.

reate numbered and bulleted lists.

(]

reate and use Building Blocks.

=]

Insert and modify  shape.
dit

Edit in Print Preview.

Print a document.

B2

OBJECTIVES

( Each lab opens with a list of objectives clearly

outlining skills covered in each lab.

CASE STUDIES

g
Case studies introduce a real-life

setting that is interwoven throughout

the lab. Four separate running cases
provide the basis for understanding
the use of applications.

(Final solution screen Shots of the major

Graphic enhancements such as shapes add interest
to 3 document.

w23

features and the final document allow you to
preview what will be accomplished.




NUMBERED AND BULLETED STEPS

Numbered and bulleted steps provide
clear step-by-step instructions on how

to complete a task, or series of tasks.

Find a bttor word |

g 4 4/

Indent paragraphs | St N
[

e by 1 e & P8 e i
o

g e v
e e

B o ———
e £ 1 T e T 1 o

e

S

T G T M ML

o= __,{... _

Make bulloted ist |_|
and sort

Add closing —{————a

Spell

A S e Y e

A £ R R—
B i

—— RO =
e e B e DT

—
P T

ok T | Find and replace
— | with "tour”
s i T s e+ b

P

The first correction you want to make is to clean up the spelling and
grammar errors that Word has identified

the Entire

Start Office Word 2007  |* % *
and open the file

All steps and bullets appear in
the left-hand margin, making
it easy not to miss a step.

' wd02_Tour Letter.

WL AR ma b B8] Many spelling and

‘grammer errors.
identified

If necessary, change
to Print Layout view at
100% zoom.

Your screen should be
similar to Figure 2.1

Open the Review tab.

Click

The keyboard shortcut is

- If necessary, select the
Check grammar option
to turn on grammar
checking.

Additional Information

You also can click the Spelling
and Grammar status icon [
to move to the next

spelling or grammar error

and open the spelling context

Your screen should be
similar to Figure 2.2

Because the contents of the

list are determined only by
spelling, any instances of
terms that seem
inappropriate in context are
completely coincidental.

The [ 7w ion
replaces the same word
throughout the document
with the word you select in
the Suggestions box.

Word 2007

Lab 2: Revising and Refining a Document

HYyey

Figure 2.1
wp2.5

Revising a Document

-1.2x checker 1o Joczte aud correct

Turns grammar
checker

on or off

Figure 2.2

The Spelling and Grammar dialog box is displayed, and the spelling and
grammar checker has immediately located the first word that may be
misspelled, “paddleing.” The sentence with the misspelled word in red is
displayed in the Not in Dictionary text box, and the word is highlighted in
the document.

The Suggestions list box displays the words the spelling checker has
located in the dictionary that most closely match the misspelled word. The
most likely match is highlighted. Sometimes the spelling checker does not
display any suggested replacements. This occurs when it cannot locate
any words in the dictionaries that are similar in spelling. If no suggestions
are provided, the Not in Dictionary text box simply displays the word that
is highlighted in the text.

To change the spelling of the word to one of the suggested spellings,
highlight the correct word in the list and then click @=w . If there
were no suggested replacements, and you did not want to use any of the
option buttons, you could edit the word yourself by typing the correction
in the Not in Dictionary box. In this case, the correct replacement,
“paddling,” is already highlighted.

www.mhhe_com/oleary

T




AND EASY-TO-FOLLOW DESIGN

TABLES

Tables provide quick summaries of
concepts and procedures for specific

tasks.

To Collapse Do This
Text below a specific heading level Select the lowest heading you want to display from
he e — drop-down menu.

All subheadings and body text under a heading  Double-click @ next to the heading.
Text under a heading, one level at a time Click the heading text, and then click [ =] Collapse.

All body text Select the heading level you want to see from the

= == drop-down menu.

All body text except first line Click [ ===+,

To Expand Do This

All headings and body text Select Show All Levels from the s ==
drop-down menu.

@ Al collapsed subheadings and body text

under a heading Double-click @ next to the heading.

Collapsed text under a heading,

one level at a time Click the heading text; then click [+] Expand

To change the amount of information displayed, you will collapse the
display of the text under the Geography and Climate heading first. Then
you will collapse everything below a level 3 heading so you can quickly
check the report organization.

Open the Review tab.

>
Click .
[Another Mcthod ]
The keyboard shortcut
If necessary, select the
Check grammar option

to turn on grammar
checking.

Additional Information

You also can click the Spelling
and Grammar status icon [T
to move to the next

spelling or grammar error
and open the spelling context

Your screen should be
similar to Figure 2.2

Additional Information
Because the contents of the
list are determined only by
spelling, any instances of
terms that seem
inappropriate in context are
completely coincidental.

nal Information

The [ #=%=" option
replaces the same word
throughout the document
with the word you select in
the Suggestions box.

Word 2007

WD2.6 Lab 2: Revising and Refinhg a Document

To correct the misspelled words and grammatical errors, you can use the
context menu to correct each individual word or error, as you learned in
Lab 1. However, in many you may find it more efficient to wait until
you are finished writing before you correct errors. Rather than continually
breaking your train of thought to correct errors as you type, you can
manually turn on the spelling and grammar checker to locate and correct
all the errors in the document at once.

spelling
and grammar
check

Suggested |
corrections

Turns grammar
checker
on or off

-

Figure 2.2

The Spelling and Grammar dialog box is displayed, and the spelling and
grammar clecker has immediately located the first word that may be
misspelled, [paddleing.” The sentence with the misspelled word in red is
displayed injthe Not in Dictionary text box, and the word is highlighted in
the documep

The Suggpstions list box displays the words the spelling checker has
located in the dictionary that most closely match the misspelled word. The
most likely thatch is highlighted. Sometimes the spelling checker does not
display any |suggested replacements. This occurs when it cannot locate
any words i the dictionaries that are similar in spelling. If no suggestions
are provided, the Not in Dictionary text box simply displays the word that
is highlighted in the text.

To chang the spelling of the word to one of the suggested spellings,
highlight thf correct word in the list and then click [ . If there
were no sugpested replacements, and you did not want to use any of the
option buttdns, you could edit the word yourself by typing the correction
in the Not|in Dictionary box. In this case, the correct replacement,
“paddling,” §s already highlighted.

www.mhhe.com/oleary
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FIGURES

content.

Large screen figures make it easy to
identify elements and read screen

SCREEN CALLOUTS

[

Meaningful screen callouts identify the
results of the steps as well as reinforce
the associated concept.

XiX
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Pressing the st [onm] ended the first lise of teat and inserted a Blank
lime. The next two inserted blank lines

Revealing Formatting Marks
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REAL-WORLD APPLICATION

The default range setting, All, is the correct setting. In the Copies
section, the default setting of one copy of the document is acceptable. You
will print using the default print settings.

If you need to change the selected printer to another printer, open the Name drop-down list box and select the
appropriate printer (your instructor will tell you which printer to select).

Click [ & .
Your printer should be printing the document. The printed copy of the
flyer should be similar to the document shown in the Case Study at the
beginning of the lab.

g Word

You are finished working on the flyer for now and want to save the last
few changes you have made to the document and close the Word applica-
tion. The [W&w#ss command in the File menu is used to quit the Word

[Another Method
The keyboard shortcut
for the Exit command is

program. Alternatively, you can click the [¥ Close button in the application
window title bar. If you attempt to close the application without first saving
your document, Word displays a warning asking if you want to save your
work. If you do not save your work and you exit the application, any
changes you made since last saving it are lost.

+
Click [+ Close.
Click [ % to save the changes you made to the file.

The Windows desktop is visible again.
If multiple Word documents are open, clicking [® closes the application
window containing the document you are viewing only.

Focus on Careers

EXPLORE YOUR CAREER OPTIONS employees. As a food service manager, your position
! would likely include creating newspaper notices and
Food Service Manager flyers to attract new staff. These flyers should be eye-
Have you noticed flyers around your campus  ciching and error-free. The typical salary range of a
advertising job positions? Many of these jobs are in the fooq service manager is $34,000 to $41.700, Demand
food service industry. Food service managers are gy gilled food service managers is expected to
traditionally responsible for overseeing the Kitchen and — incease through 2010.
dining room. However, these positions increasingly

involve administrative tasks, including recruiting new

Exiting Word

FOCUS ON CAREERS

>
Focus on Careers provides an example of

how the material covered may be applied in
the “real world.”

Each lab highlights a specific career,
ranging from forensic science technician
to food services manager, and presents job

responsibilities and salary ranges for each.

Adventure Travel Tours

CONTINUING CASE STUDIES

Within each series application, the
same Case Study is used to illustrate
concepts and procedures.

Adventure Travel Tours provides information on their
tours in a variety of forms. Travel brochures, for instance,
contain basic tour information in a promotional format
and are designed to entice potential clients to sign up
for a tour. More detailed regional information packets
are given to people who have already signed up for a
tour, so they can prepare for their vacation. These pack-
ets include facts about
each region’s climate,
geography, and cul-
ture. Additional infor-
mational formats
include pages on Ad-
venture Travel's Web
site and scheduled
group presentations.
Part of your re-
sponsibility as adver-
tising coordinator is to

WD3.2

gather the information that Adventure Travel will publi-
cize about each regional tour. Specifically, you have
been asked to provide background information for two
of the new tours: the Tanzania Safari and the Machu
Picchu trail. Because this information is used in a variety
of formats, your research needs to be easily adapted.
You will therefore present your facts in the form of a
general report on Tan-
zania and Peru.

In this lab, you will
learn to use many of
the features of Office
Word 2007 that make
it easy to create an
attractive and  well-
organized report. A
portion of the com-
pleted report is shown
here.




AND INTEGRATION

Working Together 1:
Word 2007 and

Your Web Browser

Adventure Travel Tours

The Adventure Travel Tours Web site is used to pro-
mote its products and broaden its audience of cus-
tomers. In addition to the obvious marketing and
sales potential, it provides an avenue for interaction
between the company and the customer to improve
customer service. The company also uses the Web
site to provide articles of interest to customers. The
articles, which include topics such as travel back-
ground information and descriptions, changes on a
monthly basis as an added incentive for readers to re-
turn to the site.

You want to use the flyer you developed to pro-
mote the new tours and presentations on the Web

site. To do this, you will use Word 2007’ Web-editing
features that help you create a Web page quickly and
easily. While using the Web-editing features, you will
be working with Word and with a Web browser appli-
cation. This capability of all 2007 Microsoft Office ap-
plications to work together and with other applications
makes it easy to share and exchange information be-
tween applications. Your completed Web pages are
shown here.

Note: The Working Together tutorial is designed to show how two
applications work together and to present  basic introduction to
creating Web pages,

WowT1.1

.

B

Lab Exercises

step-by-step

Adding a New Web Page %

1. You want to continue working on the Web pages about the new tour presentations for the
Adventure Travel Web site. Your next step is to create links from each loc:
Locations Web page to information about each location’s presentation date and times. Your
completed Web page for the Los Angeles area should be similar to the one shown here.

a. In Word, open the
Web page file Tour
Locations you
created in this lab.

b. Open the document
wawt_LosAngeles.
Save the document
as a Web page to

the ATT Web Page -
folder with the — -
file name LosAngeles - g
and a page tile ——
of Los Angeles

Presentation

Information.

c. Change the page
color to a gradient
fill effect of your
choice. Change the
first title line to the
Title style and the

* Easy
% % Moderate
% % % Difficult

ion on the Presentation

second title line to

a Heading 1 style. Change the title lines to a color of your choice.

e

£. On the Tour Locations page, create a link from the Los Angeles text to the Los Angeles page. Test

the link.

g Resave both Web pages and preview them in your browser. Print the Los Angeles Web page.

h. Exit the browser and Word.

. Increase the font size of the table to 12 points. Add color to the table headi
page with any features you feel are appropriate.

e. Two lines below the table, add the text Contact [your name] at (908) 555-1212 for more information.

Apply the Emphasis style to this line and increase the font size to 14 points.

. Enhance the Web

Lab Exercises WDWT1.19

Word 2007

WORKING TOGETHER LABS

.

At the completion of the brief
and introductory texts, a final lab

the
Microsoft Office applications. Each

demonstrates integration of

Working Together lab also includes
end-of-chapter materials.

[ croate hypertink |

@9 switch to the Now ‘

Tour
window. SN - l

Add the following text e . »
to the end of the last J
paragraph: Find out

about presentation
locations, dates, and
times.

e —
|
Select the text |
“locations, dates, and |
times.” o

Open the Insert tab. Seloct document
tolink o

Select [T

from the Links group.

[ Text to be used as

hyperiink !

“Anoth hod | | 5 e
The keyboard shortcut
is (G0 + K. Figure 12

Your screen should be
similar to Figure 12

From the Insert Hyperlink dialog bos, you need to specify the name of the
document you want the link to connect to.

Select Tour -
Locations.htm from e e . . i
the file list. - e e

Click - . 1
Save the document.

Your screen should be
similar to Figure 13

Hyperlink formatted |
in theme colors

Figure 13

WDWT1.12

Word 2007

Working Together 1: Word 2007 and Your Web Browser

www.mhhe.com/oleary




REINFORGED CONGEPTS

CONCEPT PREVIEW

Concept Previews provide an overview to the
concepts that will be presented throughout

the lab.

Concept Preview

The following concepts will be introduced in this lab:

Grammar Checker The grammar checker advises you of incorrect grammar as you create and
edit a document, and proposes possible corrections.

Spelling Checker The spelling checker advises you of misspelled words as you create and edit
a document, and proposes possible corrections.

AutoCorrect The AutoCorrect feature makes some basic assumptions about the text you are

CONCEPT BOXES

Concept boxes appear throughout

the lab providing clear, concise
explanations and serving as a
valuable study aid.

typing and, based on these assumptions, automatically corrects the entry.

Word Wrap The word wrap feature automatically decides where to end a line and wrap text to
the next line based on the margin settings.

Font and Font Size Font, also commonly referred to as a typeface, is a set of characters with a
specific design that has one or more font sizes.

Alignment Alignment is the positioning of text on a line between the margins or indents.
There are four types of paragraph alignment: left, centered, right, and justified.

Graphics A graphic is a nontext element or object such as a drawing or picture that can be
added to a document.

. Introducing Office Word 2007

Adventure Travel Tours has recently upgraded their computer systems at
all locations across the country. As part of the upgrade, they have installed
the latest version of the Microsoft Office 2007 suite of applications. You
are very excited to see how this new and powerful application can help
you create professional letters and reports as well as eye-catching flyers
and newsletters.

Starting Office Word 2007

€ » ik cutsie the mens 1o close 1.

@ Open the speliing confex! monu for “lern™ and choose “learn”™.

tion Microsoft Office Word 2007
and presentations.

The spelling Is comecied. and the spelling Indicator i the seatis b
indicaten that the document s froe of errom
Now you will continue entering moee of the parugraph. As you type, when
the toxt gets close to the cight margin, do ot press (o=l 1o move 1o the
neat line. Woed enatically wrasp words (0 the et line as necded
The word wrap feature automatically decides where | § & finc and wiap texl 10 the neat Bne based on

(—__www.mhhe.com/oleary )

the mavgin seatings. This feature saves time when ent et Becaune you do not neod D press (o F e
M the end of a fll Bine 10 begin a new line. The only time you need 1o pross (=] s to end a paa
graph, to lesert blank liney, of to create 2 short line such i 2 wlutation, In adéion, i e change the

margin o insert or deletr bext om 3 Bne, he progam avlomaticaly readinty the tenl on the fine 1o fit

within the

margin settiogn, Word wrao s common 1o all woed processon,

-

Entor the Tollovitng text 1o complete 1he sentence

o.h-aumbmnb 2 Dy il M

he end of the lise. | - e 4 PORY s | vttt
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| .
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REINFORCED CONCEPTS  (coninuen)

CONCEPT SUMMARIES

The Concept Summary offers a visual
summary of the concepts presented
throughout the lab.

Concept Summary

Grammar Checker (WD1.16)

The grammar checker advises you of Abiiand
incorrect grammar as you create and
edita document, and proposes possible

misspelled words as you create and edit
a document, and proposes possible
. corrections

{ g Sr——— p
\ corrections |3 [TGrammar hockr
. /
. T —
—
B |
Spelling Checker (WD1.19) C o
Thelspelling ehecker advises youlof PP PRI b A S

=

rect (WD1.21)

e AuloCorrect feature makes some 2
sic assumptions about the text you are .
T 3 ping and, based on these assumptions,
. Word Wrap  (WD1.23) iLamatically corrects the entry. J P —
PO IROVE b A A ~ e word wrap feature automatieally
decides where to end a line and wraps. o
text to the next line based on the

AutoCorrect

margin settings.

e [ Worawiop |
O ——— S - ¢

Lab 1: Creating and Editing a Document

b Fonts and Font Size_(WD1.46) )

(__www.mhhe com/oleary )

PTORE b & g Afont, also commonly referred to as a
typeface, is a set of characters with a
specific design that has one or more

— font sizes.
Fontsand font size J

‘ \Mwmm- ‘vrwves Tours Alignment _(WD1.56) )
New Adventores Alignment is the positioning of text on a

line between the margins or indents.

Alignment There are four types of paragraph
alignment: left, centered, right, and
_justified

Graphics  ( 59) ]

A graphic is a nontext element or object
such as a drawing or picture that can be
added to a document.

Yirw Adve '
' ' -

Concept Summary WD1.73
Word 2007




LAB REVIEW

KEY TERMS

Includes a list of all bolded
terms with page references.

L L

COMMAND SUMMARY

command summary

Command Shorteut Action
Opens
+N ‘Opens new blank document
@+ 0 Opens existing document file
+s Saves document using same file name

+P Prints document

Brepare/Broperties

Opens Document Information Panel

Close [ +[FE)  Closes document
o & + ED Exit Word application

Paragraph group
[E] show/Hide +*  Displays or hides formatting marks
lign Text Left (Gl L

Algns text to left margin
enter Centers text between left and right margins

[ Align Text Right

Justify

Tab

Aligns text to right margin

Aligns text equally between left and right margin|

lllustrations group
Inserts selected picture

Saves document using 2 new file name, type, and/or location

Quick Access Toolbar

FED +s Saves document using same file name

7 Undo Restores last eciting change

[ Redo Y Restores last Undo or repeats last command o action
ey

Font Group

= font Changes typeface

Flsie Changes font size

[E Clear Formatting Remove all formatting from selection

[Esold +B Adds/removes bold effect

= G + | Adds/removes italic effect

I= change Case Changes case of selected text

[ Color Changes text o sslected color

Lab Review

END-OF-CHAPTER
MATERIALS

Word 2007

Lab Exercises

Match the item on the left with the correct description on the right.
=] a. undocs last command

2. font b. m

s to the top of the document

3. sans serif

right margin

alignment
G@+h

a pictures and clip art
5.

6. graphics

7.

8.

shows dialog box
type style that can be applied to text
=

word wrap

font size measurement

Fmome 8

9. point . saves a docum

10. % j- font without a fla

ssing the sam

multiple choice

Circle the correct response to the questions below:

1. Document development follows these steps.
a. plan, edit, enter, format, preview, and print
b. enter, edit, format, preview, and print
<. plan, e

edit, format, preview, and print
dit, format, preview, and print

»

The feature makes some basic assumptions about the text enter
changes based on those assumptions,

€. AutoText
d. AutoCorrect

Wp1.78 Lab 1: Cresting and Editing  Document

Lab Exercises reinforce the terminology and
concepts presented in the lab through Screen
Identification, Matching, Multiple Choice, True/

False, and Fill-In questions.

~

__ c. feature that automatically begins a new line when text reaches the

controls paragraph positioning between the margins

¢ file name

Word 2007

Lab Exercises

1. In the following Word screen, letters identify important elements. Enter the correct term for each
screen element in the space provided.

H]

£

Lab Exercises

9. A set of characters with a specific design is called a(n)

a. style

b. font

c. AutoFormat
d. Design

s

a. graphic
b. watermark
c. embedded object
d. thumbnail

true/false

Circle the c:

et answer to the following questions.

A wavy red line indicates a potential spelling error

Hard spaces are used to justify text on a line.

‘The default document settings are stored in the Normal.docs file.
‘The (Beles) key erases the
‘The automatic word wrap

racter to the right of the insertion point.

re checks for typing errors.
‘The Word document file name extension is wrd.
Font sizes are measured in inches,

O E N MW

The AutoCorrect feature automatically identifies and corrects certain
types of errors.

:

Aselected picture is surrounded by a selection rectangle and eight
moving handles.

Wp1.80 Lab 1: Creating and Editing a Document

§£23
32

sl
78

Word inserts hidden marks into a document to control the display of text

Am) is text or pictures that appear behind document text

True
True
True
True
True
True
True
True

True

ase

False
False
False
False
False
False
False
False

False

False

e comToTeary

( Command Summaries provide a table of commands,
shortcuts, and their associated action for all commands
used in the lab.

wo1.77
Wiord 2007




AND SKILL DEVELOPMENT

LAB EXERCISES

Ve

ON YOUR OWN

STEP-BY-STEP

Lab Exercises

Creating a Flyer *
1. Adventure Travel Tours is offering a great deal on a Day of the Dead Bicycle Tour in Mexico,
Research the Day of the Dead celebration using the Web as a resource. Then, using the features of
flyer that will advertise this tour. Be sure to use at least two,
colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from the
Clip Organiz Tnclude your name in the file
properties as author and the file name as the title. Save the document as Mexico Adventure.

Creating a Swimming Pool Rules Flyer % *
2. You work in the community pool and have been asked to create a flyer to post that identifies the rules

swimmers should follow when using the pool. Create a flyer that explains the five most important
1ules to follow while swimming at the pool. Use a piece of clip art toli
different font sizes, paragraph alignments, and other formatting features to make the flyer attractive,
Apply different font colors for cach rule. Include a page border. Include your name at the bottom of
the flyer. Include your name in the file properties as author and the file name as the title. Save the
document as Pool Rules;

Astronomy Class Memo * %

3. The city of Gilbert, Arizona, has recently built a $100,000 observatory that includes a $20,000
telescope in a local park. The observatory is open evenings for small groups of five to six people to
take turns looking through the 16-inch telescope’s eyepiece. The use of the observatory

‘The city has decided to offer classes for the community to learn how to use the telescope and to
teach about astronomy: As a trial run, the class will first be offered to city employees and their familics.
You want to notify all employees about the obsc:
paycheck. Using Hands-On Exercise 1 as a model, provide information about when and where the
class will be held. Include information about how people sign up for the class. Include your name in
the file properties as author and the file name as the title. Save the memo as Astronomy Bascs

Volunteer Opportunities * % %
4. Many community groups, hospitals, libraries, and churches are looking for volunteers to assist in
their programs. Volunteering has rewards for both the volunteer and the community. Using the
Web as a resource, research volunteer opportunities in your community. Then write a one-page

report that includes information about two volunteer groups for which you would like to
volunteer. Include information about what the organization does for the community. Also include
the skills you have to offer and the amount of time you can commit as volunteer: Include a title at
the top of the document and your name and the current date below the title. Center the title lin
Use at least two colors of text, two sizes of text, and two kinds of paragraph alignment. Include a
graphic from the Clip Organizer. Include your name in the file properties as author and the file
name as the title. Save the document as Volunteer Opportuniies.

Writing a Career Report * % %
5. Using the library or the Web, research information about your chosen career. Write a one-page report
about your findings that includes information on three areas: Career Description; Educational
Requirements; Salary and Employment projections. Include a ttle at the top of the document and your
name and the current date below the title. Center the title lines. Justify the paragraphs. Include your
name in the file properties as author and the file name as the title. Save the document as Career Repor,

w188 Lab 1: Creating and Editing a Document

Word 2007

RATING SYSTEM

Lab Exercises provide hands-on practice and develop critical-
thinking skills through step-by-step and on-your-own practice
exercises. Many cases in the practice exercises tie to a running
case used in another application lab. This helps demonstrate the
use of the four applications across a common case setting. For
example, the Adventure Tours case used in Word is continued
in practice exercises in Excel, Access, and PowerPoint.

Lab Exercises

Hands-On Exercises [ roting st ]

* Easy
S‘ep l’y s'ep * % Moderate
* % Difficult
Asking for Input Memo *

1. Adventure Travel Tours is planning to update its Web site in the near future. You have been asked
to solicit suggestions from the travel agents about changes they would like to see made to the
current Web site. You decide to send all the travel agents a memo asking them for their input.
Your completed memo will be similar to the one shown here.

a. Open a blank Word
2007 document and

create the following [ e
memo in Draft view. o s e
Press (GB%) twice after| . sy, 11, 10
you type the colons (:

following To in the
s

‘This will make the
information following
the colons li

evenly,

line between
paragraphs

To: Travel Agents
From: Student Name
Date: [Current date]
‘The Adventure Travel Tours current Web site was designed with travel agents in mind but as you know, the
role of the travel agent is changing. In order to keep up with these changes we plan to begin work on
updating the current Adventure Travel Tours Web site. In preparation for this project, | would like your input
about the content that will only be available to travel agents. As you work with clients please note what can
be changed to make it easier for you to book travel, then send your comments back to me. All suggestions
for changes are welcome and will be considered for our improved Web site.

‘Thank you in advance for your input.
b. Correct any spelling and grammar errors that are identified.
. Turn on the display of formatting marks. Check the document and remove any extra blank
spaces between words or at the end of lines.
d. Save the document as Web Site Memo in your data file location.

e. Switch to Print Layout view,
£. End the first sentence after the word “mind”. Capitalize the following word, but. Insert the text

wD1.82 Lab 1: Creating and Editing a Document

Word 2004

These exercises have a rating system from easy to difficult
and test your ability to apply the knowledge you have gained
in each lab. Exercises that build off of previous exercises are

noted with a Continuing Exercises icon ‘@) .

HeRceS

Expanding the Note- Taking Shills Handowt

« ¢ el

PR }

% Easy
% % Moderate

% % % Difficult
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Shortcut

Command

@ Office Button

New

Open

Save ©m+S, @
Save As

Save as/Save As type/
Web Page

Print

Print/Print Preview
Print/Quick Print
Prepare/Properties

Close

[l " /Proofing

| s [Advanced/
Mark formatting
inconsistencies

T (&) + F),

Quick Access Toolbar

[ Save
= Undo
¥ Redo

Cir) + Z

Home tab
Clipboard Group
Cut G + X

[ copy

E .

[#] Format Painter

2007 Word

Brie

Command Summary

Action

Opens File menu

Opens new document
Opens existing document file

Saves document using same file name

Saves document using a new file name, type, and/or

location

Saves file as a Web page document

Specify print settings before printing document

Displays document as it will appear when printed

Prints document using default printer settings

Opens Document Information Panel

Closes document

Changes settings associated with Spelling and

Grammar checking

Checks for formatting inconsistencies

Closes the Word application

Saves document using same file name

Restores last editing change

Restores last Undo or repeats last command or action

Cuts selection to Clipboard
Copies selection to Clipboard

Pastes item from Clipboard

Copies format to selection

2007 Word Brief Command Summary

COMPREHENSIVE COMMAND SUMMARY

Provides a table of commands, shortcuts, and
their associated action for all commands used

throughout each text in the O’Leary Series.

Command
Font Group
o b

n I Size

[&] Grow Font

|# Clear Formatting

[®] Bold
[T Italic

® | Underline
[&] Change Case
[¥77] Text Highlight Color

Shortcut A

Font Changes typeface

Changes font size

Increases font size

Clears all formatting from selected text, leaving plain text
Makes selected text bold

Applies italic effect to selected text

Adds underline below selected text
Changes case of selected text

Applies highlight color to selection

[&] Font Color
Paragraph group

[] Bullets

[ 7] Numbering

[ Indents and Spacing

Changes selected text to selected color

Creates a bulleted list
Creates a numbered list

Indents paragraph from left margin

4 Sort Rearranges items in a selection into ascending
alphabetical/numerical order

[% Show/Hide * Displays or hides formatting marks

[® Align Text Left Aligns text to left margin

[W Center Centers text between left and right margins

[ Align Text Right
[38] Justify

|8 | Line Spacing

Aligns text to right margin

Aligns text equally between left and right margins

Changes amount of white space between lines

Styles Group

More Opens Quick Styles gallery

Editing Group
[ ] Locates specified text

PAD— Locates and replaces specified text

Insert tab

Pages group

active window  The window containing the
insertion point and that will be affected by any
changes you make.

alignment How text is positioned on a line
between the margins or indents. There are four
types of paragraph alignment: left, centered,
right, and justified.

antonym A word with the opposite meaning.

author The process of creating a Web page.

AutoCorrect A feature that makes basic
assumptions about the text you are typing and
automatically corrects the entry.

bibliography A listing of source references that
appears at the end of the document

browser A program that connects you to

remote computers and displays the Web pages
u request.

building blocks Document fragments that
include text and formatting and that can be
casily inserted into a document.

bulleted list  Displays items that logically fall
out from a paragraph into a list, with items
preceded by bullets.

caption A title or explanation for a table,
picture, or graph.

case sensitive The capability to distinguish
between uppercase and lowercase characters.

cell The intersection of a column and row
where data are entered in a table.

character formatting Formatting feature
such as bold and color that affect the selected
characters only.

citations Parenthetical source references that
give credit for specific information included in
a document

Click and Type A feature available in Print
Layout and Web Layout views that is used to
quickly insert text, graphics, and othe i

Glossary of Hey Terms

a blank area of a document, avoiding the need
to enter blank lines.

elip art Professionally drawn graphics.

control A graphic clement that is a container
for information or objects.

cross-reference A reference in one part of a
document related to information in another
part.

cursor The blinking vertical bar that shows
you where the next character you type will
appear: Also called the insertion point.

custom dictionary A dictionary of terms you
have entered that are not in the main
dictionary of the spelling checker:.

default The initial Word document settings
that can be changed to customize documents

destination The location to which text is
moved or copie

Document Map A feature that displays the
headings in the document in the navigation
window.

document properties Details about a
document that describe or identify it and are
saved with the document content

document theme A predefined set of
formatting choices that can be applied to an
entire document in one simple step.

document window  The area of the application
window that displays the contents of the open
document.

drag and drop A mouse procedure that moves
or copies a selection to a new location.

drawing layer The layer above or below the
text layer where floating objects are inserted.

drawing object A simple object consisting of
shapes such as lines and boxes.

edit The process of changing and correcting

g text in a document.

Glossary of Key Terms. WDG.1

O—

Word 2007

j e~ Inserts a preformatted cover page
[

Tables group

Inserts a blank page

Inserts a hard page break

Inserts a table

Word 2007

2007 Word Brief Command Summary

www-mhhe com/oleary

GLOSSARY

Bolded terms found throughout each text in
the O’Leary Series are defined in the glossary.
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Appendix

"1 MORE ABOUT WORD 2007

1. CREATING AND CUSTOMIZING DOCUMENTS

1.1 CREATE AND FORMAT DOCUMENTS @

MORE ABOUT APPENDICES

-
A More About appendix appears at

the end of the brief and introductory

SET THEMES AS DEFAULT

texts. This appendix offers students
additional coverage needed to meet
MCAS requirements. Skills pertaining

lick the Normal dotm file to open it
indows Server 2003

be the

RESTORE TEMPLATE THEMES

1o The

the template file yo

Creating and Customizing Dacuments

W2 ‘Appendix: More about Word 2007

Word 2007

to additional MCAS coverage are
denoted by a More About icon in the
margins of the text.

Reference ]

Data File List

REFERENCE 1 - DATA FILE LIST

The Data File List is a reference guide
that helps organize data and solution
files. It identifies the names of the
original and saved files.

wao1.|
Stopby-Step
1

2.wd01_Child on Bike.wm
3. wd01_Coffes v o
4. wd01_Note Taking Skils.docx Note Taking Skils docx

e Cream History.docx

REFERENCE 2 - MCAS
CERTIFICATION GUIDE

>
Links all MCAS objectives to text
content and end-of-lab exercises.
You will always know which MCAS
objectives are being covered.
Introductory  texts are MCAS
certified.

Reference E _

Microsoft Certified Applications Specialist (MCAS)

Microsoft Office Word 2007

Reference 1 WOR1.1
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The Online Learning Center follows The O'Leary Series lab by lab, offering all kinds of supplementary help
for you. OLC features include:
® Learning Objectives

Student Data Files
Chapter Competencies

Chapter Concepts
Self-Grading Quizzes
Additional Web Links
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Introduction to Microsoft

Office 2007

Objectives

After completing the Introduction to Microsoft Office 2007, you should be able to:

1

Describe the 2007 Microsoft Office System.

©@

Describe the Office 2007 applications.

©

Start an Office 2007 application.

>

Recognize the basic application features.

&

Use menus, context menus, and shortcut keys.

o

Use the Ribbon, dialog boxes, and task panes.

N

Use Office Help.

8/

Exit an Office 2007 application.

1.1



1.2

Access 2007

. What Is the 2007 Microsoft Office System?

Introduction to Microsoft Office 2007 (

Microsoft’s 2007 Microsoft Office System is a comprehensive, integrated
system of programs, servers, and services designed to solve a wide array of
business needs. Although the programs can be used individually, they are
designed to work together seamlessly, making it easy to connect people and
organizations to information, business processes, and each other. The
applications include tools used to create, discuss, communicate, and
manage projects. If you share a lot of documents with other people, these
features facilitate access to common documents. This version has an
entirely new user interface that is designed to make it easier to perform
tasks and help users more quickly take advantage of all the features in the
applications. In addition, the communication and collaboration features
and integration with the World Wide Web have been expanded and refined.

The 2007 Microsoft Office System is packaged in several different
combinations of programs or suites. The major programs and a brief
description are provided in the following table.

Program Description

Word 2007 Word Processor program used to create text-
based documents

Excel 2007 Spreadsheet program used to analyze
numerical data

Access 2007 Database manager used to organize, manage,
and display a database

PowerPoint 2007 Graphics presentation program used to create
presentation materials

Outlook 2007 Desktop information manager and messaging
client

InfoPath 2007 Used to create XML forms and documents

OneNote 2007 Note-taking and information organization
tools

Publisher 2007 Tools to create and distribute publications for
print, Web, and e-mail

Visio 2007 Diagramming and data visualization tools

SharePoint Designer 2007 Web site development and management for

SharePoint servers
Project 2007 Project management tools

Groove 2007 Collaboration program that enables teams to
work together

The four main components of Microsoft Office 2007—Word, Excel,
Access, and PowerPoint—are the applications you will learn about in this
series of labs. They are described in more detail in the following sections.

www.mhhe.com/oleary ]




Word 2007

Word 2007 is a word processing software application whose purpose is to
help you create text-based documents. Word processors are one of the
most flexible and widely used application software programs. A word
processor can be used to manipulate text data to produce a letter, a report,
a memo, an e-mail message, or any other type of correspondence.

Two documents you will produce in the first two Word 2007 labs, a letter
and flyer, are shown here.

A letter containing a tabbed
table, indented paragraphs,
and text enhancements is
quickly created using basic

September 15,2008 Word features

Dear Adventure Traveler:

Imagine camping under the stars in Africa, hiking and paddling your way through the rainforests of Costa
Rica, or following in the footsteps of the ancient Inca as you backpack along the Inca trail to Machu Picchu. Turn
these dreams of adventure into memories you will cherish forever by joining Adventure Travel Tours on one of
our four new :d'.ﬁnture tours.

To tell you more about these exciting new adventures, we are offering several presentations in your
area. These presentations will focus on the features and cultures of the resion, We will Jlso show wou pictures of
the places you will visit and activities you can partici
to attend one of the following presentations:

Raz Ima
January 5 800 p.m. ————Crg
February 3 —— 7:30 p.m. —————Air;
March 8 800 p.m. Req

In appreciation of your past patronage, we

of the new tour packages. You must book the trip ot New A d venfur‘es

letter to qualify for the discount.

Our vacation tours are professionally develd
everything in the price of your tour while giving you|
these features:

» Allsccommodstions and meals
| fees, # fers and
» Professional tour manager and local guide:

We hope you will join us this year on anoth.
Travel Tours each day is an adventure. For reservat)
Travel Tours directly at 1-800-555-0004.

Attention adventure travelers! Attend an Adventure Travel presentation to learn about
some of the earth’s greatest unspoiled habitats and find out how you can experience
the adventure of a lifetime. This year we are introducing four new tours that offer you a
unigue opportunity to combine many different outdoor activities while exploring the
world.

India Wildlife Adventure
Inca Trail to Machu Picchu

Safari in Tanzania

Costa Rica Rivers and Rainforests

Presentation dates and times are January 5 at 8:00 p.m., February 3 at 7:30 p.m., and
March 8 at 8:00 p.m. All presentations are held at convenient hotel locations in
downtown Los Angeles, Santa Clara, and at the LAX airport.

Call Student Name 1-800-555-0004 for presentation locations, a full color brochure,
and itinerary information, costs, and trip dates.

Visit our Web site at

A flyer incorporating many www_adventuretraveltours.com
visual enhancements such as
colored text, varied text
styles, and graphic elements
is both eye-catching and
informative.

What s the 2007 Microsoft Office System? 1.3
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Access 2007

Introduction to Microsoft Office 2007 (

The beauty of a word processor is that you can make changes or
corrections as you are typing. Want to change a report from single spacing
to double spacing? Alter the width of the margins? Delete some paragraphs
and add others from yet another document? A word processor allows you
to do all these things with ease.

Word 2007 includes many group collaboration features to help streamline
how documents are developed and changed by group members. You also can
create and send e-mail messages directly from within Word using all its
features to create and edit the message. In addition, you can send an entire
document as your e-mail message, allowing the recipient to edit the
document directly without having to open or save an attachment.

Word 2007 is closely integrated with the World Wide Web, detecting when
you type a Web address and automatically converting it to a hyperlink. You
also can create your own hyperlinks to locations within documents, or to
other documents, including those at external locations such as a Web site or
file server. It also includes features that help you quickly create Web pages
and blog entries.

Excel 2007

Excel 2007 is an electronic worksheet that is used to organize, manipulate,
and graph numeric data. Once used almost exclusively by accountants,
worksheets are now widely used by nearly every profession. Marketing
professionals record and evaluate sales trends. Teachers record grades and
calculate final grades. Personal trainers record the progress of their
clients.

Excel 2007 includes many features that not only help you create a well-
designed worksheet, but one that produces accurate results. Formatting
features include visual enhancements such as varied text styles, colors,
and graphics. Other features help you enter complex formulas and
identify and correct formula errors. You also can produce a visual display
of data in the form of graphs or charts. As the values in the worksheet
change, charts referencing those values automatically adjust to reflect the
changes.

Excel 2007 also includes many advanced features and tools that help you
perform what-if analysis and create different scenarios. And like all Office
2007 applications, it is easy to incorporate data created in one application
into another. Two worksheets you will produce in Labs 2 and 3 of Excel
2007 are shown on the next page.
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A worksheet showing the
quarterly sales forecast
containing a graphic, text
enhancements, and a chart of
the data is quickly created
using basic Excel 2007
features.

A large worksheet incorporat-
ing more complex formulas,
visual enhancements such as
colored text, varied text styles,
and graphic elements is both
informative and attractive.
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You will see how easy it is to analyze data and make projections using
what-if analysis and what-if graphing in Lab 3 and to incorporate Excel
data in a Word document as shown in the following figures.
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Worksheet data and charts
can be copied and linked to
other Office documents such
as a Word document.
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Access 2007

Access 2007 is a relational database management application that is used
to create and analyze a database. A database is a collection of related data.
In a relational database, the most widely used database structure, data is
organized in linked tables. Tables consist of columns (called fields) and
rows (called records). The tables are related or linked to one another by a
common field. Relational databases allow you to create smaller and more
manageable database tables, since you can combine and extract data
between tables.

The program provides tools to enter, edit, and retrieve data from the
database as well as to analyze the database and produce reports of the
output. One of the main advantages of a computerized database is the
ability to quickly add, delete, and locate specific records. Records also can
be easily rearranged or sorted according to different fields of data,
resulting in multiple table arrangements that provide more meaningful
information for different purposes. Creation of forms makes it easier to
enter and edit data as well. In the Access labs, you will create and organize
the database table shown below.
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A database can be queried
to locate and display only
specified information.

A professional-looking report
can be quickly generated
from information contained in
a database.

1.8 Introduction to Microsoft Office 2007 (
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Another feature is the ability to analyze the data in a table and perform
calculations on different fields of data. Additionally, you can ask questions
or query the table to find only certain records that meet specific
conditions to be used in the analysis. Information that was once costly
and time-consuming to get is now quickly and readily available. This
information can then be quickly printed out in the form of reports ranging
from simple listings to complex, professional-looking reports in different
layout styles, or with titles, headings, subtotals, or totals.
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PowerPoint 2007

PowerPoint 2007 is a graphics presentation program designed to help you
produce a high-quality presentation that is both interesting to the audience
and effective in its ability to convey your message. A presentation can be as
simple as overhead transparencies or as sophisticated as an on-screen
electronic display. In the first two PowerPoint labs, you will create and
organize the presentation shown below.
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¢ ~ager o
i St T SWOR L B S B ) Ewaane s ufau:‘/.‘ 5

A presentation consists of a
series of pages or “slides”
presenting the information
you want to convey in an
organized and attractive
manner.

<d
=welcome Volunteers/

Animal Rescue Foundation
Student Name, Volunteer Coordinator

When running an on-screen
presentation, each slide of
the presentation is displayed
full-screen on your computer
monitor or projected onto a
screen.
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.. .common Office 2007 Interface Features

Now that you know a little about each of the applications in Microsoft
Office 2007, we will take a look at some of the interface features that are

Additional Information
Please read the Before You

Begin and Instructional common to all Office 2007 applications. This is a hands-on section that will
Conventions sections in the introduce you to the features and allow you to get a feel for how Office 2007
2;’:;:;6%8; '(WA'gS,S‘%ngg'fee works. Although Word 2007 will be used to demonstrate how the features
starting this section. work, only common user interface features, a set of graphical images that

represent various features, will be addressed. These features include using
the File menu, Ribbon, Quick Access Toolbar, task panes, and Office Help,
and starting and exiting an application. The features that are specific to
each application will be introduced individually in each application text.

Starting an Office 2007 Application

There are several ways to start an Office 2007 application. The two most
common methods are by using the Start menu or by clicking a desktop
shortcut for the program if it is available. If you use the Start menu, the
steps will vary slightly depending on the version of Windows you are using.

. Quick Access Toolb E d butt
CIICK to ofﬁce [ uic| ccess loolbar ] omman uttons

display the Start menu. Button yd Close
Y

Having Trouble? &) u.:- /7 4 B Y e s - aw

[ Poge Lapent Betnenn Metrgn Freen ew -
In Windows Vista, click ~ Y — —
e \ Cosar Boayt H NN S B T RS e Asncen ASBDC AsBDCe % :‘hmn
i . pste ;g Bl A V-A EEIWE N - Thomat |90efoc. Waangl Mesang? ;"::v' ':,_m,.
Choose Microsoft | - | g ) tawng
Office Word 2007. Eﬂ\ e ST e —— ; .

Having Trouble?

If you do not see the
program name on the Start
menu, select All Programs,
select Microsoft Office, and
then choose Microsoft Office
Word 2007.

S

Document
window

OR

Double-click the | ¥,

shortcut on the ="
desktop.

If necessary, click
Maximize in the title ~ [[wivs wons &

bar to maximize the

i i Figure 1
window (oo™ gurs
Your screen should be

similar to Figure 1

Having Trouble?

Your screen may look slightly
different based on your
Windows operating system
settings.
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The Word 2007 program is started and displayed in a window on the
Application windows can be desktop. The application window title bar displays the file name followed
sized, moved, and otherwise by the program name, Microsoft Word. The right end of the title bar

Additional Information

manipulated like any other displays the [ -] Minimize, [~ Restore Down, and Close buttons. They

windows on the desktop. . . .
perform the same functions and operate in the same way as all Windows
versions.

Below the title bar is the Ribbon, which provides a centralized area that
makes it easy to find ways to work in your document. The Ribbon has
three basic parts: tabs, groups, and commands. Tabs are used to divide
the Ribbon into major activity areas. Each tab is then organized into
groups that contain related items. The related items are commands that
consist of command buttons, a box to enter information, or a menu. As
you use the Office applications, you will see that the Ribbon contains
many of the same groups and commands across the applications. You also
will see that many of the groups and commands are specific to an
application.

The upper left area of the window’s title bar displays the “* Office

Additional Information

Benee e RIDECITCan Button and the Quick Access Toolbar. Clicking # Office Button opens the
adapt to the screen File menu of commands that allows you to work with your document,
resolution and orientation, unlike the Ribbon that allows you to work iz your document. For example,
your Ribbon may look slightly .. . . .

N it includes commands to open, save, and print files. The Quick Access

Toolbar (QAT) provides quick access to frequently used commands. By
default, it includes the [\ Save, [9] Undo, and [# Redo buttons, commands
that Microsoft considers to be crucial. It is always available and is a
customizable toolbar to which you can add your own favorite buttons.

The large center area of the program window is the document window
where open application files are displayed. Currently, there is a blank
Word document open. In Word, the mouse pointer appears as I when

positioned in the document window and as a [} when it can be used to
select items.

On the right of the document window is a vertical scroll bar. A scroll
bar is used with a mouse to bring additional lines of information into view
in a window. The vertical scroll bar is used to move up or down. A
horizontal scroll bar is also displayed when needed and moves side to side
in the window. At the bottom of the window is the status bar, a view
selector, and a document zoom feature. Similar information and features
are displayed in this area for different Office applications. You will learn
how these features work in each individual application.

Using the File Menu

Clicking the ©3 Office Button opens the File menu of commands that are
used to work with files.

Common Office 2007 Interface Features L.11

Access 2007




H s 3 Click to open
Click Oﬂl_ce Button | £l cne
to open the File menu.
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commands ) Maee b GewesdodY Lakd e
Toar Letienl 9500
I Do Wa3_Sour Lether @acx —

1] Wand Opmams || X gt Woed

Indicates a submenu
will be displayed

et PEERE" VoT—m—

Figure 2

The menu lists nine commands that are used to perform tasks associated
with files. Notice that each command displays an underlined letter. This
Clicking the next to a identifies the letter you can type to choose the command. Five commands
file name pins the file and disol 3], which indicates th d includ b f
permanently keeps the file play a , which indicates the command includes a submenu o
name in the recently used list | options. The right side of the command list currently displays the names
until it is unpinned. of recently opened files (your list will display different file names). The
default program setting displays a maximum of 17 file names. Once the
maximum number of files is listed, when a new file is opened, the oldest is
dropped from the list.

Once the File menu is open, you can select a command from the menu
by pointing to it. A colored highlight bar, called the selection cursor,
appears over the selected command.

Additional Information
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Point to the Open
command.

Your screen should be
similar to Figure 3

with the selection cursor

Selected command is highlighted

- Fevert Documenty
{

o)
y " WL Peed deen
2, 3 wal) Tow Researcn 8o
3 W) et Rawesech Rend.

Documentt - Microtoh Word

i

View

Il G 2 TR iwm[uoco AaBbC AsibCe |
ot it S ST 1 hermat Weaangl  Mssngl?

11 e Spsa
e

ScreenTip displays
command name and
keyboard shortcut

Weris &

Figure 3

A ScreenTip, also called a tooltip, briefly appears displaying the command
name and the keyboard shortcut, + O. The keyboard shortcut can be
used to execute this command without opening the menu. In this case, if
you hold down the key while typing the letter O, you will access the
Open command without having to open the File menu first. ScreenTips also
often include a brief description of the action a command performs.

Next you will select a command that will display a submenu of options.

Common Office 2007 Interface Features
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Figure 4
The submenu lists the six Prepare command submenu options and the
Mark as Final option is selected. A ScreenTip provides information about
how to get help on this feature. You will learn about using Help shortly.
Point to the Print 6 M2o0s Dotumertl - Aerotoh Word - =¥
command. e [T p— o proees
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Another Method

You also can use the
directional keys to move up,
down, left, or right within the
menu.

Another Method

You also can press to
choose a selected command.

Click the Print
command.

Your screen should be
similar to Figure 6

Print dialog box is used
to specify print settings

o]
C u-'u-
On

@ e ciick o .

Another Method

You also can press to
cancel an action.

So far you have only selected commands; you have not chosen them. To
choose a command, you click on it. When the command is chosen, the
associated action is performed. Notice the Print command is divided
into two parts. Clicking the Print section on the left will choose the
command and open the Print dialog box. Clicking |- in the right section
has no effect and only the submenu is displayed.
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Click to print

Click to close dialog
document

box without printing

e EER IO e

In the Print dialog box, you would specify the print settings and click
to actually print a document. In this case, you will cancel the
action and continue to explore other features of the Office 2007 application.

Using Context Menus

Another way to access some commands is to use a context menu. A
context menu is opened by right-clicking on an item on the screen. This
menu is context sensitive, meaning it displays only those commands
relevant to the item. For example, right-clicking on the Quick Access
Toolbar will display the commands associated with using the Quick
Access Toolbar only. You will use this method to move the Quick Access
Toolbar.
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Point to the Quick
Access Toolbar and
right-click.

Another Method

You also can click [] at the
end of the Quick Access
toolbar to open the menu.

i Click the Show Quick
Access Toolbar below
the Ribbon option.

Your screen should be
similar to Figure 7

Click [-] on the right
end of the Quick
Access Toolbar.

Choose Show Above
the Ribbon.

Your screen should be
similar to Figure 8

MORE ABOUT

) See the More About
appendix to learn how to
customize the Quick Access Toolbar.
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Quick Access Toolbar
displayed below Ribbon

Figure 7

The Quick Access Toolbar is now displayed full size below the Ribbon.
This is useful if you have many buttons on the toolbar; however, it takes
up document viewing space. You will return it to its compact size using
the toolbar’s drop-down menu.

Quick Access Toolbar displayed
above Ribbon again

1
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Figure 8

The Quick Access Toolbar is displayed above the Ribbon again. The
toolbar’s drop-down menu contains a list of commands that are often
added to the toolbar. Clicking on the command selects it and adds it to the
toolbar.

Using the Ribbon

The Ribbon displays tabs that organize similar features into groups. In
Word, there are seven tabs displayed. To save space, some tabs, called
contextual or on-demand tabs, are displayed only as needed. For example,
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when you are working with a picture, the Picture Tools tab appears. The
contextual nature of this feature keeps the work area uncluttered when the
feature is not needed and provides ready access to it when it is needed.

Opening Tabs

The Home tab is open when you first start the application or open a file. Tt
consists of five groups: Clipboard, Font, Paragraph, Styles, and Editing.
Each group contains command buttons that when clicked on perform
their associated action or display a list of additional commands. The
commands in the Home tab help you perform actions related to creating
the content of your document.

Insert tab active

Additional Information g e e e .
The open tab appears dcmmmen L MR P TS B et D) 2 (ARt i uive - X Swoten
hlghllghted J‘"‘""" Sl :") S ket g @ heotmen riv e il e Arvesin: 0 A e £2 Symast -
O Pegt Breme . ™ y 243 Owasanteaney . > temhnc G- M ol Owger
gt | pre | nnamam ] Lz a5 Foom | ten | = |
(ST AR IR SEENAEEY T SENEEE T -
Your screen should be x e b e C— WO E

similar to Figure 9

Seven groups in Insert tab

Figure 9

This Insert tab is now the active tab. It contains seven groups whose
commands have to do with inserting items into a document.

94 Click on each of the

other tabs, ending IR S R -
with the View tab, to Y e i b oo i .
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Your screen should be
similar to Figure 10

Figure 10
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0% Open the Home tab.

© Point to the upper part
of the F button in

the Clipb~oard group.

© Point to the lower part
of the ~ button in

the Glipb.oard group.

@ Point to [ /] Format
Painter in the
Clipboard group.

Your screen should be
similar to Figure 11

Additional Information

Not all commands have
shortcut keys.

Additional Information

You will learn about using
Help shortly.
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Each tab relates to a type of activity; for example, the View tab commands
perform activities related to viewing the document. Within each tab,
similar commands are grouped together to make finding the commands
you want to use much easier.

Displaying Super Tooltips

Many command buttons immediately perform the associated action when
you click on them. The buttons are graphic representations of the action
they perform. To help you find out what a button does, you can display the
button’s ScreenTip.
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B Sone vt Sstis Super tooltip

L Tre 11 S o help,
:

i
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Figure 11

The |, | button is a split button. Both parts of the button display tooltips

Paite

containing the button name, the shortcut key combination, +V and a
brief description of what clicking the button does. Pointing to Format
Painter displays a super tooltip that provides more detailed information
about the command. Super tooltips may even display information such as
procedures or illustrations. You can find out what the feature does
without having to look it up in Help. If a feature has a Help article, you
can automatically access it by pressing while the super tooltip is
displayed.

Using Galleries and Lists

Many commands in the groups appear as a gallery that displays small
graphics that represent the result of applying a command. For example, in
the Styles group, the command buttons to apply different formatting
styles to text display examples of how the text would look if formatted
using that command. These are called in-Ribbon galleries because they
appear directly in the Ribbon. Other commands include multiple options
that appear in drop-down galleries or drop-down lists that are accessed
by clicking the [] in the split button. To see an example of a drop-down

gallery, you will open the Bullets drop-down gallery.
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€@ e ciick[Jinthe

Bullets button.

Your screen should be
similar to Figure 12

Click outside the
Bullet gallery to clear
it.

Click [-] in the

Font Size button.

Your screen should be
similar to Figure 13
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Figure 12

A drop-down gallery of different bullets is displayed. The drop-down
gallery will disappear when you make a selection or click on any other
area of the window. To see an example of a drop-down list, you will open
the Font Size drop-down list.
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Figure 13

If you click on the button itself, not the [] section of the button, the
associated command is performed.

Using the Dialog Box Launcher

Because there is not enough space, only the most used commands are
displayed in the Ribbon. If there are more commands available, a
button, called the dialog box launcher, is displayed in the lower-right
corner of the group. Clicking opens a dialog box or task pane of
additional options.
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Click outside the Font
size list to clear it.

@ Point to the [ ] of the
Paragraph group to
see the tooltip.

@ Click [=] of the
Paragraph group.

Your screen should be
similar to Figure 14

Click to

close the dialog box.

Click [=] in the
Clipboard group.

Your screen should be
similar to Figure 15

Clipboard
task pane

Additional Information

You will learn about using
dialog boxes, task panes, and
the Clipboard as they are
used in the labs.
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The Paragraph dialog box appears. It provides access to the more
advanced paragraph settings features. Selecting options from the dialog
box and clicking will close the dialog box and apply the settings

as specified. To cancel the dialog box, you can click or [ in the
dialog box title bar.

Dn =

. e Puge |yt L Vhoar o o —— .-

x % Pl T A A rew

wtn 320 u AW SIS SRR | ] L socitx | antnced AaBLC  AsEbCe ’A & r5ad

.

4 Pl XA YA EEBEE O - LoV IRALS R T Measng | Tlesrwn harge § Sebiet+

fom Terewms LA ey
~

Closes task pane

Dialog box launcher ]

\/

Figure 15

A task pane is open that contains features associated with the Clipboard.
Unlike dialog boxes, task panes remain open until you close them. This
allows you to make multiple selections from the task pane while continuing
to work on other areas of your document.

64 Click [ <] in the upper-right corner of the task pane to close it.
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Using Access Key Shortcuts

Another way to use commands on the Ribbon is to display the access key
shortcuts by pressing the key and then typing the letter for the feature
you want to use. Every Ribbon tab, group, and command has an access key.

a—. Press (Alt ). Access keys appear
in KeyTips

GJ) Qf‘ 1) Lad Oocmartt « Aboroveh Woed - =y
You also can press (F10) to 7o e . o Uy bysan o v

Another Method

display the access keys. A o o BT T P R ey s RIS e RS prem - M ::‘"
Pocts , B dex x AW A B S o] | e [Tt eyt iy e
Your screen should be i : : e )Y — . e
[0  EEEEEEN BEEREEEN ELETELEL EEETEEEL EEE T EERL EEE AN -y 0

similar to Figure 16

Figure 16

The letters are displayed in KeyTips over each available feature. Now
typing a letter will access that feature. Then, depending on which letter
you pressed, additional KeyTips may appear. To use a Ribbon command,
press the key of the tab first, then the group, and then continue pressing
letters until you press the letter of the specific command you want to use.
You will use KeyTips to display the Paragraph dialog box again.

Type the letter H to by W29
By e -
access the Home tab. 2 e ‘:“'_ ':'- Yn =
| Cont Boa ‘N BB Aabecele | AmeCedr AaBbC: AalibCe | % Richa
o I B U b oAt V-A BE S 3 S| treme (thateen essngi  nessngl o
Type the letters PG to s e P IS o Ol ] e

access the Paragraph | . (eSS, o

group and open the

dialog box. —
Ouiew vt buddy et v
Irdert sty
Y(')UI" screen should be R e -
similar to Figure 17 we o 2 o~y ¥ :
Eo e Paragraph dialog
warq box opened using
wow O 2 \or Gecrg » Access keys
) LS bl e :

(7] 00t wdd se tetmemn saray wche of the Same st

Figure 17

Three keystrokes opened the Paragraph dialog box.
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Another Method

You also can press to
change the focus from the
Ribbon to the document area
to the View Toolbar.

Another Method

You also can use the
keyboard shortcut +
to minimize and redisplay the
Ribbon.

Click [ ] to close the
Paragraph dialog box.

Double-click the Home
tab.

Another Method

You also can choose Minimize
the Ribbon from the Quick
Access Toolbar menu.

Your screen should be
similar to Figure 18

Double-click the
Insert tab.

Your screen should be
similar to Figure 19

Ribbon
redisplayed

Additional Information

If you single-click a tab, the
Ribbon reappears temporarily,
but minimizes again as you
continue to work.

.22 Introduction to Microsoft Office 2007 (
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Once the Access key feature is on, you can also use the or
directional key to move from one tab to another, and the (3] key to move
from a tab to a group and the (#) key to move from a group to a tab. You can
use all four directional keys to move among the commands in a Ribbon.
(Tab’5i) and (&> Shift] + (Tab'i) also can be used to move right or left. Once a
command is selected, you can press (Spacebar] or («Enter] to activate it.

Minimizing the Ribbon

Sometimes you may not want to see the entire Ribbon so that more space
is available in the document area. You can minimize the Ribbon by
double-clicking the active tab.

g

: l
z
:
a
4
i
!

g 5
i

Bfe -

Ribbon hidden except
for tab area

Figure 18

Now, the only part of the Ribbon that is visible is the tab area. This allows you
to quickly reopen the Ribbon and, at the same time, open the selected tab.

0, = g -
-
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e g s s A n Fosea T ey

Insert tab open

Figure 19

The full Ribbon reappears and the Insert tab is open and ready for use.
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Right-click the blank
document window
space.

Your screen should be
similar to Figure 20

Another Method

You also can press to
access Help.

Using the Mini Toolbar

Another method of accessing commands is through the Mini toolbar. The
Mini toolbar appears automatically when you select text in a document
and provides commands that are used to format (enhance) text. It also
appears along with the context menu when you right-click an item in a
document. Both the Mini toolbar and context menus are designed to make
it more efficient to execute commands.

You can see what these features look like by right-clicking in a blank
area of the document window.

n‘l o v 3 0 mert]l - Aber o4O Word - 9%

3 5
“ et | Peprlapedt  Benescn  Mateg  Brew View -

&) Cowet Page (313 A Pl B, onies "y A . A | A G Pty 2 Sgnshune tee + [T Bustion -
| O Y : “ J 2. — adan
) Sank Prpe — 4 A Basimant A = L) Aweser P 0w s 13 tomtaut -
- fatde Acut Op Deoel Ssanint Ot aader forter  Page Test -
CAPp e » at . WO »  Memtac Bt M Cwpent -«
agrr [ ratians o swrtr A P astn et T2
L R KR IR SRR SR M S RO WX AR SRR
Mini toolbar
| Comn e 11 - N displays most

used formatting
commands

A toe
M tooporn. Context menu
= . .
~ i displays context-
". e sensitive commands
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B eee
Tem
gty
e

'».n-n wene D

Figure 20

The Mini toolbar displays the most frequently used formatting commands.
For example, when the Home tab is closed, you can use the commands in
the Mini toolbar to quickly change selected text without having to reopen
the Home tab to access the command. When the Mini toolbar appears
automatically, it is faded so that it does not interfere with what you are
doing, but changes to solid (as it is here) when you point at it.

The context menu below the Mini toolbar displays a variety of commands
that are quicker to access than locating the command on the Ribbon. The
commands that appear on this menu change depending on what you are
doing at the time.

Using Office Help

Notice the [@)| in the upper-right corner of the Ribbon. This button is used
to access the Microsoft Help system. The Help button is always visible
even when the Ribbon is hidden. Because you are using the Office Word
2007 application, Office Word Help will be accessed.
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Click [@)] Microsoft
Office Word Help.

If a Table of Contents
list is displayed along
the left side of the
Help window, click [&
in the Help window
toolbar to close it.

Additional Information

You will learn about using the
Table of Contents shortly.

Your screen should be
similar to Figure 21

Additional Information

Clicking the scroll arrows
scrolls the text in the window
line by line, and dragging the
scroll bar up or down moves
to a general location within
the window area.

Additional Information

Because Help is an online
feature, the information is
frequently updated. Your
screens may display slightly
different information than
those shown in the figures in
this lab.

Having Trouble?

In addition to being
connected to the Internet,
the feature to show content
from the Internet must be
selected. If necessary, click
the | &omine  button at the
bottom of the Help window
and choose Show content
from Office Online.

1.24

R

3

o 3

Introduction to Microsoft Office 2007 (

- raant Foge Lapent Retnenenn Matmg Proew vew ﬁ
2) Cowet Page * 1315 ) Yy B, ot A A | A Quamti 2 Sgnshueting + T Egusie,
o 0 4Y T2 A8 J |
o Bk Page b WS A Beseman - - - et dweria s Ot & 13 tomy,
fitle  Aoue Op  Dadel teanin Ot Wesder forte  Page fet .
APt e . ™ . IOt . o Mabere  Ben 2 Cwent -
Fagm Tonser atratiany (rL L et A P ente et ! ™
cs) . v ' )
[j,‘] e Y ] - H - : 3 - 2 2 3 $ -
- ‘{' Werd Hegp — o v“ —
- 1 “NMe
Qs * Opens Help
v F Sempn

'~

Each topic
is a hyperlink
to more

information

Scroll bar

List of
Word Help
topics

Pogrints weme D

[ Shows online status

-/

Figure 21

The Microsoft Word Help feature is opened and displayed in a separate
window. The Help window on your screen will probably be a different size
and arrangement than in Figure 21. Depending on the size of your Help
window, you may need to scroll the window to see all the Help
information provided.

It displays a listing of Help topics. If you are connected to the Internet,
the Microsoft Office Online Web site is accessed and help information
from this site is displayed in the window. If you are not connected, the
offline help information that is provided with the application and stored
on your computer is located and displayed. Generally, the listing of topics
is similar but fewer in number.

Selecting Help Topics

There are several ways you can get help. The first is to select a topic from
the listing displayed in the Help window. Each topic is a hyperlink or
connection to the information located on the Online site or in Help on
your computer. When you point to the hyperlink, it appears underlined
and the mouse pointer appears as . Clicking the hyperlink accesses and
displays the information associated with the hyperlink.
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04 Click “Getting help.”

Your screen should be
similar to Figure 22

Click “Using Microsoft
Office.”

Click “Use the
Ribbon.”

Your screen should be
similar to Figure 23
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Figure 22

A listing of topics about getting help is displayed. You will get help on
using Microsoft Office and the Ribbon.
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Figure 23

The information on the selected topic is displayed in the window.
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Use the scroll bar to
scroll the Help window
to read the information
about the Ribbon.

Display the “In this
article” section of the
window.

Your screen should be
similar to Figure 24

Additional Information

In Windows Vista, an
unopened topic heading is
preceded with + .

Click “Learn more
about using the
Ribbon.”

@ Click “Microsoft Office
Word 2007.”

@ If necessary, scroll the
window to see all the
information on this
topic.

Your screen should be
similar to Figure 25
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Figure 24

This area of the Help window provides a table of contents listing of the
information in this window. Clicking on a link will take you directly to
that location in the Help window. As you are reading the information in
the window, you will see many topics preceded with p. This indicates the
information in the topic is not displayed. Clicking on the topic heading
displays the information about the topic.
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Figure 25
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Additional Information
In Windows Vista, these
buttons are [#z1., . and
= Hige Al

@ o Oventhe

drop-down list.
® Click “Word Help.”

@ Click in the Search
text box to display the
insertion point.

@ Type What is the
Ribbon.

® Click [P = .

Additional Information

You also could press

to start the search.

Your screen should be
similar to Figure 26

The information on the selected subtopic is displayed. Clicking the table
of contents link jumped directly to this section of the window, saving you
time by not having to scroll. The P preceding the subtopic has changed to
W, indicating the subtopic content is displayed.

You can continue to click on the subtopic headings to display the
information about each topic individually. Likewise, clicking on an
expanded topic hides the information. Additionally you can click [» smowa
located at the top of the window to display all the available topic
information and to hide all expanded information.

Searching Help Topics

Another method to find Help information is to conduct a search by
entering a sentence or question you want help on in the Search text box of
the Help window. Although you also can simply enter a word in the Search
box, the best results occur when you type a phrase, complete sentence, or
question. A very specific search with 2-7 words will return the most
accurate results.

When searching, you can specify the scope of the search by selecting from
the Search scope drop-down menu. The broadest scope for a search, All
Word, is preselected. You will narrow the scope to search Word Help only.
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Figure 26

The first 25 located results of the top 100 are displayed in a window. There
are four pages of results. The results are shown in order of relevance, with
the most likely matches at the top of the list. Now you can continue to
locate the information you need by selecting from the topic links
provided. To see the next page of results, you can click or [ or
click the specific page number you want to see from the Page count area.
To see the previous page of results, click [
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Topics preceded with indicate the window will display the related

Help topic. Those preceded with a indicate a tutorial about the topic is
available from the Microsoft Training Web site.
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Figure 27

The same Help information you saw previously is displayed.

Using the Help Table of Contents

A third source of help is to use the Help table of contents. Using this
method allows you to browse the entire list of Help topics to locate topics
of interest to you.
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Click [@ Home in the
Help window toolbar
to return to the
opening Help window.

Click [2] Show Table
of Gontents from the
Help window toolbar.

Additional Information

You also could click [©] Back
in the Help window toolbar
to return to the previous

page, page by page.

Your screen should be
similar to Figure 28

Additional Information

Pointing to an item in the
Table of Contents displays a
ScreenTip of the entire topic
heading. =

Click “Getting help” to
open this chapter.

® Click “Using Microsoft
Office.”

@ Scroll the table of
contents list and click
“Use the Ribbon.”

Your screen should be
similar to Figure 29
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Figure 28

The entire Word Help Table of Contents is displayed in a pane on the left
side of the Help window. Clicking on an item preceded with a Closed
Book icon opens a chapter, which expands to display additional chapters or
topics. The Open Book icon identifies those chapters that are open.

Clicking on an item preceded with [@)| displays the specific Help information.
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The right side of the Help window displays the same Help information
about the Ribbon. To close a chapter, click the | icon.

Click || to close the Using Microsoft Office chapter.

Click [ Hide Table of Contents in the Help window toolbar to hide the table of contents list again.

Exiting an Office 2007 Application

Now you are ready to close the Help window and exit the Word program.
The |*]| Close button located on the right end of the window title bar can
be used to exit most application windows.

Click || Close in the Help window title bar to close the Help window.

Click || Close in the Word window title bar to exit Word.

Another Method The program window is closed and the desktop is visible again.

You also could choose * /

[X etwous or press
+ to exit an Office
application.
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Lab Review

Introduction to Microsoft Office 2007

context menu [.15

contextual tabs .16

dialog box launcher
document window

drop-down gallery

gallery 1.18
group .11
hyperlink 1.24

.19
.11
.18

selection cursor 1.12
split button .18
Mini toolbar 1.23 status bar .11
on-demand tab 1.16 super tooltip 1.18
Quick Access Toolbar .11 tab .11

Ribbon 1.11
ScreenTip .13

in-Ribbon gallery 1.18
KeyTips .21

task pane [.19
tooltip .13

scroll bar .11 user interface [.10

command summary )

command summary

Command/Button

E

\

Shortcut Action

Opens the Start menu

Starts the Word 2007 program

%) Office Button/| X ExitWord | + Exits Office program
© Opens Help window
)
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Lab Exercises

% Easy
step-by-step * % Moderate

Using an Office Application *

1. All Office 2007 applications have a common user interface. You will explore the Excel 2007
application and use many of the same features you learned about while using Word 2007 in this

lab.
a. Use the Start menu or a shortcut icon on your desktop to start Office Excel 2007.
b. What shape is the mouse pointer when positioned in the document window area?

c. Excel has tabs. Which tabs are not the same as in Word?

d. Open the Formulas tab. How many groups are in the Formulas tab?
e. Which tab contains the group to work with charts?

f. From the Home tab, click the Number group dialog box launcher. What is the name of the dialog
box that opens? How many number categories are there? Close the dialog box.

g. Display tooltips for the following buttons located in the Alignment group of the Home tab and
identify what action they perform.

h. Open the Excel Help window. Open the table of contents and locate the topic “What’s new in
Microsoft Office Excel 2007?” Open this topic and find information on the number of rows and
columns in a worksheet. Answer the following questions:

How many rows are in a worksheet?
How many columns are in a worksheet?
What are the letters of the last column?

i. Close the table of contents. Close the Help window. Exit Excel.

Exploring Microsoft Help *

1. In addition to the Help information you used in this lab, Office 2007 Online Help also includes
many interactive tutorials. Selecting a Help topic that starts a tutorial will open the browser
program on your computer. Both audio and written instructions are provided. You will use one of
these tutorials to learn more about using Word 2007.

Start Word 2007. Open Help and open the topic “What’s New?” Click on the topic “Up to speed
with Word 2007.” Follow the directions in your browser to run the tutorial. When you are done,
close the browser window, close Help, and exit Word 2007.

1.32 Introduction to Microsoft Office 2007 (
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Dverview of Microsoft Office Access 2007

. What Is a Datahase?

Somewhere at home, or maybe in your office, you probably have a file
cabinet or desk drawer filled with information. Perhaps you have
organized the information into drawers of related information, and
further categorized that information into file folders. This is a database.
As organized as you might be, it takes time to locate a specific piece of
information by manually opening drawers and searching through the
folders. You can just imagine how much time would be required for a large
company to manually search through its massive amounts of data. These
companies use electronic database management systems (DBMS). Now you
too can use electronic database management systems to store, organize,
access, manipulate, and present information in a variety of ways.
In this series of labs, you will learn how
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to design and create a computerized
database using Access 2007 and you will
quickly appreciate the many advantages of
a computerized database.
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Access 2007

.Access 2007 Features

Overview of Microsoft Office Access 2007

Access 2007 is a relational database management system. In relational
database systems, data is organized in tables that are related or linked to one
another. Each table consists of rows, called records, and columns, called
fields.

For example, a state’s motor vehicle department database might have
an address table. Each row (record) in the table would contain address
information about one individual. Each column (field) would contain just
one piece of information, for example, zip codes. The address table would
be linked to other tables in the database by common fields. For example,
the address table might be linked to a vehicle owner’s table by name and
linked to an outstanding citation table by license number (see example

below).

Address Table

Name License Number | Street Address City State | Zip

Aaron, Linda | FJ1987 10032 Park Lane | San Jose | CA 95127 |

Abar, John D12372 1349 Oak St Lakeville | CA 94128
—— Abell, Jack LK3457 95874 State St Stone CA 95201
key fields | key fields
linked linked ]

Owner’s Table Outstanding Citation Table

Name Plate Number License Number | Citation Code | Violation
—— Abell, Jack ABK241 T25476 00031 Speed

Abrams, Sue | LMJ198 D98372 19001 Park

Abril, Pat ZXA915 —— LK3457 89100 Speed

Access 2007 is a powerful program with numerous easy-to-use features
including the ability to quickly locate information; add, delete, modify, and
sort records; analyze data; and produce professional-looking reports. Some
of the basic Access 2007 features are described next.

Find Information

Once you enter data into the database table, you can quickly search the
table to locate a specific record based on the data in a field. In a manual
system, you can usually locate a record by knowing one key piece of
information. For example, if the records are stored in a file cabinet
alphabetically by last name, to quickly find a record, you must know the
last name. In a computerized database, even if the records are sorted or
organized by last name, you can still quickly locate a record using
information in another field.

( www.mhhe.com/oleary ]




Add, Delete, and Modify Records

Using Access, it is also easy to add and delete records from the table. Once
you locate a record, you can edit the contents of the fields to update the
record or delete the record entirely from the table. You also can add new
records to a table. When you enter a new record, it is automatically placed
in the correct organizational location within the table.

Sort and Filter Records

The capability to arrange or sort records in the table according to different
fields can provide more meaningful information. You can organize
records by name, department, pay, class, or any other category you need at
a particular time. Sorting the records in different ways can provide
information to different departments for different purposes.

Additionally, you can isolate and display a subset of records by specifying
filter criteria. The criteria specify which records to display based on data in
selected fields.

Analyze Data

Using Access, you can analyze the data in a table and perform calculations
on different fields of data. Instead of pulling each record from a filing
cabinet, recording the piece of data you want to use, and then performing
the calculation on the recorded data, you can simply have the database
program perform the calculation on all the values in the specified field.
Additionally, you can ask questions or query the table to find only certain
records that meet specific conditions to be used in the analysis.
Information that was once costly and time-consuming to get is now
quickly and readily available.

Generate Reports

Access includes many features that help you quickly produce reports
ranging from simple listings to complex, professional-looking reports. You
can create a simple report by asking for a listing of specified fields of data
and restricting the listing to records meeting designated conditions. You
can create a more complex professional report using the same restrictions
or conditions as the simple report, but you can display the data in
different layout styles, or with titles, headings, subtotals, or totals.

Case Study for Office Access 2007 Labs

You have recently accepted a job as employment administrator for
Lifestyle Fitness Club. The club has recently purchased Microsoft Access
2007, and you are using it to update their manual system for recording
employee information.

Lab 1: You will learn how to design and create the structure for a com-

puterized database and how to enter and edit records in the database. You
also will print a simple report of the records you enter in the database file.

Case Study for Office Access 2007 Labs ACO0.3
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Lab 2: You will continue to build, modify, and use the employee database
of records. You will learn how to sort the records in a database file to
make it easier to locate records. You also will learn about filtering a table
to display only the information you need. Additionally, you will create a
form to make it easier to enter and edit data in the database file.

Lab 3: You will learn how to query the database to locate specific
information. You also will learn how to create a report and link multiple
tables.

Working Together: You will learn how to share information between
applications by incorporating database information from Access into a
Word memo.

Before You Begin
To the Student
The following assumptions have been made:

e Microsoft Access 2007 has been properly installed on your computer
system.

e The data files needed to complete the series of labs and practice
exercises are supplied by your instructor. These may be supplied by

your instructor and are also available at the online learning center
Web site found at www.mhhe.com/oleary.

® You are already familiar with how to use Microsoft Windows XP or
Vista and a mouse.

To the Instructor

A complete installation of Microsoft Office 2007 is required in which all
components are available to students while completing the labs. In several
labs, an online connection to the Web is needed to fully access a feature.

Please be aware that the following settings are assumed to be in effect for
the Office Access 2007 program. These assumptions are necessary so that
the screens and directions in the labs are accurate. These settings are made
using @ Office Button/ in the categories shown below.

Popular

Always use ClearType is on.

Show feature descriptions in ScreenTips is on.
Show shortcut keys in ScreenTips is on.

The Default file format is Access 2007.

Default database folder is My Documents.

New database sort order is General.
Current Database/Application Options

e Display Status Bar is on.

e Tabbed Documents is on.

AC0.4 Overview of Microsoft Office Access 2007 (
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Display Document Tabs is on.

Use Access Special Keys is on.

Use Windows-themed Controls on Forms is on.

Enable Layout View for this database is on.

Enable design changes for tables in Datasheet view is on.

Check for truncated number fields is on.

Preserve source image format is on.

Current Database/Navigation

e Display Navigation Pane is on.

e Open objects with double-click is on.

Current Database/Ribbon and Toolbar Options

e Allow Full Menus is on.

e Allow Default Shortcut Menus is on.
Current Database/Name AutoCorrect Options
e Track name AutoCorrect info is on.

e Perform name AutoCorrect is on.
Datasheet/Default Colors

e All default colors are set to Automatic.
Datasheet/Gridlines and cell effects

e Default gridlines showing Horizontal and Vertical are on.
e Default cell effect is flat.

e Default column width is 1 inch.
Datasheet/Default font

e Font is Calibri.

e Fontsizeis 11.

e Weight is Normal.

Object Designers/Table design

Default field type is Text.

Default text field size is 255.

Default number field size is Long Integer.

Show Property Update Options is on.
Object Designers/Query design

e Show table names is on.
e Enable AutoJoin is on.

e Query design font is Segoe UI with a point size of 8.

Before You Begin AGO.5
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Object Designers/Forms/Reports

e Selection behavior is partially enclosed.

e Form and Report templates are Normal.
Object Designers/Error Checking

e All error checking options are on.

e Error indicator color is green.

Proofing

All AutoCorrect options are on.

Ignore words in Uppercase is on.

Ignore words that contain numbers is on.

Ignore Internet and file addresses is on.

Flag repeated words is on.
Advanced/Editing

Move after enter: Next field.

Behavior entering field: Select entire field.
Arrow key behavior: Next field.

Default find/replace behavior: Fast search.
All Confrim options are on.

Default direction: Left-to-right.

General Alignment: Interface mode.

Cursor Movement: Logical.
Advanced/Display

Show 9 recent documents.
Display Status bar.

Show animations is on.

Show SmartTags on datasheets is on.

Show SmartTags on forms and reports is on.
Advanced/Printing
e All margins are set to 0.25 inch.

Advanced/General

e No options are on.

Advanced/Advanced
e Default open mode is Shared.
e Default record locking is No locks.

e Open databases by using record-level locking is on.

AC0.6 Overview of Microsoft Office Access 2007 (
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Customize

e The Quick Access Toolbar displays the Save, Undo, and Redo buttons.

e Finally, the feature to access Online Help is on. (From the Help window,
open the Connection Status menu and choose Show Content from
Office Online.)

All figures in the text reflect the use of a display screen set at 1024 by 768
and the Windows XP operating system. If other monitor display settings
are used, there may be more or fewer lines of information displayed in the
windows than in the figures. If the Windows Vista operating system is
used, some features may look slightly different.

Instructional Conventions

Hands-on instructions you are to perform appear as a sequence of
numbered steps. Within each step, a series of bullets identifies the specific
actions that must be performed. Step numbering begins over within each
topic heading throughout the lab. Four types of marginal notes appear
throughout the labs. Another Method notes provide alternate ways of
performing the same command. Having Trouble? notes provide advice or
cautions for steps that may cause problems. Additional Information notes
provide more information about a topic. More About notes refer you to the
More About appendix for additional information about related features.

Commands

Commands that are initiated using a command button and the mouse
appear following the word “Click.” The icon (and the icon name if the icon
does not include text) is displayed following “Click.” If there is another
way to perform the same action, it appears in an Another Method margin
note when the action is first introduced as shown in Example A.

When a feature has already been covered and you are more familiar with
using the application, commands will appear as shown in Example B.

Example A
Open the Home tab.
‘Another Method Open the drop-down list in the Views group.
You also can click .
Datasheet View in the status Choose Datasheet view.
bar.

Instructional Conventions AGCO0.7
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Example B

@ Ciick =] Datasheet View.

OR

04 Change the view to Datasheet View.

File Names and Information to Type

Plain blue text identifies file names you need to select or enter. Information
you are asked to type appears in blue and bold. (See Example C.)

Example C
Open the database file ac02_Employees.

Type 9/23/01 in the Hire Date field.

% Office Button Menu

Clicking ©) Office Button opens the File menu of commands. File menu
commands that you are to perform appear following the word “Choose.”
Items that need to be selected will follow the word “Select” and will
appear in black text. You can select items with the mouse or directional
keys. Initially these commands will appears as in Example A. As you
become more familiar with the application, commands will appear as
shown in Example B.

Example A

@ - ciick © Office Button.

©® Choose Open.

® Select My Documents from the Look In drop-down menu.

@ Select ac02_Employees.

® Click [_2=_].

www.mhhe.com/oleary ]




Example B
Choose ©2) Office Button/Open.
Choose ac02_Employees.

OR

04 Open the file ac02_Employees.

Instructional Conventions AC0.9
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Creating a Database |5 |

Objectives

After completing this lab, you will know how to:

Plan, create, and modify a database.

Create and save a table structure.

®

Define field names, data types, field properties, and primary key fields.

L~

Enter and edit data.

@

Add attachments.

&

Change views.

Adjust column widths.

©

Use the Best Fit feature.

)

Create a second table.

=)

Create a Lookup field.

©

Delete records.

®

Preview and print a table.

®

Change page orientation.

4

Close and open a table and database.

AC1.1



Case Study

Lifestyle Fitness Club

You have recently accepted a job as a human re-
sources administrator with Lifestyle Fitness Club. Like
many fitness centers, Lifestyle Fitness Club includes
exercise equipment, free weights, aerobics classes,
tanning and massage facilities, swimming pool, steam
room and sauna, and child-care facilities. In addition,
it promotes a healthy

for traditional employment activities such as hiring
and benefits. Currently the club employment
records are maintained on paper forms and are
stored in file cabinets organized alphabetically by
last name. Although the information is well organ-
ized, it still takes time to manually look through
the folders to locate

lifestyle by including
educational seminars
on good nutrition and
proper
also has a small snack
bar that serves
healthy drinks, sand-
wiches, and snacks.
The Lifestyle Fit-
ness Clubs are a fran-

exercise. It

chised chain of clubs

that are individually

the information you
need and to compile
reports from this
data.

The Club has re-
cently purchased new
computers, and the
owners want to up-
date the employee
record-keeping sys-
tem to an electronic

database  manage-

owned. You work at a
club owned by Felicity and Ryan Albright, who also
own two others in California. Accounting and employ-
ment functions for all three clubs are handled centrally
at the Landis location.

You are responsible for maintaining the employ-
ment records for all employees, as well as records

AC1.2

ment system. The
software tool you will use to create the database is
the database application Office Access 2007. In this
lab, you will learn about entering, editing, preview-
ing, and printing information in the database you cre-

ate for the Club.
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Designing the table
structure consists of
defining field names,
data types, and field
properties.

P
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Entering data in a table
creates records of
information.

Awi

MHasw

Fields can contain attachments, such as pictures or files.
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Concept Preview

The following concepts will be introduced in this lab: ~N

Database A database is an organized collection of related information.

Object An Access database is made up of several types of objects, such as a table or report,
consisting of many elements. An object can be created, selected, and manipulated as a unit.

Data Type The data type defines the type of data the field will contain. Access uses the data
type to ensure that the right kind of data is entered in a field.

Field Property A field property is a characteristic that helps define the appearance and
behavior of a field.

Primary Key A primary key is a field that uniquely identifies each record.

LookUp Field A lookup field provides a list of values from which the user can choose to make
entering data into that field simpler and more accurate.
Subdatasheet A subdatasheet is a data table nested in another data table that contains data

related or joined to the table where it resides.

J

,Designing a New Database

The Lifestyle Fitness Club recently purchased the 2007 Microsoft Office
System software suite. You are very excited about learning to use the Access
2007 database management system to store and maintain the club’s records.

~

Concept 1

Database ~

i A database is an organized collection of related information. Typically, the information in a database is
stored in a table consisting of vertical columns and horizontal rows. Each row contains a record, which is
all the information about one person, thing, or place. Each column is a field, which is the smallest unit
of information about a record. Access databases can contain multiple tables that can be linked to produce
combined output from all tables. This type of database is called a relational database. See the “Overview
of Microsoft Office Access 2007” for more information about relational databases. y

The Lifestyle Fitness Club plans to use Access to maintain several different
types of databases. The database you will create will contain information
about each club employee. Other plans for using Access include keeping
track of members and inventory. To keep the different types of information
separate, the club plans to create a database for each group.

Good database design follows two basic principles: do not include
duplicate information (also called redundant data) in tables and enter
accurate and complete information. Redundant data wastes space, wastes
the time that is required to enter the same information multiple times, and
consequently increases the possibility of errors and inconsistencies between
tables. The information that is stored in a database may be used to make
business decisions and if the information is inaccurate, any decisions that
are based on the information would be misinformed.

AC1.4 Lab 1: Creating a Database (

Access 2007
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To attain these principles, the database design process is very important
and consists of the following steps: plan, design, develop, implement, and
refine and review. You will find that you will generally follow these steps
in order as you create your database. However, you will probably retrace
steps as the final database is developed.

Step Description

Plan The first step in the development of a database is to define the purpose of the data-
base in writing. This includes establishing the scope of the database, determining its
feasibility, and deciding how you expect to use it and who will use it.

Design Using the information gathered during the planning step, you can create an imple-
mentation plan and document the functional requirements. This includes finding and
organizing the information required for the database and deciding how this informa-
tion should be divided into subject groups. You also need to think about the types of
questions you might want the database to answer and determine the types of output
you need such as reports and mailings.

Develop Using the design you created, you are ready to create tables to hold the necessary
data. Create separate tables for each of the major subjects to make it easier to locate
and modify information. Define fields for each item that you want to store in each
table. Determine how each table is related to another and include fields to clarify the
relationships as needed. Try not to duplicate information in the different tables.

Implement After setting up the tables, populate the tables by entering sample data to complete
each record. Then work with the data to make sure it is providing the information
you need.

Refine and Review Refine the design by adding or removing fields and tables and continue to test the
data and design. Apply the data normalization rules to see if the tables are struc-
tured correctly. Periodically review the database to ensure that the initial objectives
have been met and to identify required enhancements.

As you develop the employee database for the Lifestyle Fitness Club, you
will learn more about the details of the design steps and how to use Access
2007 to create a well-designed and accurate database.

Planning the Club Database

Your first step is to plan the design of your database tables: the number of
tables, the data they will contain, and the relationship of the tables. You need
to decide what information each table in the employee database should
contain and how it should be structured or laid out.

You can obtain this information by analyzing the current record-keeping
procedures used in the company. You need to understand the existing
procedures so that your database tables will reflect the information that is
maintained by different departments. You should be aware of the forms
that are the basis for the data entered into the department records and of
the information that is taken from the records to produce periodic reports.
You also need to determine the information that the department heads
would like to be able to obtain from the database that may be too difficult
to generate with current procedures.

Designing a New Database AC1.5
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After looking over the existing record-keeping procedures and the
reports that are created from the information, you decide to create several
separate tables of data in the database file. Each table should only contain
information about the subject of the table. Additionally, try not to duplicate
information in different tables. If this occurs, create a separate table for
this information. Creating several smaller tables of related data rather than
one large table makes it easier to use the tables and faster to process data.
This is because you can join several tables together as needed.

The main table will include the employee’s basic information, such as
employee number, name, birth date, and address. Another will contain
the employee’s job title and work location only. A third will contain data
on pay rate and hours worked each week. To clarify the organization of
the database, you sketched the structure for the employee database as
shown below.

Club Records Database

Employee Records Table

Emp # Last Name First Name Street City State | Zipcode Phone Birth Date
7721 Brown Linda - -
—— 7823 Duggan Michael
° ° ° ° L] L] ° L] °
[ ] [ ] [ ] [ ] [ ) [ ) [ ] [ )
[ ] [ ] [ ] [ ] [ [ ) [ ]
link on link on common field
common field 1. Table Pay Table
Emp # Location Position Emp # Pay Hours
7721 lona Greeter 7721 8.25 30
— 7823 Fort Myers | Server - 7823 7.50 20
(] [ ] [ ] [ ] [ ] [ ]
° o ° (]
[ ] [ ]
., Creating and Naming the Database File
Now that you have decided on the information you want to include in the
tables, you are ready to create a new database for the employee
information using the Microsoft Office Access 2007 database management
program.
AC1.6 Lab 1: Creating a Database ( werw.mhhe com/oleary )

Access 2007



Start the Office Access
2007 application.

Having Trouble?

See “Introduction to 2007
Microsoft Office System” for
information about starting
the application and for a
discussion of features that
are common to all Office
2007 applications.

Your screen should be
similar to Figure 1.1

Selected category Creates blank new
database file
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Figure 1.1

The Getting Started with Microsoft Office Access page is displayed. It is
divided into several areas that provide a starting point for working with
Access. It can be used to create a new database, open an existing database
file, or access the Microsoft Office Online Web site. You want to create a
new database.

Several methods can be used to create a new database. One method is to
use one of the many templates that are provided by Microsoft as the basis
for your new database. A template is a ready-to-use database that includes
the data structure for the selected type of database. Another method is to
start with a blank database that contains the basic database objects and
then add your own content. A third is to copy or import data from another
source into an Access database file. Finally, you can use a custom template
that you created and saved as the basis for your new database.

Using the Getting Started with Microsoft Office Access page, you can
create a new database by selecting a template design. The left side of the
page displays the template categories. Currently, the Featuring category is
selected and displays graphics of the featured templates in the middle of
the page. Clicking on a different category in the list displays templates
associated with that category. Although using a template is sometimes the
fastest way to create a database, it often requires a lot of work to adapt the
template to suit the needs of the existing data.

The Featuring category also provides access to the Blank Database
template that includes the basic structure for a database file, but does not
include a data structure that is specific to a type of database. You decide to
create the club database from a blank database file.

Creating and Naming the Database File AC1.7

Access 2007



@ ecick|
New Blank Database
section of the Getting

Started window.

Your screen should be
similar to Figure 1.2

Additional Information

Depending on your Windows
settings, your screens may
not display file extensions.

Additional Information

Windows files can have up to
255 characters in the file
name. Names can contain
letters, numbers, and spaces;
the symbols\, /, ?,:, *, ", <,
and > cannot be used. The
file name can be entered in
either uppercase or
lowercase letters and will
appear exactly as you type it.
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Figure 1.2

In the Blank Database section of the page, you need to enter a file name
and specify the location on your computer where you want it saved. The
File Name box displays Databasel.accdb, the default database file name.
The file extension .accdb identifies the file as an Access 2007 database.

i e . . :
R.eplace the textinthe |5 o — Displays previously o
File Name text box to save files etz el 2
with Club Employees.
Having Trouble? ey St | et
If the default file name is not . g |
L (@ Desten ‘n,::‘m o S
highlighted, triple-click on it - = pens Save in w32
. - O s | D0 . L
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Additional Information
You do not need to type the
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Figure 1.3
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In the File New Database dialog box, you need to select the location where
you want the database file saved. The Save in drop-down list box displays

Having Trouble?

The default location, folders,
and files displayed on your the default folder, My Documents, as the location where the file will be

screen may be different from saved. You can use this drop-down list to specify another location. You

those shown here.

also can select the location to save from the Places bar along the left side
of the dialog box. The icons bring up a list of recently accessed files and
folders (History), the contents of the My Documents and Favorites folders,
items on the Windows desktop, and the locations on a network. You also

Having Trouble?

If you are using Windows . .
Vista, the buttons in your can click the [# Back button in the toolbar to return to folders that were
dialog box will be different
than those shown here.

previously opened and Up One Level to move up a level in the folder
hierarchy.

The file list section of the dialog box displays the names of folders and
database files in the default location. Only Access 2007 database (.accdb)
file names are displayed because this is the selected file type in the Save As
Type text box. In addition to the .accdb file type, Access database files also
can be saved in several different file formats that have different file

More About
- T —

) To learn how to save an
Ll Access database in

another format, see “6 Managing and extensions. The file type you select determines the file extension that will
z";i"ttai”ing zgtabases" in the More be automatically added to the file name when the file is saved. The new
out appendix.

file name you specified appears in the File Name text box.

H Shutter Bar button opens and Open tab
e_. Open the sa‘_’e n Tabs closes Navigation pane ’ [ ]
drop-down list. <
=) ’ Tanie foon & Erpiaree abass Actwns 207) - McroboR Atxe - =¥
e i d
o SE'ECt the ‘~' - | "‘j _:': Y/t DataTipe . ) ,:
appropriate drive T el asene :
and fo_lder where Fiantas ' G [ ]
you will save your =

database files (check
with your instructor if
you are not sure).

Table object
@ Click [_o_1]. created

® Click [_create_|.

r«

Tab displays name of
open table in work area

Your screen should be
similar to Figure 1.4

View buttons
Navigation pane

Work area displays |
open table object ’

Y

o | Retcea = 1efl L Lawh I

S

[ Status bar ] [ Current view ] Figure 1.4
Having Trouble?
If your screen looks slightly
different, this is because o ] o )
Access remembers settings The blank database file is opened in the Access application window. The
that were on when the name of the database, Club Employees, followed by the application name
program was last used. . . .

appears in the window title bar.
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Exploring the Access Window

Read “Common Office 2007
Interface Features” in the
Introduction for more
information about the File
menu, Ribbon, galleries, and
other features that are
common to all Office
applications.

The Access 2007 Ribbon, located below the title bar, currently consists of
five tabs. These tabs contain the commands and features you will use to
create and modify a database. Most tabs appear automatically as you
perform different tasks and open different windows. The Table Tools
Datasheet tab is open and contains buttons that are used to access basic
database features.

The mouse pointer appears as [} on your screen. The mouse pointer
changes shape depending upon the task you are performing or where the
pointer is located in the window.

The large area below the Ribbon is the work area where different
Access components are displayed as you are using the program. When the
new database file is created, it includes one empty table named Tablel. A
table is one of several different database components or objects that can
be included in the database file.

Concept 2

An Access database is made up of several types of objects, such as a table or report, consisting of many
elements. An object can be created, selected, and manipulated as a unit. The basic database objects are

described below.

The table object is the basic unit of a database and must be created first, before any other types of ob-
jects are created. Access displays each different type of object in its own window. You can open multiple
objects from the same database file in the work area; however, you cannot open more than one database
file at a time in a single instance of Access. To open a second database file, you need to start another in-
stance of Access and open the database file in it.

Object Use

Table Store data

Query Find and display selected data

Form View, add, and update data in tables
Report Analyze and print data in a specific layout

~

~

J

Additional Information
You will learn more about
tables and the different
database views shortly.
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The work area displays a tab containing the table name for the open table.
It is used to switch between open objects in the work area. There is only
one tab because only one object is open.

Just below the work area, the status bar provides information about the
task you are working on and about the current Access operation. Currently,
the left end of the status bar displays Datasheet view and the right end
displays two buttons that are used to change the view. In addition, the status
bar displays messages such as instructions to help you use the program
more efficiently.
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Additional Information USing the Navigation Pane

The items in the Navigation

b ized . . . .
g;?;:iay gyol:gianrgztie - objects in the database and is used to open and manage the objects.

The Navigation pane along the left edge of the work area displays all the

at the top of the pane. Because your database only contains one object, Tablel, it is the only

object listed in the pane. When there are many different objects, the pane

More About organizes the objects into categories and groups within each category. It is
> Toleam how to prevent the used to qullckl}.f access the dlfferenj[ objects.

"l Navigation pane from ap- The Navigation pane is always displayed, but can be collapsed to a bar to
pearing when you start Access, see “6 provide more space in the work area. The Shutter Bar close button [«],
Managing and Maintaining Databases” in 1 din th ish f th . d h hide th
the More About appendix. ocated in the upperright corner of the pane, is used to show or hide the pane.

i Each column Field data is
04 c"c!( to close the displays a field entered in a cell
Navigation pane.
0. o oo -

Another Method —— '_; ¥ oot

You also can press to ww | 204 tow
open/close the Navigation ot B, 1 : o~ o tat
pane. AsEs. | Header row | s R

(New) |
R d
Your screen should be X/
similar to Figure 15/
Identifies end of table where

new record can be entered

Navigation pane
reduced to a bar

Nangation Pase

Datasheet view displays table
as a grid of rows and columns Record number
indicator

Seath

L3

o

Figure 1.5

[ Navigation buttons ]

The Navigation pane is reduced to a bar along the left side of the window
and the work area expands to fill the space. The pane can be easily displayed
again by clicking [»]. You will learn more about using the Navigation pane
throughout the labs.

,Using Datasheet View

In anticipation of your entering information in the table, Access displays
the blank table in Datasheet view, one of several different window formats,
called views, that are used to display and work with the objects in a
database. Each view includes its own Ribbon tab that includes commands
that are designed to work with the object in that view. The available views
change according to the type of object you are using. The basic views are
described in the following table.

Using Datasheet View AC1.11
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Datasheet view Provides a row-and-column view of the data in tables or query results.

Form view Displays the records in a form.

Report view Displays the table data in a report layout.

Design view Used to create a table, form, query, or report. Displays the underlying design structure,

not the data.

Layout view Displays the object’s data while in the process of designing the object.

Print Preview Displays a form, report, table, or query as it will appear when printed.

Additional Information

Entering information in
Datasheet view is very similar
to working in a Microsoft
Excel worksheet.

AC1.12 Lab 1: Creating a Database (
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Datasheet view is a visual representation of the data that is contained in a
database table. It consists of a grid of rows and columns that is used to
display each field of a table in a column and each record in a row. The
field names are displayed in the header row at the top of the datasheet.

Below the header row is a blank row. The intersection of the row and
column creates a cell where you will enter the data for the record. The
square to the left of each row is the Select All button. It is used to select
an entire record and appears colored to identify the current record, the
record containing the insertion point and that will be affected by your
next action. The * in the Select All button identifies the end of the table or
where a new record can be entered.

The bottom of the work area displays a record number indicator and
navigation buttons. The record number indicator shows the number of
the current record as well as the total number of records in the table.
Because the table does not yet contain records, the indicator displays
“Record: 1 of 1”7 in anticipation of your first entry. On both sides of the
record number are the navigation buttons, which are used to move
through records with a mouse. In addition, two buttons that are used to
filter and search for data in a table are displayed. You will learn about
using all these features throughout the text.

Defining Fields

Now you are ready to begin defining the fields for the table. You have
already decided that the main table in this database will include the
employee’s basic information such as employee number, name, birth date,
and address. Next, you need to determine what information you want to
appear in each column (field) about the subject recorded in the table. For
example, you know you want to include the employee’s name. However,
should the entire name be in a single column or should it appear as two
separate columns: first name and last name? Because you may want to sort
or search for information based on the employee’s name, it is better to
store the information in separate columns. Similarly, the address actually
consists of four separate parts—address, city, state, and zip code—and it
also makes sense to store them in separate columns.

Generally when deciding how to store the information about a subject
in a table, break down the information into its smallest logical parts. If
you combine more than one kind of information in a field, it is difficult to
retrieve individual facts later.
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A second factor that should be considered when adding fields to a table
is to store only raw data, not the result of calculations, in the table. This is
because you can have Access quickly perform the calculations when you
want to see the result. This saves both time and space.

After looking at the information currently maintained in the personnel
folder on each employee, you have decided to include the following fields
in the table: Employee #, Hire Date, Last Name, First Name, Address, City,
State, Zip, Home Phone, Birth Date, and Photo. The data for the first
employee record you will enter is shown below.

Employee # 04731

Hire Date August 19, 2001
Last Name Marchant

First Name Roberta
Address 564 Palm Avenue
City Landis

State CA

Zip 92120-3741
Home Phone (507) 555-6707
Birth Date May 18, 1980
Photo Roberta.jpg

Entering Data

Notice that the first field in the table, ID, is already defined. This field is
automatically included in each table when it is created. It automatically
assigns a number to each record as it is added to a table and is useful for
maintaining record order. The second column header displays Add New
Field and is used to define a new field in the table.

In Datasheet view, you can enter data for a record and create a new field
at the same time. The first field of data you will enter is the employee
number, which is assigned to each employee when hired. Each new
employee is given the next consecutive number, so that no two employees
can have the same number. It is a maximum of five digits.

When you enter data in a record, it should be entered accurately and
consistently. The data you enter in a field should be typed exactly as you
want it to appear. This is important because any printouts of the data will
display the information exactly as entered. It is also important to enter
data in a consistent form. For example, if you decide to abbreviate the
word “Avenue” as “Ave.” in the Address field, then it should be abbreviated
the same way in every record where it appears. Also be careful not to enter
a blank space before or after a field entry. This can cause problems when
using the table to locate information.

As you type, the insertion point shows your location in the entry. If you
make a typing error, use the key to delete the characters back to
the error and retype the entry.

Using Datasheet View AC1.13
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Click in the blank cell
below the Add New
Field column header.

@ Type 04731.

® Press (—Enter).

Your screen should be
similar to Figure 1.6
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Default field assigns a number
to each record as it is added

Default field name
for first field

D) B Taste Toch & Bespiopeed - Database Wiccwss J0UT) - MECToboR Atcett - - ¥
3)

Employee number
for first record

L Sprars » 1l L . Searth
Deaiver view 0«

Figure 1.6

The employee number for the first record is entered in the table and Access
is ready for you to enter the data for the next field. However, the number
does not display the leading zero. You will learn the reason for this and
how to correct it shortly.

The new field has been assigned the default field name of Field1. Also
notice that the ID field displays the number 1 for the first record entered
in the table.

Changing Field Names

Before entering more data, you want to replace the default field name
with a more descriptive field name. A field name is used to identify the
data stored in the field. A field name should describe the contents of the
data to be entered in the field. It can be up to 64 characters long and can
consist of letters, numbers, spaces, and special characters, except a
period, an exclamation point, an accent grave (), and brackets ([]). You
also cannot start a field name with a space. It is best to use short field
names to make the tables easier to manage.
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Double-click on the by A saes s bl v e Mo P
5 : S &' oo Field name is descriptive v - rm—
Field1 column header. O BB | e = ce w | of @
T e e o e T A N
Type Employee # (be =

sure to include a
space before the #).

Another Method

You also can choose Rename
Column from the column
header’s shortcut menu. 1

Additional Information E

The field name can be typed
in uppercase or lowercase
letters. It will be displayed in
your database table exactly
as you enter it.

Your screen should be
similar to Figure 1.7

Deaer via 4o <

Figure 1.7

The highlighted text is deleted and replaced by the new field name you
typed. You realize that “Employee ID” is the more common term used on
company forms, so you decide to use this as the field name instead.

Editing Entries

As you enter text, you are bound to make typing errors that need to be
corrected. Other types of changes you may want to make are to edit or
update information. In this case, you want to edit the field name entry you
are currently working on. When editing, you need to position the insertion
point in the entry at the location where you want to make the change. To
position the insertion point using the mouse, simply click at the location
where you want it to appear.

Additionally, the keyboard keys shown in the table below also can be
used to move the insertion point in an entry.
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Additional Information

You can use the directional
keys on the numeric keypad
or on the dedicated
directional keypad area. If
using the numeric keypad,
make sure the Num Lock
feature is off; otherwise,
numbers will be entered in
the document. The Num Lock
indicator light above the
keypad is lit when on. Press

to turn it off.

Additional Information

These same key and mouse
movement procedures can be
used in all Access views.
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Key Movement

One character to right

One character to left

Up to current field in previous record
Down to next line

+ One word to right

+ One word to left

Beginning of field in single-line field
End of field in single-line field

+ Beginning of field in multiple-line field
+ End of field in multiple-line field

Holding down a directional key or key combination moves the insertion
point quickly in the direction indicated, saving multiple presses of the key.
Many of the insertion point movement keys can be held down to execute
multiple moves.

Depending on what you are doing, one method may be more efficient
than another. For example, if your hands are already on the keyboard as
you are typing, it may be quicker to use the keyboard rather than take
your hands off to use the mouse.

Once the insertion point is in the correct position, you can use the
(Backspace] or (Delete] key to remove text. The key removes a
character or space to the left of the insertion point. The key removes
the character or space to the right of the insertion point.

In this case, the insertion point is already in the correct position and
you just need to delete the character to the left of it.
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o_. Press to [ Data type of current field
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delete the # symbol. ) : /
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Figure 1.8

The field name has been completed and it is now easy to know what the
data in that column represents.

Defining Data Type

Notice the leading 0 of the Employee ID number has been dropped. This is
because Access automatically detects and assigns a data type to each field
based upon the data that is entered. In this case, the field entry consisted
of numbers only, and Access assigned the field a Number data type. This
data type drops any leading zeros.

~

Concept 3

~N
<M The data type defines the type of data the field will contain. Access uses the data type to ensure that the
right kind of data is entered in a field. It is important to choose the right data type for a field before you
start entering data in the table. You can change a data type after the field contains data, but if the data
types are not compatible, such as a text entry in a field whose data type accepts numbers only, you may
lose data. The data types are described in the following table.
J
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Data Type Purpose

Text Use in fields that contain alphanumeric data (words, combinations of words and
numbers, and numbers that are not used in calculations). Text field entries can be
up to 255 characters in length. Names and phone numbers are examples of Text
field entries. Text is the default data type.

Memo Use in fields where you want to store more than 255 characters of alphanumeric
data. A memo field holds up to 1GB of characters or 2GB of storage, of which
65,535 characters can be displayed. Text in this field can be formatted.

Number Use in fields that contain numeric data only and that will be used to perform calcu-
lations on the values in the field. Number of units ordered is an example of a
Number field entry. Leading zeros are dropped. Do not use in fields involving
money or that require a high degree of accuracy because number fields round to
the next highest value. Fields that contain numbers only but will not be used in
calculations are usually assigned a Text data type.

Date/Time Use in fields that will contain dates and times. Access allows dates from AD Janu-
ary 1, 100, to December 31, 9999. Access correctly handles leap years and checks
all dates for validity. Even though dates and times are formatted to appear as a
date or time, they are stored as serial values so that they can be used in calcula-
tions. The date serial values are consecutively assigned beginning with 1, which
corresponds to the date January 1, 1900, and ending with 2958465, which is De-
cember 31, 9999.

Currency Use in number fields that are monetary values or that you do not want rounded.
Numbers are formatted to display decimal places and a currency symbol.

AutoNumber Use when you need a unique, sequential number that is automatically incremented
by one whenever a new record is added to a table. After a number is assigned to
a record, it can never be used again, even if the record is deleted.

Yes/No Use when the field contents can only be a Yes/No, True/False, or On/Off value.
Yes values are stored as a 1 and No values as 0 so that they can be used in
expressions.

OLE Object Use in fields to store an object such as a graphic (picture), sound, document, or
graph. The object is converted to a bitmap image and displayed in the table field,
form, or report. An OLE server program must be on the computer that runs the
database in order to render the object. Generally, use the Attachment field type
rather than OLE Object because the objects are stored more efficiently and it
does not require the supporting program.

Hyperlink Use when you want the field to store a link to an object, document, Web page, or
other destinations.

Attachment Use to add multiple files of different types to a field. For example, you could add a
photograph and set of resumes for each employee. Unlike OLE object fields, the
files are not converted to bitmap images and additional software is not needed to
view the object, thereby saving space. Attachments also can be opened and ed-
ited from within Access in their parent programs.
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More About
- T —

P To learn more about the
W Memo, Currency, Number,
and Yes/No field types, see “2 Creating
and Formatting Database Elements” in the
More About appendix.

Additional Information

If Access does not have
enough information to
determine the data type, it
sets the data type to Text.

0% Open the

[naqq,‘«:p Mhamber -
drop-down list in the
Data Type &
Formatting group.

® Choose Text.

® Click at the beginning
of the Employee ID
entry to place the
insertion point and

type 0.

® Press to move to
the end of the entry.

@ Press (-] to move to
the next column.

Your screen should be
similar to Figure 1.9

Additional Information

The Data Type list also
contains a Lookup Wizard
option, which is not actually a
data type but instead is used
to create lookup fields that
let you choose from a list of
values you enter or that are
from another table or query.

Notice the Data Type box in the Data Type & Formatting group shows the
current data type for the field is Number. Access accurately specified this
data type because the Employee ID field contains numbers. However,
unless the numbers are used in calculations, the field should be assigned
the Text data type. This designation allows other characters, such as the
parentheses or hyphens in a telephone number, to be included in the entry.
Also, by specifying the type as Text, leading zeros will be preserved.

You need to override the data type decision and change the data type for
this field to Text.

(N B ’
=)

- L Ostatiner Tran Dot aneet -
Text data type entries |« ot it . " w—
are left-aligned A R o

Fame § ' Cpansenis

7 ¥
. v Qata Type & Fermmting Kawisne
i S e - X |
» [} tueet SURNSE I e — R — * |
0 impioyes 1L « Al New Haid
’

10471 |
. (New)

Leading zero displayed because
data type changed to Text

‘I Sprard » 1l LI T

Figure 1.9

The leading zero is now correctly displayed. Also notice that the entry is
now left-aligned in the cell space whereas it was right-aligned when the
data type was set to Number. Many data types also include formatting
settings that control the appearance of the data in the field. In this case,
the Text field format is to align the text with the left edge of the cell space.
You will learn more about formatting later in the lab.

Now you are ready to enter the data for the next field, Hire Date.
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94 Type Aug 19, 2001.

® Click in the
Fields & Columns
group.

@ Type Hire Date.

@ Press («Enterl.

@ Click on the hire date.

Your screen should be
similar to Figure 1.10

Additional Information

The [ calendar icon displays
the month calendar for that
date when you click on it.
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Figure 1.10

Access correctly determined that the entry is a Date type and displays the
date using the default date format of mm/dd/yyyy.

Using Field Templates

The next few fields you need to enter are for the employee name and
address information. Another way you can specify field names is to select
them from a list of predefined fields called field templates. Each field
template definition includes a field name, a data type, and other settings
that control the appearance and behavior of the field.

First you will add a field for the employee’s last name.
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€ o ciick |- | inthe Fields

& Columns group.

Your screen should be
similar to Figure 1.11

Double-click Last

Name in the Contacts

section of the Field
Templates list.

Your screen should be
similar to Figure 1.12
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Figure 1.11

From the Field Templates pane, you can select and drag the field name to
the table. When the insertion bar appears where you want the new field
inserted, drop the field in position. You can also double-click on the field
name and it will be inserted in the next empty field column in the
datasheet.
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Select the First Name,
Address, City,
State/Province, and
Zip/Postal Code field
names.

Having Trouble?

Hold down while
selecting multiple field
templates.

©® Drag them into the
datasheet and release
the mouse pointer
when the insertion bar
appears after the Last
Name column.

® Move to the Add New
Field column and
double-click the Home
Phone field to add it at
that location.

@ Click [x] in the title
bar of the Field
Templates pane to
close it.

@ Move the horizontal
scroll bar to the left.

Your screen should be
similar to Figure 1.13

AC1.22

Access 2007
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The Last Name field was inserted in the datasheet following the last
defined field in the datasheet. It has a data type of Text. Next you will add
the remaining address fields. Multiple field templates can be selected and
inserted into the datasheet at the same time.

Fields added to table
using Field Templates list

/ Horizontal scroll bar

T IEOE Tewin @ = »

Dezrent view o«

Figure 1.13

Using a field template saves time and provides the basis from which you
can start. Once inserted, it can be modified like any other field name.
Notice a horizontal scroll bar is displayed at the bottom of the work area.
This is because there are more fields in the datasheet than can be viewed
in the space. Tt is used to scroll the datasheet to see fields that are not
currently visible.

Switching Views

Next, you will switch to Design view. This view makes it easier to focus on
the structure of the table because it displays information about the fields
only, not the data in the table.

You can easily switch between views using the [« button in the Ribbon.
The graphic in the button changes to indicate the view that will be
displayed when selected. Currently the button displays the graphic for
Design view. If the view you want to change to is displayed in the button,
you can simply click on the button to change to that view. Otherwise, you
can open the View button’s drop-down list and select the view you want to
use. Before you can change views, you will be asked to save the table.
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Click [ | to open the
Navigation pane.

Click % Design

View in the Views
group.

Another Method

You also can click [~ to
open the View drop-down
menu and choose Design
View or click [#] Design view
in the status bar.

Your screen should be
similar to Figure 1.14

Additional Information

You also could click in
the Records group of the
Home tab, or use the
keyboard shortcut (¢ Shift) +
(<Enter), or click [ Savein
the Quick Access Toolbar to
save the changes to the table
at any time.
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The first time you switch views, you are asked to save the table design by
naming it. In the Save As dialog box, you want to replace the default name,
Tablel, with a more descriptive name. A table name follows the same set of
standard naming conventions or rules that you use when naming fields. It
is acceptable to use the same name for both a table and the database,
although each table in a database must have a unique name. You will save
the table using the table name Employee Records.
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The table structure is saved with the database file and the new table name
appears in the Navigation pane. You have created a table named Employee
Records in the Club Employees database file.

,Using Design View

Design view displays the structure of the table, not the table data. Therefore,
it is used to make changes to the layout and fields in the table only. The
Table Tools Design tab is displayed and open. The upper section consists of

Additional Information
You can get more Help a field definition grid that displays the field names, the data type associated

information about the current | with each field, and an area to enter a description of the field. The lower
selection by pressing (1 ] to section displays the properties associated with each field and a Help box

A Help. . . .
open T that provides information about the current task.

~

Concept 4

Field Property ~

Z3 A field property is a characteristic that helps define the appearance and behavior of a field. Each field has
a set of field properties associated with it, and each data type has a different set of field properties. Set-
ting field properties enhances the way your table works. Some of the more commonly used properties and
their functions are described in the following table.

Field Property Description

Field Size Sets the maximum number of characters that can be entered
in the field.
Format Specifies the way data displays in a table and prints.
Input Mask Simplifies data entry by controlling the data that is required in a field

and the way the data is to be displayed.

Caption Specifies a field label other than the field name that is used in
queries, forms, and reports.

Default Value Automatically fills in a certain value for this field in new records as
you add to the table. You can override a default value by typing a
new value into the field.

Validation Rule Limits data entered in a field to values that meet certain requirements.

Validation Text Specifies the message to be displayed when the associated
Validation Rule is not satisfied.

Required Specifies whether a value must be entered in a field.

Allow Zero Length Specifies whether an entry containing no characters is valid. This
property is used to indicate that you know no value exists for a field.
A zero-length string is entered as “" with no space between the
quotation marks.

Indexed Sets a field as an index field (a field that controls the order of
records). This speeds up searches on fields that are searched
frequently.
J
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MW?J_‘& The first field in the field definition grid, ID, is the selected field or current

) For information on other field and will be affected by any changes you make. It has a data type of
"l field properties, see AutoNumber. The properties associated with the current field are displayed
“2 Creating and Formatting Database in the Field P . .
Elements” in the More About appendix. In the Field Properties section.

You will look at the properties associated with the first field you added to
the table. Positioning the insertion point in any column of the field definition
grid will select that field and display the associated field properties.
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Figure 1.16

The data type of this field is Text and the default properties associated
with a Text data type are displayed in the Field Properties area. Although
some of the properties are the same as those for the AutoNumber data
type, most are different. Access sets the field size for a Text field to 255
characters. It also sets the Required property to no, which allows the field
to be blank. The Allow Zero Length property is set to yes, which allows
entries with no characters. The Indexed property is also set to yes,
meaning indexing is on, and duplicate entries are allowed in the field, as,
for example, the same name could be entered in the Name field of
multiple records. All these settings seem appropriate, except for the field
size, which is much too large.

Modifying Field Properties

Although Access uses only the amount of storage space necessary for the
text you actually store in a Text field, setting the field size to the smallest
possible size can decrease the processing time required by the program.
Additionally, if the field data to be entered is a specific size, setting the
field size to that number restricts the entry to the maximum number.

Using Design View AC1.25
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Click the Field Size
property text box.

Another Method

You also can press the
key to switch between the
upper and lower areas of the
Design window.

Double-click 255 to
select it.

Type 5 to replace the
default entry.

Additional Information

You can cancel changes you
are making in the current
field at any time before you
move on to the next field.
Just press (Esc), and the
original entry is restored.

Your screen should be
similar to Figure 1.17

AC1.26
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Because the employee number will never be more than five digits long,
you will change the field size from the default of 255 to 5. Another way to
edit text is to select (highlight by dragging or double-clicking) a character
or characters (including complete words and sentences) and press the

key to erase the selection.
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Figure 1.17

The maximum number of characters that can be entered in this field is
now restricted to 5. Notice the Help box displays a brief description of the
selected property.

Likewise, you will adjust the field sizes of several other fields.
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Change the field sizes
to those shown for the
fields in the following
table.
Field Size
Last Name 25
First Name 25
City 25
ZIP/Postal Code 10
Home Phone 15
Your screen should be

similar to Figure 1.18

@ - clickin the Data Type

column for the
Address field.

@ Click [] to open the
drop-down list and
choose Text.

@ Change the field size
to 50.

Your screen should be
similar to Figure 1.19
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Figure 1.18

Changing Data Type

As you look at the field definitions, you see that the Address field type was
set to Memo by the field template. This setting allows text entries longer
than 255 characters and lets you add formatting to the text, such as bold
or italics. You do not feel this data type is appropriate for the field and will
change it to Text with a field size of 50.
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Change the
State/Province field
name to State.

Change the ZIP/Postal
Code field name to ZIP
Code.

Having Trouble?

Double-click on the field
name to select it.

Your screen should be
similar to Figure 1.20
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Notice that even though this field has a text data type, the property settings
are different. For example, the Allow Zero Length and Indexed properties
are both set to No. This is because the fields were defined using field
templates that included these settings.

Editing Field Names

As you continue to look over the fields, you decide to change several of the
field names that were assigned when you selected the field templates.
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Figure 1.20

Defining a Primary Key Field

The next change you want to make is to define the Employee ID field as a
primary key field.
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Concept 5

~
A primary key is a field that uniquely identifies each record and is used to associate data from multiple
tables. To qualify as a primary key field, the data in the field must be unique for each record. For exam-
ple, a Social Security Number field could be selected as the primary key because the data in that field is
unique for each employee. Other examples of a primary key field are parts numbers or catalog numbers.
(One example of a field that should not be used as the primary key is a name field, because more than
one person can have the same last or first name.) A second requirement is that the field can never be
empty or null. A third is that the data in the field never, or rarely, changes.

A primary key prevents duplicate records from being entered in the table and is used to control the
order in which records display in the table. This makes it faster for databases to locate records in the table
and to process other operations.

Most tables have at least one field that is selected as the primary key. Some tables may use two or
more fields that, together, provide the primary key of a table. When a primary key uses more than one
field, it is called a composite key.
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Figure 1.21

Notice the Indexed property setting for this field has changed to Yes (No
Duplicates) because the field is defined as the primary key field. This
setting prohibits duplicate values in a field. Also, the primary key status
has been removed from the default ID field.
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Click the Description
text box for the
Employee ID field.

Type Unique five-digit
number assigned to
each employee.

Additional Information

The Description box scrolls
horizontally as necessary to
accommodate the length of
the text entry. The maximum
length is 255 characters.

Your screen should be
similar to Figure 1.22
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Entering a Field Description

To continue defining the Employee ID field, you will enter a brief description
of the field. Although it is optional, a field description makes the table easier
to understand and update because the description is displayed in the status
bar when you enter data into the table.
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Figure 1.22

You also want to add field descriptions to several other fields. As you do,
the Property Update Options button appears. Clicking on this button
opens a menu whose option will update the description in the status bar
everywhere it is used.
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Field Description
Hire Date Enter as month, day, year (for example, 5/2/99)
State Use a two-character abbreviation entered in capital letters
ZIP Code Include four-digit extension, if available (for example,
07739-0015)
Home Phone Enter as (555) 555-5555
Additional Information
In a table that contains a lot . .
of data, it is a good idea to Deletlng a Field
create a backup copy of the
table before you delete a Because the ID field essentially duplicates the purpose of the Employee ID
field in Cahse é’°|u "edeg to field, you will delete the ID field. Deleting a field permanently removes the
RLE" the de'ctctS field column and all the data in the field from the table.
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Select the ID field.

Click in
the Tools group.

Click in
response to the
advisory messages.

Your screen should be
similar to Figure 1.24

Another Method

You also can delete a field in
Datasheet view by choosing
Delete Column from the
shortcut menu or in
the Fields & Columns group
of the Table Tools Datasheet
tab for the column you want
to delete.
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/{ Deletes selected row
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Figure 1.24

The field is permanently removed from the table.

Defining Additional Fields

You still need to add two fields to the table: one for the employee’s date of
birth and the other to display the employee photo. You will add the new
fields and define their properties in Design view.
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oa Click in the blank Field

Name row below the
Home Phone field
name.

@ Type Birth Date.

® Press (—Enter), (Tab%),
or (») to move to the

Data Type column.

@ Open the Data Type
drop-down list and
choose Date/Time.

Another Method

You also can enter the data
type by typing the first
character of the type you
want to use. For example, if
you type D, the Date/Time
data type will be
automatically selected and
displayed in the field.

i Enter the field
description Enter as
month, day, year (for
example, 5/2/74).

Your screen should be
similar to Figure 1.25
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Figure 1.25

The default field properties for the selected data type are displayed. Because
the format line is blank, you decide to check the format to make sure that
the date will display as you want.

Using Design View
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Click in the Format
property box.

Click [¥] to open the

drop-down list of
Format options.

Your screen should be
similar to Figure 1.26

94 Choose General Date.

Your screen should be
similar to Figure 1.27

Additional Information

Access automatically assumes
the first two digits of a year
entry. If you enter a year that
is between /30 and /99,
Access reads this as a 20th
century date (1930 to 1999).
A year entry between /00 and
/29 is assumed to be a 21st
century date (2000 to 2029).

AC1.34
Access 2007

‘9;) oo : Tonte fooht Ot Enptageet | Databiaes LAcdott 00T - WcToas® Zecwst -y
ome Crnate Extarrat Dvta Ostatier Taan Cougn
B V& & AW
‘e , Test vadcatian h:pnn, ey
- ' l.‘. o iraet
Vem Whase ey
A Taos o E-——-—_
Imgioyee Rexonds 1 Neme -
T twpbapee Roterss Tatse ' Egioyes 1D Tent m‘lnoaqvlwmwiowowa L
e Date Osta/Time Enter as month, day, year (for example, 5/2/9%)
Lot Name Text
Fust Name Test
Aocres Text
cry Text
Sate Text L1 8 two-character abtrevistion ertered in captal letten
312 Coce Ten! Inciude four-age " (fer \pe, CTTY3-0013)
|| Moma Phone Tent Entar aq (355) 3555555
| Grth Date [ [ntar a3 month, day, year (for example, 3/2/4)

Prle Pepertiey

SA90007 $34 0 ™
Seeiony, e 1, 00r
Wamar

iy

3423 P

Date/time formats

==
=

The Srptay laged ot The Setd Letet 3 poe
L L e e
(tr ] Poutn ¥1 far bt o Tormats.

Devign wrwe M« Tuctin garws. 71« Wetg. iﬂ..ﬁ

Figure 1.26

The names of the seven predefined layouts for the Date/Time field type are
displayed in the list. An example of each layout appears to the right of the
name. The General Date format is the default format. It displays dates
using the Short Date format. If a time value is entered, it also will display
the time in the Long Time format.
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Figure 1.27

The Date property setting is now displayed in the Format text box.
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In the next blank field
name row, enter the
field name Photo/
Resume with a data
type of Attachment.

@ Include the description
Attach employee photo
and resume if
available.

Your screen should be
similar to Figure 1.28

The last field you will enter will display a photo and resume if available of
each employee. The data type for this type of input is Attachment. Once a
field has been assigned, this data type cannot be changed. You can, however,
delete the field and then redefine it if you think you made an error.

Switches to
Datasheet view
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Figure 1.28

Specifying the Attachment data type allows you to store multiple files of
different file types in a single field.

,Entering and Editing Data

Now that the table structure is complete, you want to continue entering
the employee data into the table. To do this, you need to switch back to
Datasheet view.

Because you have made many changes to the table design, you will be
asked to save the changes before you switch views. You also will be
advised that data may be lost because you decreased field sizes in several
fields. Since there is very little data in the table, this is not a concern.
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Click [ in the View
group to switch to the
Datasheet View.

Another Method

You also can click
Datasheet view in the
status bar.

@ Click to save

the changes.

® Click in
response to the data
may be lost warning.

@ Hide the Navigation
pane.

@ Click in the Employee
ID field for the first
record.

Your screen should be
similar to Figure 1.29

Additional Information

You will learn how to change
the column width shortly.
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Figure 1.29

Field description
appears in status bar

Because you deleted the ID field, it is no longer displayed and the new
fields you defined are ready for you to enter the remaining data for the
first record.

The first field, Employee ID, of the first record is outlined in orange,
indicating that the program is ready to accept data in this field. The field
name and Select All button also are highlighted in orange to identify the
current field and current record. The status bar displays the description
you entered for the field.

Notice also in this view that the column widths are all the same, even
though you set different field sizes in the Table Design window. This is
because the Table Datasheet view has its own default column width setting.

Verifying Data Accuracy and Validity

To see how field properties help ensure data accuracy, you will reenter the
employee number for the first record and try to enter a number that is
larger than the field size of five that you defined in Table Design view.
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If necessary, double-
click on the number to
select it.

Type 047310.

Your screen should be
similar to Figure 1.30

@ o Press (e, (@5,
or (> to move to the

Hire Date field.

@ Type 8/32/01.

® Press (—Enter), (Tab%),
or ().

Your screen should be
similar to Figure 1.31
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Figure 1.30

The program accepted only the first five digits and would not let you type
a sixth. The field size restriction helps control the accuracy of data by not
allowing an entry larger than specified. Notice also that the current record
symbol has changed to [#]. The pencil symbol means the record is in the
process of being entered or edited and has not yet been saved.

Next, you will intentionally enter an invalid date to see what happens.
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Figure 1.31
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04 Select Enter new value

from the message box.

@ Double-click on 32 to
select it.

@ Type 19.

® Press (Tab ')

Your screen should be
similar to Figure 1.32

An informational message box is displayed advising you that the entry is
not valid. In this case, the date entered (8/32/01) could not be correct
because a month cannot have 32 days. Access automatically performs
some basic checks on the data as it is entered based upon the field type
specified in the table design. This is another way that Access helps you
control data entry to ensure the accuracy of the data.

You will need to edit the date entry to correct it.
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The corrected date is accepted, and the insertion point moves to the Last
Name field. The year in the date changed to four digits, which reflects the
date format you specified in the field’s property.

Because you did not enter a description for this field, the status bar
displays “Datasheet View,” the name of the current view, instead of a field
description.

Using AutoCorrect

Now you are ready to continue entering the data for the first record. As you
are typing, you may make errors and they may be corrected automatically
for you. This is because the AutoCorrect feature automatically corrects
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obvious errors such as capitalizing names of days, the first letter of sentences,
and other common typing errors and misspellings such as words starting
with two initial capital letters. The AutoCorrect Options button will
appear next to any text that was corrected. You have the option of undoing
the correction or leaving it as is. Most times the typing error is not corrected,
and you will need to fix it manually.

To see how this works, you will enter the last name incorrectly by typing
the first two letters using capital letters.

- ¥
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Figure 1.33

The name was automatically corrected and the AutoCorrect Options button
appears. You will leave the correction as is and continue to enter data for
this record.
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Enter the data shown
in the table below for
the remaining fields,
typing the information
exactly as it appears.

Additional Information

The fields will scroll on the
screen as you move to the
right in the record.

Your screen should be
similar to Figure 1.34
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Field Name Data

First Name Roberta

Address 564 Palm Avenue

City Landis

State CA

ZIP Code 92120-3741

Home Phone (507) 555-6707

Birth Date May 18, 1980 (press to complete the entry)

All the information for the first record is now complete, except for the last
field for the employee photo and resume.

Attaching a File

Notice the field name in the header for this field is not Photo/Resume, as
you defined in Design view. This is because Access does not allow field
names for Attachment data types. Instead it displays a paperclip icon in
the field header to show that the field has an Attachment data type. The
field description that appears in the status bar is particularly important
because there is no descriptive field name.

To complete the information for this field, you plan to attach the
employee photo and a copy of the employee’s resume if it is available. A
photo is one of several different types of graphic objects that can be added
to a database table. A graphic is a nontext element or object. A graphic
can be a simple drawing object consisting of shapes such as lines and
boxes that can be created using a drawing program such as Paint or it can
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be a picture. A picture is an illustration such as a scanned photograph. A
resume is a text document that is typically created using a word processor
application.

Because you have not organized all the employees’ badge photographs
yet, you will only insert the photo for Roberta Marchant to demonstrate
this feature to the club owners. You also will attach a sample resume that
was created using Word 2007.
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Figure 1.35

The Attachments box is used to manage the items that are in an attachment
field. Because there are currently no attachments associated with this field,
it is empty. You will select the photo and resume files you want to add to
the field.
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Additional Information

To remove a file from the names of the selected files.
attachment field, select the
file name from the list and

click [ gemore ].

More About

) To learn how to export
attachments, see
“3 Entering and Modifying Data” in the
More About appendix.
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The Attachments dialog box is displayed again and now displays the
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€) o ciick[_o_1.

Your screen should be
similar to Figure 1.37

04 Double-click the cell.

@ Select the
ac01_Roberta file
from the Attachments
dialog box.

® Click [_oen .

Another Method

You also can double-click
the file to both select and
open it.

Your screen should be
similar to Figure 1.38
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The selected files are inserted as attachments and identified with the
number 2 in the cell. The number indicates how many attachments have
been added to the field. You will now display the photograph from the
Attachment field to check that it has been inserted properly.
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Additional Information

Image files that open in
Microsoft Picture and Fax
Viewer can only be viewed,
not edited. If you wanted to
edit the image, right-click on
the image and choose Edit.
The program used to create
the file, if available on your
computer, is opened.

Click I Close in the
graphics application
window title bar to
close the application.

Select and open the
ac01_Resume
attachment.

Your screen should be
similar to Figure 1.39

AC1.44 Lab 1: Creating a Database (

Access 2007

The picture object is opened and displayed in the graphics program that is
associated with this type of file—in this case, Windows Picture and Fax
Viewer. Yours may open and display in a different graphics program such
as Paint. The application that opens is not necessarily the application in
which the file was created. If the application in which it opens includes
features that can be used to edit the file, you will be prompted to save any
changes before closing the Attachments dialog box. If you do not save
them, the changes will be lost.

puatee © Mirocolt Word - x

AL W
r e o S T ol Resume document opened in .
4)} A tecmten 2 KNS EE T REANE sy assolf:ia:'ed word processing
= application
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i ~
(pmaed Poemt . Fangragh - Ve / Y

Resume
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Figure 1.39

The resume is opened and displayed in the associated word processing
application program. A copy of the file is placed in a temporary folder. If
you change the document, the changes are saved to the temporary copy.
Then when you return to Access and close the Attachments dialog box,
you are asked if you want to save the attached file again.

www.mhhe.com/oleary ]




6_. c"(:k CIose in the D; ‘: :ul:‘ Eitarrat Dsta Oatatiasr Taan "’u-:n::rvl' . ; ) s ‘ . ey = ;
application window : P Tim A Ut gy e
. » Love Sooten, L P aaverers * - Galer
title bar to close the i o ] W 3 o e
application. — o - i R —
- 3 L Name - ) '~ﬁ N :'A ASdren --: C‘!y= -’V Ve -7 DPCodn - -::r‘-=-’v~u-- - L Brth Dste
=18 H /1N 2001 M cnant foberta 563 Palm Aven Langn A 2104 S07) SAs47 Min1%s0
o Click [ Close to .
close the Attachments
: Second record is
dlaloQ box. ready for input
® Press to move
to the beginning of the | 4
next record. ' i
Your screen should be
similar to Figure 1.40
Current record of a total
of 2 records in table
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Figure 1.40

The data for the first record is now complete. The insertion point moves to
the first field in the next row and waits for input of the employee number
for the next record. As soon as the insertion point moves to another
record, the data is saved to the table file and the number of the new record
appears in the status bar. The second record was automatically assigned
the record number 2.

Moving between Fields

Next, you will check the first record for accuracy. To quickly move from
one field to another in a record, you can first select (highlight) the entire
field contents and then you can use the keyboard keys shown in the
following table to move quickly between field columns.

Key Movement

or Next field

or + Previous field

Current field in next record
Current field in previous record
First field in record

End Last field in record

You will select the Employee ID field for the first record and then move to
the Address field to check its contents.
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04 Point to the left end of

the Employee ID field
for the first record.
When the mouse
pointer appears as
o, click the mouse
button.

® Press (-] four times.

Your screen should be
similar to Figure 1.41

Additional Information

If you press or

while the entire
field is selected, the entire
field contents will be deleted.

Click the Address
field with the mouse
pointer shape as an
I-beam.

Your screen should be
similar to Figure 1.42
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Figure 1.41

Because the entire field contents are selected, you need to be careful that
you do not type a character as that will delete the selection and replace it
with the new text. To switch back to editing, you need to display the
insertion point in the field and then edit the entry.

.ﬂa) 80 Tove fooh  Chab Bmpiopees : Database cewss 2007) - Microbeht Atoest -
S| eme | Gt DtwesiOMa  OMibewseTiok  Dibsinent
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Voo hedr L m WA S - B} SR s
Wemy | Optama < ford Fcn Tee Kesmen e A rtn L
w1 e Sty
Impioyee if« MraDete + LagIName « fusthaow = ASSe - City . e « DPCodm + Mo Phom « BithDate «
o 12001 Marchant Robera 564 Palmqaven Langa ca WV (S07) sssex 31v1%80
.
— [ Entire entry is not visible ]
Highlight cleared and
insertion point displayed
DR L DR tewn ‘" -y : »
Dwtasvent View e..'

Figure 1.42
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Additional Information The highlight is cleared and the insertion point is visible in the field. Now,
You can press (F2 ) to switch using the directional keys moves the insertion point within the field and

between editing an entry (the | you can edit the field contents if necessary.
insertion point is displayed)

and navigating (the field is . .

selected) through the Zoommg a FIEId

datasheet.

The beginning of the field looks fine, but because the column width is too
narrow, you cannot see the entire entry. You will move the insertion point
to the end of the address so you can check the rest of the entry.

o_. PI'eSS . ei' N> : Tanie Toon b Empiopeet - Databare tccwrs 2007) - Mcroteh Alowet -'"y

rme Cmate Dtwrrat Ovta  Ostatinr Taaie Detaineet ~
b = - - e o mtew T ) ¥/ Sawction + L Brpmay
‘@.. ’.’3 ‘ Coet (1) Esa rir : .;:",, Wi Diong '! T aavarord * t'h) * CatTer
Your screen should be bl 4 e e B — Pl e Pl L
. . 3 Viewmy C . . e . " Lot Faowr A s Poz
similar to Figure 1.43 s an . — = el
| Impioyenif« MraDute + LagiNews « futhame - Al  + City - Aune « DPCoda « Homa Phom « BithDate -
o /132001 Marchant foberta Im lvm\a‘ Langs ca 72100 1507) saseX7 311980

Entry scrolled in cell and insertion
point is at end of entry

|fprart ™ 10iL LA . Sash . L »
L —— ppe——
Deaivest view jDas«

Figure 1.43

The text scrolled in the field, and the insertion point is positioned at the
end of the entry. However, now you cannot see the beginning of the entry,
which makes it difficult to edit. Another way to view the field’s contents is
to expand the field.
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in Zoom dialog box

i | :

Entire entry displayed ’

I ———— E.
Figure 1.44

The entry is fully displayed in the Zoom dialog box. You can edit in the
dialog box just as you can in the field.
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If the entry contains
an error, correct it.

Click [ o« .

Press (Tab'5).

Additional Information

You also can use the
horizontal scroll bar to scroll
the window and check fields
that are not currently visible.

‘ Continue to check the
first record for
accuracy and edit as
needed.

@ Enter the data shown
in the table for the
second record (you will
leave the attachment
field empty).

@ Check the second
record for accuracy
and edit it if necessary.

@ Move to the first field
of the blank record
row.

Your screen should be
similar to Figure 1.45
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Data for record ~ R . o
2 complete
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|
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tojiullyicisplay content than it needs to be
Current record
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Figure 1.45

Field Name Data
Employee ID 03474

Hire Date June 3, 2003
Last Name Driscoll

First Name Andy

Address 1903 25th Street
City Maldin

State CA

ZIP Code 92121-3740
Home Phone (507) 555-4494
Birth Date October 10, 1979

The record indicator in the status bar tells you that record 3 is the current
record of a total of three records.
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Additional Information

The default datasheet
column width is set to display

15.6667 characters.

AC1.50 Lab 1: Creating a Database

Access 2007

,Changing Golumn Width

As you have noticed, some of the fields (such as the Address field) do not
display the entire entry, while other fields (such as the State field) are
much larger than the field’s column heading or contents. This is because
the default width of a column in the datasheet is not the same size as the
field sizes you specified in Design view. Column width refers to the size of
a field column in a datasheet. The column width does not affect the
amount of data you can enter into a field, but it does affect the data that
you can see.

You can adjust the column width to change the appearance of the
datasheet. Usually you should adjust the column width so that the column
is slightly larger than the column heading or longest field contents,
whichever is longer. Do not confuse column width with field size. Field
size is a property associated with each field; it controls the maximum
number of characters that you can enter in the field. If you shorten the
field size, you can lose data already entered in the field.

Resizing a Column

The first thing you want to do is make the Address column wider so that
you can see each complete field entry without having to move to the field
and scroll or expand the field box. There are several ways that you can
manipulate the rows and columns of a datasheet so that it is easier to view
and work with the table data.

To quickly resize a column, simply drag the right column border line in
the field selector in either direction to increase or decrease the column
width. The mouse pointer shape is +# when you can drag to size the
column. As you drag, a column line appears to show you the new column
border. When you release the mouse button, the column width will be set.
First you will increase the width of the Address field so that the entire
address will be visible.
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-
pointer is 4, click
and drag to the right [ Drag to size column width
until you think the

column width will be
wide enough to
display the field
contents.

Column width increased and field
entries are fully displayed

Hovipation Pune

@ Adjust the column
width again if it is too
wide or not wide
enough.

e L} » ‘ Sean ‘ s »

Another Method e el [Faax

You also can adjust the Figure 1.46
column width to a specific
number of characters using

in the Records group
of the Home tab and
choosing Column Width. This
command is also on the
shortcut menu when an entire
column is selected.

Your screen should be
similar to Figure 1.46

Using Best Fit

Rather than change the widths of all the other columns individually, you
can select all columns and change their widths at the same time using the
Best Fit feature. To select multiple columns, point to the column heading
in the header row of the first or last column you want to select. Then,
when the mouse pointer changes to ¥, click, and without releasing the
mouse button, drag in either direction across the column headings.
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Figure 1.47

All the table columns are highlighted. Now, if you were to drag the column
border of any selected column, all the selected columns would change to
the same size. However, you want the column widths to be adjusted
appropriately to fit the data in each column. To do this, you can double-
click the column border to activate the Best Fit feature. The Best Fit
feature automatically adjusts the column widths of all selected columns to

accommodate the longest entry or column heading in each of the selected
columns.
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Double-click any
column border line (in
the field selector row)
when the mouse

pointer is 4.

@ Click anywhere on the
table to deselect the
datasheet.

Another Method

You also can use in the
Records group of the Home
tab and choose Column
Width/Best Fit.

Your screen should be
similar to Figure 1.48
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Figure 1.48

The column widths for each field have been sized to accommodate the
longest entry or column heading. As you add more records to the table
that contain longer field entries, you will need to use Best Fit again to
readjust the column widths.
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ea Check each of the

records again and edit
any entries that are
incorrect.

® Add the data shown in
the following table as
record 3.

® Press twice to
skip the Attachment

field and complete the
record.

Your screen should be
similar to Figure 1.49
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Figure 1.49
Field Name Data
Employee ID 04731
Hire Date April 12,2004
Last Name Delano
First Name Gordon
Address 1310 N. Spindrift Drive
City Chesterfield
State CA
ZIP Code 92122-1268
Phone (507) 555-8201
Birth Date August 7,1979

As soon as you complete the record, an error message dialog box appears
indicating that Access has located a duplicate value in a key field. The key
field is Employee ID. You realize you were looking at the employee
number from Roberta Marchant’s record when you entered the employee
number for this record. You need to clear the message and enter the
correct number.
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Your screen should be } .
similar to Figure 1.50

Figure 1.50

The record is accepted with the new employee number. However, you
notice that the address and city for this record are not fully displayed in

the fields.
Best fit the Address ,'Ejy‘ H.‘:- -"M' - — Tovte foon  Chab Empiopeed - Database ihctwas 071 - Mcrobeh Atcwet = ;
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When you add new records in a datasheet, the records are displayed in the
order you enter them. However, they are stored on disk in order by the
primary key field.

You will add three more records to the table. If data for some fields,
such as the City, State, or ZIP Code, is the same from record to record, you
can save yourself some typing by copying the data from one of the other
records. Just select the field contents and click Copy in the Clipboard
group. Then move to the field where you want the copy to appear and

click in the Clipboard group.

Enter the data for the
two records shown in
the following table.

Field Record 4 Record 5

Employee ID 13635 12583

Hire Date January 2, 2007 April 20, 2007

Last Name Martinez Sullivan

First Name Juan Marie

Address 1920 First Avenue 78 Omega Drive

City Maldin Chesterfield

State CA CA

ZIP Code 92121-3740 92122-1268

Phone (507) 555-2935 (507) 555-7890

Birth Date December 10, 1982 March 15, 1981
AC1.56 Lab 1: Creating a Database (wwwmhhecomoleary )
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Figure 1.52

There are now a total of six records in the table

JDeleting Records

While you are entering the employee records, you find a memo from one
of your managers stating that Andy Driscoll is no longer working at the

You also can move to the : : :

rocord and choose Select club and asking you to remove his record from the employee files.

from the drop-down You can remove records from a table by selecting the entire record and

list in the Find group of the pressing the key. After pressing (Delete), you will be asked to confirm

Home tab. that you really want to delete the selected record. This is because this

action cannot be reversed.

Another Method

Additional Information

You can select multiple
noncontiguous records by
holding down while
clicking the Select All button
of each record. To select
contiguous records, click and
drag along the Select All
buttons.

Deleting Records AC1.57
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@ Point to the Select Al

button for record 2
and click when the
mouse shape is =»,

® Press (Delete).

Another Method

You also can use £ Cut in the
Clipboard group to delete a
selected record.

Click to
confirm that you want
to delete the record.

Additional Information

Clicking | ®  restores the
record.

Your screen should be
similar to Figure 1.53
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Figure 1.53

The table now consists of five employee records.

JCreating a Second Table

You also can choose Delete
Record from the
drop-down list in the Records
group of the Home tab. The
current record is both
selected and deleted at the
same time.

Additional Information

A SharePoint list is a list of
data that is stored on a
SharePoint server and is
available to others in an
organization.

AC1.58

Access 2007

Lab 1: Creating a Database (

Following your plan for the employee database, you will add another table
to the existing database file. This table will hold information about the
employee’s work location and job title.

There are several ways to create a new table in an existing database.
You can insert a blank table and define the fields in datasheet view as you
already did or you can create a table based on a table template. You also
can import from or link to data from another source, such as another
database, an Excel worksheet, or a SharePoint list. Finally, you can create
a new table starting in Design view. You will use this last method to define
the two fields in the table, club location and job title.
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Field Name Data Type Field Size

Location Text 20

Job Title Text 50

The new table has a default table name of Tablel displayed in the table tab.

Adding an Existing Field

As you look at the design, you realize you need to include a field that will
be used to refer back to the primary key field of the Employee Records
table in order to create an association between the two tables. A field that
refers to the primary key field in another table is called a foreign key
field. The new table will use the same field as the Employee Records table,
employee number, as the foreign key field. The field names of these two
fields do not have to match, although their data types must be the same.
Instead of recreating the field, you will copy it from the Employee Records
table into the new table.
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Figure 1.55

Fields & Columns
group.

Your screen should be
similar to Figure 1.55

The Navigation pane displays the names of both tables in the database
and a tab for both open objects appears above the work area. A Field List
pane appears on the right side of the work area. It displays the name of the
only other table in the database, Employee Records. Clicking the [# next
to the table name will display a list of the fields in the table. Then you can
select and drag the field name to the new table, much as you did when
using the Field Templates pane. When the insertion bar appears where
you want the new field inserted, drop the field in position. You also can
double-click on the field name and it will be inserted in the next empty
field column in the datasheet.
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Figure 1.56

Using the Lookup Wizard

The Lookup Wizard automatically starts and is used to create a lookup
field that will allow you to select from a list of values when entering the
employee number into the new table. A wizard is a feature that guides you
step by step through the process to perform a task.
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Concept 6

Lookup Field ~N

(B A lookup field provides a list of values from which the user can choose to make entering data into that
field simpler and more accurate. The lookup field can get the values from an existing table or a fixed set
of values that are defined when the lookup field is created. A lookup field that uses another table as the
source for values is called a lookup list, and one that uses fixed values is called a value list.

Lookup List Lookup Field

When the lookup field uses a table for the values it displays, an association is created between the two
tables. Picking a value from the lookup list sets the foreign key value in the current record to the primary
key value of the corresponding record in the related table. A foreign key is a field in one table that refers
to the primary key field in another table and indicates how the tables are related. The field names of these
two fields do not have to match, although their data types must be the same.

The related table displays but does not store the data in the record. The foreign key is stored but does not
display. For this reason, any updates made to the data in the related table will be reflected in both the list
and records in the table containing the lookup field. You must define a lookup list field from the table that
will contain the foreign key and display the lookup list.

Value List Lookup Field

A lookup field that uses a fixed list of values looks the same as a lookup field that uses a table, except the
fixed set of values is entered when the lookup field is created. A value list should be used only for values
that will not change very often and do not need to be stored in a table. For example, a list for a Saluta-
tion field containing the abbreviations Mr., Mrs., or Ms. would be a good candidate for a value list. Choos-
ing a value from a value list will store that value in the record—it does not create an association to a
related table. For this reason, if you change any of the original values in the value list later, they will not
be reflected in records added before this change was made.

J

Additional Information
You will create a value list In the first Lookup Wizard dialog box, you specify the source for the values

lookup field in Lab 2.

for the lookup field. The Employee ID field is already correctly selected.

AC1.62 Lab 1: Creating a Database (

Access 2007

www.mhhe.com/oleary ]




€@ o click e 1.

Your screen should be
similar to Figure 1.57

@) o ciick twice.

Your screen should be
similar to Figure 1.58

’Fy S L LR N Toste focn
eme Trnate Extarral Dsta Ostataer Toan Dt anert -
- " |t Yt Dotalipe Tt « I g '141 "'}
5 _ﬂ ¥ JA 7 come ' b Reyared J ] ﬁ;:'
VA Nww " L2 S lie-1 Q 0
s - r::a.. Comer W Aeme (8 e Cupanzeniny
ewy fre & Creamen Cata Type & Farmatieng Ensanog,
A2 Tables > w Rt (ockuo v fekd Lt x
Tmployee Rex onde T teg & reonent & o ot bee? Fiandi ssatudie in strer tatier
I tmptaypen Rocerss : Tatse . = Unglayey Reczron 100 Tane
o Ll Imgtazes ©
'; o l Dy
53 e Table Last hame
'l CAr=——"u Pos ome
ssaen
2 <o
Teate
3 D Cose
mzme Peane
4 Beth Date
* Pagts Sarume
‘ | coun || <poa | twes |
|
|
Yamora - 1a1 IR Tewn |
e - S [ ——
Lasdip ware (oasa

Figure 1.57

The next step is to specify a sort order. Since the items will automatically
appear in the same order as in the Employee Records table, you can skip this
step and move to the next step to specify the column width. Again, you want
to use the same width setting you established in the Employee Records table
so you will skip this step as well.
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Figure 1.58
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€ o click [==_1.

@ Close the Field List
pane.

® Switch to Design view.

@ Select the Employee ID
field.

@ Open the Lookup tab
in the Field Properties
area.

Your screen should be
similar to Figure 1.59

Additional Information

You will learn about table
relationships in later labs.

Finally, you are asked to specify a field name. You will accept the default
name, which is the same as the name used in the Employee Records table.

0z) o s Tanie foctt & Enotorees : Databiaee (Aot J0077 + NCIOADR Accas
T e Crnate Eitarrat Oota Ostatase Toan Detign -

[ el | :br wt Aowt

i' " ‘ g 7 Dot Qe
‘o P

(,." oA Lectug Cotmn

A2 Tables R e

T —rv— Ta | it Na Deta Type Ovacription -

s Emghyee D Tant [#
Location

[ Text
20 iob: Tuble Job Title Tent

Lookup tab

Puks Papertiey

Camerst L30hi0

Cviptay Camtins {emz) 30

B Gourie Yype Tovke Queny

Brw towie HUCT Baprayee Koo fagroyee ©f PECA Jumpiaree Fosirnl Source Of d?ta
Brns Conmn for lookup field
Lohma Come

Lhme o ALt mame 0 Be g te B (R adten) g
Cynmn VAaN ety spatei. v 11 U0 etp oa fend
Ut Ry Liasnss

Lt AEn

ot T i

A mpie by

F i e dai

Aow Vetut Ut Loty Yoy
st Rens 04 Fom
ew Oy Faw Sowrte v e

ow.---n.m-nn.-.o‘ |Daa«

AC1.64 Lab 1: Creating a Database (

Access 2007

Figure 1.59

The new field has been added to the table and includes the same properties
as the Employee ID field in the Employee Records table. It is a primary key
field with a field size of 5. In addition, an association between the two
tables has been established, as can be seen in the Row Source row of the
Lookup properties, which identifies the source of the data for this row as
the Employee Records table.

Using a Lookup Field

Next, you will use the Employee ID lookup field to enter the employee
numbers for each record. Then you will complete the information for each
record.

www.mhhe.com/oleary ]




H i ) [ R ¥ Tamie Toon b Empiopeedt - Databune Wiicws J007) - Mcrotel Aloeet 5342 0L
04 S_W|tch to Datasheet L N — .
view. W Ty o n M Q) |G SRRt S iy S
Vom0 WA - IEE|ISA] | ot o te = M a1 951 % Wage et | 0 s+
. . Ve Outans trre . Rt To Fosmn o2 A Ve oz
@ If necessary, click in T —
the Employee ID field e ———— -
to make it active. e 1 = Lookup list contains all
i 2 unique values from
ooo Employee ID field
. Lesesd
@ Click [¥] at the end of
the box to open the
drop-down list of
options.
Your screen should be
similar to Figure 1.60
[Rmers @ 1t CER Tewin

Figure 1.60

The lookup list displays a drop-down list of all the values in the Employee
ID field of the Employee Records table. Clicking on an entry in the list
inserts it into the field.
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@ In a similar manner,
add the remaining
records (shown below)
to the table.

@ Best fit the columns.

Your screen should be
similar to Figure 1.61 |
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Figure 1.61
ID Location Position
12258 Chesterfield Food Service Manager
12583 Landis Greeter
13635 Landis Fitness Instructor
99999 Landis Records Administrator

The table now includes information on the location and job titles for the
same five records as in the Employee Records table.

Inserting a Field

As you consider the contents of the two tables, you realize that the Hire
Date information also should be in the Job table because the subject matter
is related to the employee’s job, not to his or her personal information.
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Your screen should be
similar to Figure 1.62 The new field has been inserted and defined.

Copying Field Content

Next, you will copy the data from the Hire Date field in the Employee
Records table to the new field in the Job table. A selection that is copied
creates a duplicate of the original, called the source, and stores it in the
Clipboard, a temporary storage area in memory. Then, to insert the
copied data from the Clipboard, you paste it in a new location, called
the destination.
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04 Click on the Employee

Records tab to make
the table active.

Select the Hire Date
column.

Click [22] Copy in the
Clipboard group of the
Home tab.

Click on the Job tab to
make the table active.

Select the Hire Date
column.

Click in the

Clipboard group of the
Home tab.

Click to
confirm the paste
operation.

Your screen should be
similar to Figure 1.63
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Figure 1.63

The hire date data for each record has been copied into the Hire Date field
of the Job table. All you need to do now is delete the Hire Date field in the
Employee Records table.

Make the Employee Records table active.

Delete the Hire Date field from the table.

Lab 1: Creating a Database (

Now, the Employee Records table only contains the employee’s personal
information and the Job table contains information about the employee’s job.

.Previewing and Printing a Table

Now that you have completed designing and entering some sample data in
the two tables, you want to print a copy of the tables to get your managers’
approval before you begin entering more employee records. Before printing
the tables, you will preview them onscreen to see how they will look when
printed.

Previewing the Table

Previewing a table displays each page in a reduced size so you can see the
layout. Then, if necessary, you can make changes to the layout before
printing, to both save time and avoid wasting paper.
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Button.
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@ Select Print and
choose Print Preview.

@ Hide the Navigation
pane.

Your screen should be
similar to Figure 1.64

Zoom slider

Current magnification level ] Figure 1.64

The Print Preview window displays how the table will appear when printed.
The Print Preview tab is open and includes commands that are used to
modify the print settings.

To see the information in the table more clearly, you can change the
magnification level of the preview window. The current setting, One Page,
adjusts the magnification to display an entire page in the preview window.
Additional Information You can drag the zoom slider in the status bar to increase the onscreen
The current magnification character size up to 10 times the normal display (1000 percent) or reduce
. leplaved inthe the character size to 10 percent. Clicking @ or @ on the zoom slider
status bar.

increases or decreases the magnification by 10 percent increments.

Notice that the mouse pointer is a magnifying glass when it is
positioned on the page. This indicates that you can click on the page to
switch between the One Page setting and the last-used magnification level
(initially 100%).
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Additional Information

The location where you click
will determine the area that is
displayed initially.

Your screen should be
similar to Figure 1.65

If necessary, make
sure your printer is on
and ready to print.
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Another Method

The keyboard shortcut is

(Cu)+P.

Your screen should be
similar to Figure 1.66

Having Trouble?

Please consult your instructor
for printing procedures that
may differ from the directions
given here.
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Figure 1.65

The table appears in 100 percent magnification. This is the size it will

appear when printed.

Printing a Table
The ‘3‘

Mt
and print the document.

button in the Print group is used to define the printer settings

[ Closes Print Preview ]

e
2 BT R T

L

Opens Print dialog box |4
to define print settings |13

Prints all pages

Lab 1: Creating a Database

Figure 1.66
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From the Print dialog box, you specify the printer you will be using and the
document settings. The printer that is currently selected is displayed in the
Name drop-down list box in the Printer section of the dialog box.

The Print Range area of the Print dialog box lets you specify the amount
of the document you want printed. The range options are described in the
following table.

All Prints the entire document.

Pages Prints pages you specify by typing page numbers in
the text box.

Selected Records Prints selected records only.

You will print the entire document.

If you need to change the selected printer to another printer, open the Name drop-down list box and select the
appropriate printer (your instructor will tell you which printer to select).

Click [_oc 1.

A status message box is displayed briefly, informing you that the table is
being printed. Your printed copy should be similar to the printout shown
in the Case Study at the beginning of the lab.

Changing the Page Orientation and Margins

Next, you will preview and print the Employee Records table.

n:] Mo : AL Enpioyees - Databate (orwes 00N - Micronolt Accwss -
=)

@ o ciick S inthe e . — .

Close Preview group. DAy s L)

@ Make the Employee
Records table active.

364 Paln Avwrue
3210 K Spndri®t Orive

@ Click ¥ Office TEOmag rve
Button . 1234 N Flth Sareet

@ Select Print and
choose Print Preview.

@ Click on the table to
zoom the preview.

Your screen should look
similar to Figure 1.67

Figure 1.67
Previewing and Printing a Table AC1.71

Access 2007



Notice that because the table is too wide to fit across the width of a page,
only the first six fields are displayed on the page. Tables with multiple
columns are typically too wide to fit on an 8!/, by 11 piece of paper. You
would like to see both pages displayed onscreen.

Displays two pages in
Preview window

ol /
94 Click | - | in the Zoom gy W o (A8 Evgterver - Dutabats thecrst 3900 - MoK Accviy = .

group.

Your screen should be
similar to Figure 1.68

Last four fields print
on second page

oo o AN A e —

[ Two pages displayed ] Figure 1.68

Rather than print the table on two pages, you decide to see whether
changing the orientation of the table will allow you to print it on one page.
Orientation refers to the direction that text prints on a page. Normal
orientation is to print across the width of an 8'/,-inch page. This is called
portrait orientation. You can change the orientation to print across the
length of the paper. This is called landscape orientation.
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Changes orientation
to landscape

Additional Information

Clicking || changes the

orientation to portrait.

Your screen should be
similar to Figure 1.69

Figure 1.69

Although this helps, there are still two fields that do not fit on the page. To
fix this, you will try reducing the size of the page margins. The margin is
the blank space around the edge of a page. You will decrease the right and
left margin settings to 0.25 inch to see if this helps all fields fit on the page.

__J | Adjusts page margins ] v e :
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@ Increase the All fields fit on one page
magnification to 90%.
Your screen should be
similar to Figure 1.70
Magnification at 90%
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Foray
Figure 1.70
You can now see that all the fields will print on one page.
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Print the table.

Close the Print Preview window.

Oa Display the Navigation

pane.

@ Click [X] Close
‘Employee Records’ in
the datasheet window.

@ If necessary, click

in response

to the prompt to save
the table.

@ In a similar manner,
close the Job table.

Your screen should be
similar to Figure 1.71
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Closing and Opening a Table and Databhase

You are ready to show the manager your printed table to get approval on
the setup of the data. But first you want to close the table and database
that you created.

Closing a Table and Database

You close a table by closing its window and saving any layout changes you
have made since your last Access session. Because you changed the
column widths of the table in Datasheet view, you will be prompted to
save the layout changes before the table is closed. If you do not save the
table, your column width settings will be lost.

,ny‘ ® B T et R (A8 Engioyees  Oatabaie theryes 00N - Mirerolt Acevty 0l
Meme | Crmate Dxtarrat Ot Ostatasr Taale v
Eor - X tatas €/ somiiomn :

& = - i et I B e Y totor
" - o Ty 1l P ssnain - G T
P e AR S SN | MWW Dot - St~ 1 951 T s ||

Wewi  Crgbama ford P e Lt o0 A rate ot

Table objects closed and Figure 1.71
work area is empty

The work area is empty because there are no open objects. The Navigation
pane still displays the names of the table objects. Next, you will close the
database.
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Click % Office Button
and choose Close
Database.

Another Method

Do not click [x] Close in the
Access window title bar as
this will exit the application.

Your screen should be
similar to Figure 1.72

More About
T —

) See “6 Managing and
s Maintaining Databases” in
the More About appendix to learn how to
save databases as a previous version.

Another Method

You also can click *= Office
Button and select the file
name from the Recent
Document list or choose
Open to browse your
computer to locate the file.
You also can use the
keyboard shortcut +0

to browse for files.

Additional Information

The default setting is to
display the last nine recently
used files. This setting can be
changed using "= Office
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Figure 1.72

The Getting Started window is displayed again so you can open another
existing database file or create a new one.

Opening a Table and Database

You want to make sure that you know how to access your table of
employee records, so you will reopen it and then close it again. Because
opening a file is a very common task, there are many ways to do it. You can
select the file name from the Open Recent Database list, which displays the
names of the last nine recently used files. If the file name is not listed, you
can click to browse your computer to locate the file.

You also can open database files that were created in previous versions of
Access that used the .mdb file extension. It must be converted to Access
2007 file format, however, if you want to take advantage of the new features
in Access 2007. If you plan to share a file with someone using Access 2003
or earlier, you can save the file using the .mdb file type; however, some
features may be lost. Otherwise, if you save it as an .accdb file type, the
recipient will not be able to open the file.

Closing and Opening a Table and Database AC1.75
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04 Choose Club Employees

from the Open Recent
Database list.

® Click in
the Security Warning
bar, select Enable this
content, and click
from the
Microsoft Office
Security Options
dialog box.

Double-click object
name to open

Having Trouble?

Depending upon the security
settings on your system, a

Security Warning may not be
displayed below the Ribbon.

i Double-click on the
Employee Records
table.
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Click expand indicators
to display subdatasheet
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Another Method

You also can drag the object
from the Navigation pane to
the work area to open it.

Your screen should be
similar to Figure 1.73

Figure 1.73

The database file is open and the Navigation pane displays the table name.
The Employee Records table is open in the work area. Notice the expand
indicators at the beginning of each row. This indicates there is a
subdatasheet linked to the records in this table.

Concept 7

Subdatasheet

[ A subdatasheet is a data table nested in another data table that contains data related or joined to the
table where it resides. A subdatasheet allows you to easily view and edit related data. Subdatasheets are
created automatically whenever relationships are established between tables.

~

~

J
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In this case, the subdatasheet is to the Job table. Clicking [# will expand
the table to show the information in the subdatasheet table, Job.
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Click next to the [ Exits Access application
first record.
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Figure 1.74

A subdatasheet appears and displays the location and job title information
ol e e aBouT contained in the Job table for Roberta Marchant. Then, to hide or collapse

relationships and the subdatasheet again, you click the collapse indicator .
subdatasheets in later labs.

Additional Information

94 Click [=] next to the first record.

You have created a database file that contains two tables and that follows
the two basic principles of database design: do not include redundant
information in tables and enter accurate and complete information.
Although you may think the employee number is redundant data, it is the
only way the information in the two tables can be associated. The
database attains the goals of normalization, a design technique that
identifies and eliminates redundancy by applying a set of rules to your
tables to confirm that they are structured properly. These rules ensure that
your design meets the normal form standards, a set of constraints that
must be satisfied. There are five sequential normal form levels; however,
meeting the third level, commonly called 3NF, is the level that is required
for most database designs. This level requires that every nonkey column
be dependent on the primary key and that nonkey columns are indepen-
dent of each other.

Closing and Opening a Table and Database AC1.77
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You also have followed the five steps (plan, design, develop, implement,
and refine and review) of the database design process while creating the
database.

,Exiting Access

You will continue to build and use the database of employee records in the
next lab. Until then, you can exit Access.

04 Click [x] Close in the Access window title bar.

Notice that this time you were not prompted to save the table because you
Another Method did not make any changes to it since last opening it. If you had made
You also can click ™ Office changes, you would be prompted to save the file before exiting Access.

Button and choose [X etacces |,

LA Focus on Careers

EXPLORE YOUR CAREER OPTIONS departments of the hospital, from the doctors, to the
Admitting Nurse pharmacy, and to the billing department. Without a
Can you imagine trying to organize the information of ~ proper understanding of database software, a hospital
hundreds of patients in a busy emergency room? This  cannot run efficiently. The average salary of an
is the job of an admitting nurse. They have to be able ~ admitting nurse is in the $40,000 to $50,000 range.
to enter, edit, and format data; add and delete  The demand for nurses is expected to remain high.

records; and so on. This information is used by all

AC1.78 Lab 1: Creating a Database (
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Concept Summary

Database

(AC1.4)

A database is an organized collection of
related information.

Nemnetue Pune

é‘l’ e R sk | ' BN Object (AC1.10)

o e An Access database is made up of

- o — several types of objects, such as a table
—~ ' or report, consisting of many elements.

Forawn (oordagw

0yt Servicn Mnagey An object can be created, selected, and
b manipulated as a unit.

. Data Type (AC1.17)

= | The data type defines the type of data
the field will contain. Access uses the
data type to ensure that the right kind
of data is entered in a field.

Nomnetvs Pune

Concept Summary AC1.79
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Concept Summary

Field Property (AC1.24)

A field property is a characteristic that
helps define a field. A set of field
properties is associated with each field.

Primary Key (AC1.29)

A primary key is a field that uniquely

identifies each record.

Field Property

S
VTG e O M S D ST SOy

Dot momts, day. waie [ for waampne, 17209

P

Lookup Field (AC1.62)

Sub

AC1.80
Access 2007

A lookup field provides a list of values
from which the user can choose to make
entering data into that field simpler and
more accurate.

atasheet (AC1.76)

A subdatasheet is a data table nested in
another data table that contains data
related or joined to the table where it

\resides.
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Lab Review

Allow Zero Length
property AC1.24

Attachment data type AC1.18
AutoNumber data type AC1.18
Best Fit feature AC1.51
Caption property AC1.24

cell AC1.12

Clipboard AC1.67

column width AC1.50
composite key AC1.29
Currency data type AC1.18
current field AC1.25

current record AC1.12

data type AC1.17

database AC1.4

Datasheet view AC1.12
Date/Time data type AC1.18
Default Value property AC1.24
Design view AC1.12
destination AC1.67

drawing object AC1.40

field AC1.4

field name AC1.14

field property AC1.24

Field Size property AC1.24
field template AC1.20

Creating a Datahase

LAB 1

foreign key AC1.59

form AC1.10

Form view AC1.12

Format property AC1.24
graphic AC1.40

header row AC1.12
Hyperlink data type AC1.18
Indexed property AC1.24
Input Mask property AC1.24
landscape orientation AC1.72
Layout view AC1.12

lookup field AC1.62

lookup list AC1.62

Lookup Wizard AC1.61
margin AC1.73

Memo data type AC1.18
navigation buttons AC1.12
Navigation pane AC1.11
normal form AC1.77
normalization AC1.77
Number data type AC1.18
object AC1.10

OLE Object data type AC1.18
orientation AC1.72

picture AC1.41

portrait orientation AC1.72

primary key AC1.29
Print Preview AC1.12
query AC1.10
record AC1.4

record number
indicator AC1.12

relational database AC1.4
report AC1.10

Report view AC1.12
Required property AC1.24
Select All button AC1.12
serial value AC1.18
source AC1.62
subdatasheet AC1.76
table AC1.4

template AC1.7

Text data type AC1.18

Validation Rule
property AC1.24

Validation Text
property AC1.24

value list AC1.62

view AC1.11

wizard AC1.61

Yes/No data type AC1.18

The Microsoft Certified Applications Specialist (MCAS) certification program is designed to measure your profi-
ciency in performing basic tasks using the Office 2007 applications. Getting certified demonstrates that you
have the skills and provides a valuable industry credential for employment. See Reference 2: Microsoft Certified
Applications Specialist (MCAS) for a complete list of the skills that were covered in Lab 1.
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Lab Review

Command Shortcut
@ Office Button

New

Open + O
Save +S
Print/Print + P

Print/Print Preview
Close Database
Home tab

Views group

E Design View

[[7 Datasheet View
Clipboard group
Cut +X
Copy +C
-
Records group

**|/Column Width
Find group
[l seect-]/Select

Table Tools Datasheet tab

Views group
[w Design View

[_ Datasheet View
Fields & Columns group

command summary

Opens a new blank database

Opens an existing database
Saves database object

Specifies print settings and prints current database
object

Displays file as it will appear when printed
Closes open window

Closes Access

Displays object in Design view

Displays object in Datasheet view

Removes selected item and copies it to the Clipboard

Duplicates selected item and copies to the Clipboard

Inserts copy of item from Clipboard

Deletes current record

Adjusts width of selected column

Selects current record

Displays table in Design view

Displays table in Datasheet view

Inserts a new field

Removes selected field column
o
AC1.82 Lab 1: Creating a Database ( www.mhhe.com/oleary )
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command summary

command summary )

Command Shortcut Action

T Renames selected field

Data Type & Formatting group
[pata Type: Tem ] Changes the data type for current field

| | Sets the display format of the selected field
Table Tools Design Tab

Views group

[ Design View Displays table in Design view
[ Datasheet View Displays table in Datasheet view
Tools group

Makes current field a primary key field

Deletes selected field row
Print Preview Tab
Print group

i Prints displayed object

Page Layout group

Al . q o o
3 Changes print orientation to portrait

Al
onercise Changes print orientation to landscape

Zoom group

Displays one entire page in Print Preview

j Displays two entire pages in Print Preview
Close Preview group
"f Closes Print Preview window
- /

Lab Review AC1.83
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Lab Exercises

screen identification

1. In the following Access screen, several items are identified by letters. Enter the correct term for
each item in the spaces provided.

t\d/

L Totan i §r U fencoen }) L4 Fapaty

€< Corte |
- Tiomng  £I L [ FEESEE » ety
e »J u A 3.‘ rae
13 . r Tee . ® AT oz

A1 Tables X = y ey [ = A

Umphoyee Rex oty o LA Name o First Neew « Addrans o Oty o[ ate <] 22Code « Home Phone

V' o Umphupee Recerds ) Tobte Marchant Aoberta 364 Palm Avenue Landis Ca 0L (S07) SIS AN0Y
| < 12 Delanc Gorden 1350 N. Sgungnt ettertiold | CA 21231 $307) 3353201} -t F

(20 oo Tetde « 158 Sivan Mare hessertiend | CA (307) 335 7190

* 14 Martinez uan Malge cA 0 (S07] 5352905

@/D' Y Neme Student hetsertie A 307] 559 3334

.

P I

w

Possible answers for the screen identification are:

L iraten e 2upt rsmber purigree ts even

Design view Select All button A J.
Cell Primary key indicator B K.
Record number Navigation buttons C L.
indicator Datasheet View button D M.
Field name Status bar E N.
Work area Tabs F. 0.
Ribbon Delete record G P.
Object Field H Q.
Field description Navigation pane I R.
End of table indicator Record
Open tab File menu
AC1.84 Lab 1: Creating a Database ( SR PrEW ey o )
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Match the numbered item with the correct lettered description.

1. primary key a. collection of related fields
2. Navigation pane b. a unit of a database
3. Datasheet view c. contains multiple tables linked by a common field
4. Attachment d. used to define the table structure
5. Design view e. used to open and manage database objects
6. field size f. a data type that stores multiple files of different file
types in a single field
7. data type g. field that uniquely identifies each record
8. object h. displays table in row and column format
9. record i. defines the type of data the field will contain
10. relational database j. controls the maximum number of characters that can

be entered in a field

Complete the following statements by filling in the blanks with the correct terms.

1. You use the located at the left of the work area to select the type of object you want
to work with.

2. The field property specifies how data displays in a table.

3. A field name is used to identify the stored in a field.

4. The data type restricts data to digits only.

5. Using orientation prints across the length of the paper.

6. The field property that limits a text data type to a certain size is called a(n)

7. A is a data table nested in another data table that contains data related or joined to
the table where it resides.

8. An Access database is made up of several types of

9. The is a field that uniquely identifies each record.

10. The data type can be used to store a graphic file in a field.

Lab Exercises AC1.85
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Lab Exercises

true/false

Circle the correct answer to the following statements.

1. A field description is a required part of the field definition. True False
2. Interactive databases define relationships between tables by having

common data in the tables. True False
3. A field contains information about one person, thing, or place. True False
4. The data type defines the information that can be entered in a field. True False
5. You can format the text in a Memo field. True False
6. A foreign key is a field in one table that refers to the primary key field

in another table and indicates how the tables are related. True False
7. Tables and queries are two types of database objects. True False
8. A lookup field that uses another table as the source for values is called a

value list. True False
9. A table is a required object in a database. True False

10. Changing the column width in the datasheet changes the field size. True False

multiple choice

Circle the letter of the correct response.

1. The last step of database development is
design

develop

review

plan

o TP

2. is a design technique that identifies and eliminates redundancy by applying a set of
rules to your tables.

Database development

Normalization

Validation

Orientation

is often used as the primary key.
phone number
catalog number
last name
first name

%
ooy > ogp

AC1.86 Lab 1: Creating a Database (

Access 2007

www.mhhe.com/oleary ]




10.

You may lose data if your data and are incompatible.
field name

data type

default value

field size

o e

affects the amount of data that you can enter into a field.
. Column width
Field size
Format
Description size

pe e

A is a field in one table that refers to the primary key field in another table and
indicates how the tables are related.

a. foreign key

b. common key

c. related key

d. data key

A(n) provides a list of values from which the user can choose.
a. value field

b. lookup field

c. related field

d. attachment field

Graphics can be inserted into a field that has a(n) data type.
a. graphic

b. text

c. attachment

d. memo

The basic database objects are

panes, tables, queries, and reports
tables, queries, forms, and reports
forms, reports, data, and files
portraits, keys, tables, and views

I

view is only used to modify the table structure.
Design
Report
Datasheet
Query

gao op

Lab Exercises AC1.87
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Lab Exercises

Hands-On Exercises

% Easy

% % Moderate
step-by-ste
L oder

Oak Ridge School Parent Contact Database *

| 1. Oak Ridge Elementary School has decided to set up a database with the contact information for
all students. As a parent, you have volunteered to do the initial database creation and teach the
secretary at the school to maintain it. The database table you create will have the following
information: student’s last name, student’s first name, guardian’s name, home address, and home
phone number. When you have finished, a printout of your completed database table should look
similar to the one shown here.

CtenosS

L] Sudert LR Name Stydent Fegt Neme Guarden street Address Cey Nte TP Code  Home Pheng Argrngie Moee
§ Aoderick Sty $hanncn Roderick 1268 Wiview 24 Oak Rdpe UT 21380 (R0 ss0e 4
3 Salagar Glorla Setha Salac 105 Ok Ave Osk Rdpe UT 22300 (903 5558411
dName Student Ricardy Aam irez 107 Ok Ave Onk 2dge VT 23301 (S0 S55A6%0  (B02) 888471

AC1.88 Lab 1: Creating a Database (
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a. Create a blank database named 0ak Ridge School. Design a table in Design view named Students
using the following field information. Make the ID field the primary key field.

Field Name Data Type Description Field Size
ID AutoNumber Long Integer
Student Last Name Text Student’s legal
last name 25
Student First Name Text Include student’s nickname
in parentheses 25
Guardian Text First and last name of
primary guardian 55
Street Address Text 75
City Text 20
State Text Two-letter abbreviation 2
ZIP Code Text 5
Home Phone Text 15

Record 1 Record 2 Record 3
Roderick Avery Salazar
Smithy Wilson Gloria
Shannon Roderick Rita Avery-Montoya Betha Salazar
1293 Hillview Rd. 102 4th Street 103 Oak Ave.
Oak Ridge 0Oak Ridge Oak Ridge

ut ut ut

22301 22301 22301

(802) 555-0914

(802) 555-3375

(802) 555-8411

Lab Exercises

b. Enter the following records into the table, using Copy and Paste for fields that have the same
data (such as the city):

AC1.89
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Lab Exercises

C.

d.

5 W

j-

Adjust the column widths appropriately.
Delete record 2. Add another record with the following data:

[Your last name]
[Your first name]
Ricardo Ramirez
107 Oak Ave.
Oak Ridge
ut
22301
(802) 555-8632
Add a new field after the Home Phone field with the following definitions:

Field Name: Alternate Phone
Data Type: Text
Field Size: 15

Change the ZIP Code field size to 10.

Enter the Alternate Phone number of (802) 555-9711 and the ZIP Code of 22301-4459 for the
record with ID number 4.

Best fit all columns.

View the table in Print Preview; change the page orientation to landscape and margins to
Narrow.

Print, save, and close the table.

EchoPlex Records Database * %

2. Your record collection has expanded beyond a hobby into an online business. In order to meet the
needs of your expanding client base, you need to get your inventory cataloged. When you are
finished, your printed database table should be similar to the one shown here.

AC1.90

Access 2007

Records 10/6/2008
Catalog Number Item Title Acquired Date (0}
iLe Up 8/13/2002 (1)
312" Forever Blue 7/8/2005 U(0)
aLp Definitive Collection 3/3/2003 (0)
5 Student Name 10/6/2008 U(0)

_— T~
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a. Create a blank database named EchoPlex.
b. From the Assets Field Templates list, add the following fields to the table:
Item
Description
Acquired Date
Attachments
c. Switch to Design view. Save the table as Records.
d. Change the ID Field Name to Catalog Number. Change the Description Field Name to Title.
e. Change the Field Size of the Item field to 4.
f. Return to Datasheet view. Add the following records to the table:
Item LP 12” 12” LP
Title Up Rank Forever Blue Definitive
Collection
Acquired Date | 8/13/2002 4/1/2006 7/8/2005 3/3/2003
g. Insert the image file ac01_Guitar in the Attachment field of the first record.
h. Adjust the column widths using the Best Fit feature.

i. Delete the record for the title Rank. Add a new record and enter your name in the Title field
and the current date in the Acquired Date field.

j. Preview and print the table in portrait orientation with wide margins.

k. Save and close the table. Exit Access.

Library Catalog Database % %

3. You are a volunteer at a small county library. The library recently received a large collection of
young adult books and would like to keep better track of the titles. The library is still using an
antiquated method for cataloging most its books. Because of your computer skills, you have been
asked to create a database containing the catalog number, title, author, and copyright date of each

Lab Exercises AC1.91
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Lab Exercises

of the new books. The young adult titles database will serve as a model for the library’s entire
collection; after it is done, the database will make search, tracking, and inventory functions much
easier. Your printed database table should be similar to the one shown here.

Cazolcg 10/6/2000
Catnlogn Tee Destrgtion Azguired Date BeN Lotation Condtion
15penk Proertack 8/12/2006 340817615 buiang Sinding loose
ot Pacertach 8/17/2006 375821813 Bulcng
GArtem g Powl rardCover $/17/2006 161313133 8cokmablle Miggirg dug achet
SWollie Hard¢over 9/19/3008 199389231 Bookmobile

e

. Create a blank database named County Library.

12;. Add fields using the following field templates from the Assets list:
Item
Description
Acquired Date
Manufacturer
c. Switch to Design view. Save the table as Catalog.
d. Edit the field properties using the following information:
Field Name Data Type Description Field Size
Change ID to Catalog # AutoNumber
Change Item to Title Text Include complete title 150
Description Text Hardcover or paperback | 15
Change Manufacturer to ISBN | Text Unique 10-digit number | 10
AC1.92 Lab 1: Creating a Database (wwmhhecomroteay )
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e. Add the following new fields:

f. Switch to Datasheet view and enter the following records into the table:

P 0

Field Name | Data Type | Description Field Size
Location Text Building or Bookmobhile 30
Condition Memo Describe condition of book if needed

Record 1 Record 2 Record 3 Record 4
Title Speak Freak the Mighty Hoot Artemis Fowl
Description Paperback Paperback Paperback Hardcover
Acquired Date | 8/12/2006 8/12/2006 8/17/2006 8/17/2006
ISBN 0340817623 0439286069 0375821813 0141312122
Location Building Bookmobile Building Bookmobile
Condition Binding loose Missing dust jacket

Best Fit all column widths.
Delete record 2. Add another record with the following data:

Title:
Description:
Acquired Date:
ISBN:
Location:

Wolfie
Hardcover
9/29/08
0299389231
Bookmobile

Check the table in Print Preview. Change the page layout to landscape with wide margins.
Print, save, and close the table. Exit Access.

Lab Exercises
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DownTown Internet Café Inventory Database * %k %

4. The Downtown Internet Café, which you helped get off the ground, is an overwhelming success.
The clientele is growing every day, as is the demand for the beverages the café serves. Up until
now, the information about the vendors has been kept in an alphabetical card file. This has
become quite unwieldy, however, and Evan, the owner, would like a more sophisticated tracking
system. He would like you to create a database containing each supply item and the contact
information for the vendor that sells that item. When you are finished, your database tables

should be similar to those shown here.

Suppliers
0 vendar Contact Frst Name Contact Last Name Bsness Phone Emad Address
1Cppoa o ieip Brooks 1502) 5559090 Leia Brocks@ouppaoe ©
2 Natural Nectors Estrells Ramireez {206} 555-5586 etre @ nnectar com
5TeaTime Audey Chischine (206)555-6100 o Ptestime com
& Paper froducts e Student Name (208)555-9999 stude rtname Bpoperpeo

10/6/2000

Stock

ftem Description Vendor
\_/\ 197 Café Mocha Cuppa Jo

198 Mango Strawberry Flavoring Natural Nectars

199 Chamomile Tea Leaves Cuppa Jo
200 Napkins Paper Products etc.

AC1.94 Lab 1: Creating a Database
Access 2007
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(o)

www.mhhe.com/oleary ]




a
b
c.
d
e

f. Create a second table using the following field templates from the Contacts list:

Switch to Design view. Save the table as Stock.
. Delete the ID field. Make Item the primary key field.
. Add the following information to the field properties:

. Create a blank database named Cafe Inventory.
. Design a table using the Item and Description field templates from the Assets list:

Field Name | Data Type | Description Field Size
ltem Text Unique three-digit product

number 3
Description | Text Name of product 50

Company

First Name
Last Name
Business Phone
E-mail Address

g. Switch to Design view. Save the table as Suppliers.
h. Edit the field properties as shown here:

Field Name Data Type | Description Field Size
Change Company to Vendor Text Company name of supplier 50
Change First Name to Contact Text
First Name 50
Change Last Name to Contact Text
Last Name 50
Business Phone Text Include the area code

in parentheses: (800) 555-5555 | 15
Change E-mail Address to E-mail | Text E-mail address

of contact person 50

Lab Exercises AC1.95
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i. Enter the following records into the Stock and Suppliers tables:

Stock table
Record 1 Record 2 Record 3
197 198 199
Café Mocha Mango Strawberry Chamomile

Flavoring Tea Leaves
Suppliers table
Record 1 Record 2 Record 3 Record 4
Cuppa Jo Natural Nectars Tea Time Paper Products etc.
Leila Estrella Audry Enter your first name
Brooks Ramirez Chischillie Enter your last name
(502) 555-9090 (206) 555-5986 (206) 555-6001 (206) 555-9999
Ibrooks@cuppajo.com | estrella@nnectar.com ac@teatime.com Yourname@paperproducts.com

Add the existing field, Vendor, from the Suppliers table as the last field in the Stock table.

In the Stock table, select Cuppa Jo as the vendor for the first record, Natural Nectars for the

second record, and Tea Time for the third record.

1. In the Suppliers table, edit the record for ID 1 by changing the E-mail address to

Leila.Brooks@cuppajo.com.

m. Add a new field to the Stock table named Picture. Make the data type Attachment. For item
number 198 insert the file ac01_Flavoring.

n. Add the following new item to the Stock file.

Item: 200
Description:  Napkins

P

Vendor: Paper Products etc.

0. Adjust the column widths in both tables using Best Fit.

p. Preview the Suppliers table. Change to landscape orientation. Change the margins to wide and
print the table.

q. Close the database. Exit Access.

AC1.96 Lab 1: Creating a Database (
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Kodiak Construction Database * % %

5. You have just been hired by Kodiak Paint and Construction to create and maintain a database
containing information about their clients and jobs. The company has grown rapidly and they
need ready access to information about jobs spread across the city. When you are finished, your

tables should be similar to those shown here.

2 Hector Valdez (303) 555-7677 G(a)
3Bob England (303) 555-6123 (o)
4Ricky pisano (303) 555-9438 )
5 Student Name (303) 555-7712 (o)
Cleres 20/6/2008
0 FrtName  Lest Neme acdress Cay Stete | 2IPCode | Business Phone

1Joe some 20050 W 13thPlace  Lakewoed €O 20215 [303) 5551232

2 Timethy McGhee 135 Mountan Pesk Rd. Aurcrs (O 80011 (303 5557922

3 Chariotre Foss 29 avery Rd Dermver («v] 8028 {303) 55525258

S Migue! Sanchez TJ218 N Crestview St Giendee CO 80246 (303) 555-C932

SAlsn Cheng B2 Pire Land Denver (O g0 (303) 5550048

1D Job Client Last Name Begin Date Forema Job Description Job Location Job Estimate
010 Ridgeline Condos Foss 2/18/2008 Pisano New construction of 75 condo units  Aurora $2,500,000.00
053 R BarCRanch Sanchez 7/18/2008 Englan Private home guest addition Glendzle $125,000.00
062 Sandalwood Villa McGhee 9/15/2008 Name Remodel restaurant Aurora $750,000.00
112 WilliamsRetreat Bortle 12/13/2008 Valdez New construction Golden $925,000.00
Foremen 10/6/2008
ID Foreman First Name Foreman Last Name Mobile Phone 0
1Jonathan Hedly (303) 555-1480 (o)

- T~
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Lab Exercises

a. Create a blank database named Kodiak Construction. Design a table using the following field
templates from the Projects list:

Project Name
Begin Date
End Date
b. Add the following additional fields to the table.

Field Name Type
Job Description Memo
Job Location Text

Job Estimate Currency

Save the table as Jobs. Switch to Design view.
Change the Project Name field name to Joh. Delete the End Date field. Add field descriptions
and make the changes to the field properties shown in the following table:

o

Field Name Data Type | Description Field Size | Format

ID Text Unique three-digit job ID 3

Joh Project Name 75

Begin Date General date
Joh Description Brief description of project

Job Location Text Enter city only 25

e. Enter the following records into the table:

Record 1 Record 2 Record 3 Record 4 Record 5
034 062 010 053 112
Summit Sandalwood Ridgeline R Bar Williams
Lakes Villa Condos C Ranch Retreat
4/13/2008 9/15/2008 2/18/2008 7/18/2008 12/13/2008
Remodel Remodel New construction Private home New
golf club restaurant of 75 condo units guest addition construction
Denver Aurora Aurora Glendale Golden
1,200,000 750,000 2,500,000 125,000 925,000
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f. Adjust the column widths using Best Fit.

Delete the record for the Summit Lakes job.
Create a second table for the client information using the following field templates from the
Contacts list:

5w

First Name

Last Name
Address

City
State/Province
ZIP/Postal Code

Business Phone

i. Save the table as Clients.

j. Add field descriptions and make the changes to the field properties shown in the following

table:
Field Name Data Type | Description Field Size
First Name First name of client 25
Last Name Last name of client 25
Address Text 50
Change State/Province to State Use two character abbreviation 2
Change ZIP/Postal Gode to ZIP Code Enter 10 digit code, if available 10
Business Phone Enter phone as (###) ###-#### 14
k. Add the following client information:
Record 1 Record 2 Record 3 Record 4 Record 5
First Name | Joe Timothy Charlotte Miguel Alan
Last Name | Bortle McGhee Foss Sanchez Chang
Address 20032 W. 135 Mountain 39 Avery Rd. 7218 N. 82 Pine Lane
13th Place Peak Rd. Crestview St.
City Lakewood Aurora Denver Glendale Denver
State co co co co co
ZIP Gode 80215 80011 80012 80246 80002
Business (303) 555-1232 | (303) 555-7922 | (303) 555-2525 | (303) 555-0932 | (303) 555-0048
Phone
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Lab Exercises

1. Create a third table for the foreman information with the following fields:

Field Name Data Type Description Field Size
Foreman First Name Text 25
Foreman Last Name Text 25
Mobhile Phone Text Enter phone as

() HEH-BEHH 14
Picture Attachment Photo of foreman

m. Save the table as Foremen.
Enter the following information for the five foremen.

B

Jonathan Hedly Hector Valdez Bob England Ricky Pisano Your Name
(303) 555-1480 (303) 555-7677 | (303) 555-6123 | (303) 555-9438 | (303) 555-7712

o. Add the file ac01_Valdez to the attachment field for Hector Valdez.

p. Add the existing field Foreman Last Name from the Foremen table to the Jobs table after the
Begin Date field.

q. Enter the following foremen for each job:

Job Foreman
010 Pisano

053 England
062 Your Name
112 Valdez

r. Add the existing field Last Name from the Clients table to after the Job field in the Jobs table.
Rename the field Client Last Name.

AC1.100 Lab 1: Creating a Database (

Access 2007

www.mhhe.com/oleary ]




s. Enter the following clients for each job:

Job Client
010 Foss
053 Sanchez
062 McGhee
112 Bortle

t. Best fit all fields in all tables.

u. Preview and print the Jobs table in landscape orientation with narrow margins. Print the
Foremen table in portrait orientation with wide margins.

v. Save and close all tables and exit Access.

Valley View Newsletter Advertising Database %

st 1. Your homeowner’s association distributes a monthly newsletter, Valley View News, to keep

R residents up to date with neighborhood news. In the past year, there has been rapid growth in
building, including more houses and small office complexes. There are also plans to build an
elementary school, fire station, and shopping center in the community. Consequently, the
newsletter is now the size of a small newspaper, and the homeowners’ dues are not covering the
expense of publishing it.

The editorial staff has already begun selling ad space in the newsletter to local businesses, and,
based on your background in database management, they have asked you to set up a database to
keep track of the advertiser contact information. You agree to design such a database, called Valley
View News, and tell them you will have something to show them at the next meeting. Your finished
database should include each advertiser’s billing number, business name and address, and contact
name and phone number in a table named Advertisers. Enter 10 records and include a record that
has your name as the contact name. Preview and print the table when you are finished.

Lab Exercises AG1.101
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Lab Exercises

Music Collection Database *

2. You have just purchased a 200-disk CD carousel and now you would like to organize and catalog
your CDs. You realize that without an updatable list, it will be difficult to maintain an accurate list
of what is in the changer. To get the most out of your new purchase, you decide a database is in
order. Create a new database called Music Collection and a table called CD Gatalogue. The table you
create should include the Artist’'s Name, Album Title, Genre, and Position Number. Make the
Position Number field the primary key (because you may have multiple CDs by a given artist).
Enter at least 15 records. Include an entry that has your name as the artist. Preview and print the
table when you are finished.

Patient Database %

3. You are the manager of a newly opened dental office. As one of your first projects, you need to
create a patient database. Create a database called Dental Patients and a table named Personal
Information. The database table you set up should contain patient identification numbers, last and
first names, addresses, and phone numbers. Also include a field named “Referred by” and another
field named “Patient since”. Use appropriate field sizes and make the ID number field the primary
key. Enter at least ten records, adjusting the column widths as necessary. Include a record that
contains your name as the patient. Preview and print the table.

Old Watch Database Using the Web % %

4. You have a small online business, Timeless Treasures, that locates and sells vintage wrist and pocket
watches. Your business and inventory has grown large enough now that you have decided to use a
database to track your inventory. Create a simple database named Timeless Treasures with a table
named Watches that contains identification numbers, manufacturer (Waltham, Hamilton, Melrose),
category (pocket watch, wrist watch), description, price, and quantity on hand. Size the fields
appropriately and assign a primary key to one of them. Enter at least 10 records in the table. To
obtain data about watches to include in your table, search the Web on “old watches”. Use the
information you locate to complete the data for the records in your table. Adjust column widths as
necessary. Include your name as the manufacturer in one of the records. Preview and print the table.

Expense Tracking Database % % %

5. You work in the accounting department at a start-up company called EMP Enterprises. One of
your duties is to process, which up until now was a simple task of having the employees fill out a
form and submit it to you for payment. You would then cut a check for them and charge it to the
general expense fund of the company. However, the company has grown tremendously in the last
year, adding employees and departments at a rapid rate, and the executive team has decided that it
is time to start managing the income and expenses on a much more detailed level. To this end, you
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need to create a database that includes the employee ID, employee name, submission date,
expense type, and expense amount for each expense report that is turned in. Name the database
EMP Enterprises. Create two tables, one for the employee information named Employee Info and the
other for employee expenses named Employee Expenses. Include the Employee ID, First Name and
Last Name fields in the Employee Info table. Include the Employee ID, Submission Date,
Expense Type and Expense Amount fields in the Employee Expenses table. Use the Currency data
type for the Expense Amount field, and appropriate data types for all other fields. Size the fields
appropriately. Delete the ID field from the Employee Info table and make the Employee ID field
the primary key. Enter at least 15 records. Adjust the column widths as necessary. Delete one of
the records you just entered, and then edit one of the remaining records so it contains your name
as the employee. Enter 10 records in the Employee Expenses table (one should be an expense
record for the record containing your name.) Preview and print both tables.
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Modifying and Filtering

a Table and Greating LAB 2
a Form

Objectives

After completing this lab, you will know how to:

Navigate a large table.

o

Change field format properties.

©

Set default field values.

o

Insert a field.

&

o

efine validation rules.

o

ide and redisplay fields.

©

(]

reate a lookup field.

Q

-n
(=1

and replace data.

w
o
=t

rt records.

-
(=]

rmat a datasheet.

©

-

ilter a table.

®

Create, modify, and use a form.

®

Preview, print, close, and save a form.

14/

Identify object dependencies.

5,

Add file and object documentation.
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Case Study

Lifestyle Fitness Club

The Lifestyle Fitness Club owners, Ryan and Felicity,
are very pleased with your plans for the organization
of the database and with your progress in creating
the first table of basic employee data. As you have
seen, creating a database takes planning and a great
deal of time to set up the structure and enter the
data. As you have continued to add more employee
records to the table,

structure and to customize field properties to pro-
vide more control over the data that is entered in a
field.

Even more impressive, as you will see in this lab,
is the program’s ability to locate information in the
database. This is where all the hard work of enter-
ing data pays off. With a click of a button, you can
find data that might

you have noticed sev-

eral errors. You also
realize that you forgot
to include a field for
the employee's gen-
der. Even with the
best of planning and
care, errors occur and
the information may
change. You will see
how easy it is to
modify the database

otherwise take hours
to locate. The result
saves time and im-
proves the accuracy
of the output.

You also will see
how you can make
the data you are look-
| ing at onscreen more
pleasing and easier to
read by creating and
using a form.
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Concept Preview

The following concepts will be introduced in this lab:

Format Property The Format property is used to specify the way that numbers, dates, times,
and text in a field are displayed and printed.

Default Value Property The Default Value property is used to specify a value that is
automatically entered in a field when a new record is created.

Validation Rule Validation rules are used to control the data that can be entered in a field by
defining the input values that are valid or allowed.

Expression An expression is a formula consisting of a combination of symbols that will
produce a single value.

Find and Replace The Find and Replace feature helps you quickly find specific information
and automatically replace it with new information.

Sort You can sort the data in a table to quickly rearrange the order of the records.

Filter A filter is a restriction placed on records in the open datasheet or form to quickly isolate
and display a subset of records.

Form A form is a database object used primarily to display records onscreen to make it easier
to enter new records and to make changes to existing records.

Controls Controls are objects that display information, perform actions, or enhance the design

of a form or report. Y,

,Navigating a Large Table

You have continued to add more records to the Lifestyle Fitness Club
employee database. As you entered the data, you know you made data
entry errors that still need to be corrected. Additionally, you have found
that with the addition of records, it takes much longer to move around in
the datasheet. Typical database tables are very large and consequently can
be very inefficient to navigate. Learning how to move around in a large
table will save time and help you get the job done faster. You want to open
the expanded database that you saved using a new file name, and to
continue working on and refining the Records table.

Note: Before you begin, you may want to create a backup copy of the ac02_Employees file by
copying and renaming it.
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By default, the table is displayed in Datasheet view. As you can see from

 Open the Employee the record number indicator, the updated table now contains 53 records.

Records table.

Moving Using the Keyboard
Your screen should be I 1 bl h hod ickl .
similar to Figure 21 n a large table, there are many methods you can use to quickly nav1gate

through records in Datasheet view. You can always use the mouse to move
from one field or record to another. However, if the information is not
Having Trouble? visible in the window, you must scroll the window using the scroll bar
Your screen may display a first. The following table presents several keyboard methods that will help
different number of records -

you move around in the datasheet.

depending on your monitor
Keys Effect

settings.
Down one window
Up one window
+ Left one window
+ Right one window
+ Last field of last record

+ First field of first record
+ Current field of first record

+ Current field of last record

Currently, records 1 through 27 are displayed in the work area. You can
easily move from one window of records to the next.

Navigating a Large Table AC2.5
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Press +
(Page Down).

Your screen should be
similar to Figure 2.3

AC2.6

Now records 27 through 53 are displayed in the window. The first record
in the window is now the current record.

Because of the number and width of the fields, all of the fields cannot
be displayed in the window at the same time. Rather than scrolling the
window horizontally to see the additional fields, you can quickly move to
the right a window at a time.
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The table scrolled horizontally one window to the right and the last two
fields in the table are now visible.

Moving Using the Navigation Buttons

The navigation buttons in the status bar also provide navigation shortcuts.
These buttons are described in the following table.

Another Method

You also can use in
the Find group of the Home
tab to access the navigation
buttons.

First record, same field

Previous record, same field

Next record, same field
Last record, same field

New (blank) record

You will use the navigation buttons to move to the same field that is
currently selected in the last record, and then back to the same field of the
first record. Then you will move to the first field of the first record.

Additional Information

You can move to a specific
record by typing the record
number in the Record
Number Indicator box.

- 3 A e e 3t 4Rk
Click E Last Record. 03 _ Pressing quickly moves dne s
T mme RS o first field of first record "
i" | - —— _ i tew X Totan 1) r ¢/ Lavcren - .ﬁ Lo Brgmacy
W'l W - lmi’r- Wi P sosting | 31 ree 2 P25
Click [«] First Record. | RLES R e SIS M o6 e - M Fewpotie | "2 7y
VYem  Outens et Ran Tedt Eermisy o Ayt fos
Tobles
ErrTTT Erplopen il Last Naow = Fvthame « Addrem Cfty. = S8 « | 2Code = HomePhene « B
Press _ = « R semn Chad IS Cactuslv,  Chestarfield CA i (867) $38-0020
» 006LY Nicsely Cattry 73 hrockies Or ancs CA "o (357 358-0001
. 008GY Parvingion  Mark 23S Ave ros [+ ] noix (507) 355-3333
* 03431 Sty Tathy 90 Reyal O Vadin CA 1230 (307) 8551008 d
* 0 Morgan o 364 5. Lamon Dr vaizin CA 2207 (307) 333-3367
Your screen should be eyt 2 R R et 5 :
similar to Figure 24 * 0390 ™ trons T68 Forert Ave Rver Mt CA |nc9n5|.ster.1t
» o Sabe Greg i Rewhide Ave.  Ohesterfield CA capitalization
A 04T Marchast Roderta 264 Paben Averue Lanas A S 7 v~ 1
# 05018 g e S Camalback Rt  Bver Vit Ca MIIANT (N7) S350
* 06000 Robertson Ork B2 S Witkam Ave Maan caA uin 1357) 55570
» oray Roman Ana 2543 S, Bala Or vaan CA SNL 340 (307 559020
* o Ry trege 53 Palm 3¢ Chastertiale CA MIA1A [307) 334000
.y Lettow Kyan 338 Magile Dr. Maan cA STU5E0 (307) S55- 2005
EReL ] Poknsky Miteh 01 L SPandan vean CA MWA3-RE |307) 4581018
» 220 Young am 9 CoSage dve \anay CA 7o (307) 335-10%9
.12 Aeste Suarre 932 E Parkway Or wros CA 22 [367) $55-1191
* 1208 Rarn Cathy 570 Awrtrn Ave Chantarfinld CA 0w SN s
- Oetano Gorgon N, Springrft O,  Chasterfalo €A 221008 (T 3508
& 12e% Stacey [ ) 737 5 College Ao Chesterfield CA INIAI-1208  (I0T) 345 TTM4
* 1 Blackman  Jeeniter L el 82 Rever N CA 132203 |I0T) 854988
. i Oetuca Elraveth AW, Southam Ave.  Lands A m» (347) 3551145
* 1% Sdlivan Mare 78 O=ags Drive Chanterfinio CA 112 (N0T) 83510
* oM Redte Mare P00 W. Compus Or.  Maidin CA s (367) 335-11099
. 2602 Lattow Meldta AN 1R Pver st CA s (307) 535. 7798
* e Lt o S401 € Thomas hd Landiy ca ae (367) 335-Tes
. Less Rueleng Valerin M University Dr Madin CA SA-IRO (AT) 551843 v
L ‘ilnnn 109 b w San ‘ _ N .
[TRSr——————r— \ [Basax

AN

Moves to same
field of last record

’ Figure 2.4

Moves to same
field of first record

The first field of the first record is selected.
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JGustomizing and Inserting Fields

As you looked through the records, you noticed that record 3 has a
lowercase entry in the State field and that record 10 has a mixed-case
entry. You want all the State field entries to be consistently entered in all
uppercase letters. Also, because all the club locations are in California, it
is unlikely that any club employees live in another state. Rather than
repeatedly entering the same state for each record, you want the State
field to automatically display CA. You will make these changes to the State
field by modifying its properties.

Additionally, you realize that you forgot to include a field for each
employee’s gender. While developing a table, you can modify and refine
how the table operates. You can easily add and delete fields and add
restrictions on the data that can be entered in a field as well as define the
way that the data entered in a field will be displayed.

Setting Display Formats

You will begin by fixing the display of the entries in the State field. Instead
of manually editing each field, you will fix the entries by defining a display
format for the field to customize the way the entry is displayed.

~

Concept 1

Format Property

1 The Format property is used to specify the way that numbers, dates, times, and text in a field are dis-
played and printed. Format properties do not change the way Access stores data, only the way the
data is displayed. To change the format of a field, you can select from predefined formats or create a
custom format by entering different symbols in the Format text box. Text and Memo data types can
use any of the four symbols shown in the following table.

Symbol Meaning Example

@ Requires a text character or space @@Q@-@@-@@@ would display
123456789 as 123-45-6789. Nine charac-

ters or spaces are required.

> Forces all characters to uppercase > would display SMITH whether you
entered SMITH, smith, or Smith.

< Forces all characters to lowercase < would display smith whether you
entered SMITH, smith, or Smith.

& Allows an optional text character @@-@@& would display 12345 as 12-345
and 12.34 as 12-34. Four out of five
characters are required, and a fifth is
optional.

/

You want to change the format of the State field to display the entries in
all uppercase characters.
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Figure 2.5
Setting Default Values

Next, you want to change the State field for new records to automatically
display CA. To do this, you specify a default value property.

~

Concept 2

Default Value Property

p The Default Value property is used to specify a value that is automatically entered in a field when a
new record is created. This property is commonly used when most of the entries in a field will be the
same for the entire table. That default value is then displayed automatically in the field. When users
add a record to the table, they can either accept this value or enter another value. This saves time while
entering data.

You will set the State field’s default value to display CA.
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Value property text
box.

® Type CA.

® Press (Enter).

Your screen should be
similar to Figure 2.6
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The default value is automatically enclosed in quotation marks to identify
the entry as a group of characters called a character string. To see the
effect on the table of setting a default value, you will return to Datasheet
view and look at a new blank record.

Next, you want to see the effect of the modifications to the State field’s
properties on the table.
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Click [+ | New (blank)
Record on the status

bar to move to a new
record.

Your screen should be
similar to Figure 2.8

Another Method

You also can insert a field in
Datasheet view by moving to
the location where you want
to insert the new field and
using on the
Datasheet tab. However, you
still need to switch to Design
view to set the new field's
properties.

You can see that records 3 (Mark Pennington) and 10 (Scot Briggs) now
correctly display the state in capital letters. Setting the format for the field
will prevent this type of error from occurring again.
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Figure 2.8

New (blank)
record button

The new blank record at the end of the table displays CA as the default
value for the State field. If you did need to enter a different state, it would
display in all capital letters because of the format property setting
associated with the field.

Inserting a Field

Now you want to add the new field to hold each employee’s gender.
Although it is better to include all the necessary fields when creating the
table structure, it is possible to add fields to a table at a later time. After
looking at the order of the fields, you decide to add the Gender field
between the Home Phone and Birth Date fields. To do so, you will switch
to Design view to insert the new field in the table.
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Switch to Design view.

Make the Birth Date
field current.

Click in the

Tools group of the
Design tab.

Another Method

You also can use Insert Rows
on the shortcut menu.

Your screen should be
similar to Figure 2.9

Enter the new field
definitions from the
table shown here:

Field Name | Gender

Data Type Text

Description | Enter f for
female and
m for male.

Field Size 1

Format >

Your screen should be

similar to Figure 2.10
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A new blank row is inserted into the table. Next, you will name the field
and set its properties.
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Defining Validation Rules

The only two characters you want the Gender field to accept are F for
female and M for male. To specify that these two characters are the only
entries acceptable in the Gender field, you will add a validation rule to the
field’s properties.

~

Concept 3

Validation Rule

“B Validation rules are used to control the data that can be entered in a field by defining the input val-
ues that are valid or allowed. Certain checks on the validity of the data that is entered in a field are per-
formed automatically based on the field’s data type and size. For example, in a field whose data type
is Number and size is five, the type of data that can be entered in the field is restricted to a maximum
of five numeric entries. You can further refine these basic restrictions by adding a validation rule to the
field’s properties that defines specific restrictions for the type of data that can be entered in the field.

You also can include a validation text message. Validation text is an explanatory message that
appears if a user attempts to enter invalid information in a text field for which there is a validity check.
If you do not specify a message, Access will display a default error message, which may not clearly
describe the reason for the error.

/

You will create a validation rule for the Gender field to restrict the data
entry to the two valid characters. A validation rule is specified by entering
an expression in the validation rule property that limits the values that can
be entered in the field.

Customizing and Inserting Fields AC2.13
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Concept 4

Expression

~

4 An expression is a formula consisting of a combination of symbols that will produce a single value.
You create an expression by combining identifiers, operators, and values to produce the desired results.
An identifier is an element that refers to the value of a field, a graphical object, or a property. In the
expression [Sales Amount] + [Sales Tax], [Sales Amount] and [Sales Tax] are identifiers that refer to
the values in the Sales Amount and Sales Tax fields. ldentifiers are separated by dots or exclamation
points. Each part of an identifier is surrounded by square brackets.

An operator is a symbol or word that indicates that an operation is to be performed. Common
mathematical operators are + for addition, - for subtraction, * for multiplication, and / for division. A
comparison operator is a symbol that allows you to make comparisons between two items. The fol-
lowing table describes the comparison operators:

Operator Meaning

= Equal to

<> Not equal to

< Less than

> Greater than

<= Less than or equal to
>= Greater than or equal to

In addition, the OR and AND operators allow you to enter additional criteria in the same field or dif-
ferent fields.

Values are numbers, dates, or character strings. Character strings such as “F”, “M”, or “Workout
Gear” are enclosed in quotation marks. Dates are enclosed in pound signs (#), as in #1/1/99#.

The following table shows some examples of possible expressions.

Expression Result

[Sales Amount] + [Sales Tax] Sums values in two fields.
“F" OR "M" Restricts entry to the letters F or M only.
>= #1/1/99# AND <= #12/31/99# Restricts entries to dates greater than or equal

to 1/1/99 and less than or equal to 12/31/99.

“Workout Gear” Allows the entry Workout Gear only.

/

You will enter the expression to restrict the data entry in the Gender field
to the letters “f” or “m.”
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The expression states that the acceptable values can only be equal to an F
or an M. Notice that Access automatically added quotation marks around
the two character strings and changed the “0” in “or” to uppercase.
Because the Format property has been set to convert all entries to
uppercase, this means that an entry of f or m is as acceptable as F or M.

Next, you will switch back to Datasheet view to test the validation rule
by entering data for the Gender field. In addition to a message box asking
whether you want to save the design changes, another message box will
appear to advise you that the data integrity rules have been changed.
When you restructure a table, you often make changes that could result in
a loss of data. Changes such as shortening field sizes, creating validity
rules, or changing field types can cause existing data to become invalid.
Because the field is new, it has no data values to verify, and a validation
check is unnecessary at this time.
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The new field was added to the table between the Home Phone and Birth
Date fields. Because the letter p is not a valid entry, Access displays the
error message you entered as the Validation Text for the field. You will
clear the error message and correct the entry.
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Select the Address
field through the Home
Phone field.

Additional Information

Drag along the column heads
when the mouse pointer is
to select the fields.

Right-click on the
selection.

Choose Hide Columns
from the shortcut
menu.

Another Method

You also can click [Fw«-| in
the Records group of the
Home tab and choose Hide
Columns.

Your screen should be
similar to Figure 2.14

The entry for the first record is accepted and displayed as an uppercase M.

,Hiding and Redisplaying Fields

To enter the gender data for the rest of the fields, you will use the First
Name field as a guide. Unfortunately, the First Name and Gender fields
are currently on opposite sides of the screen and will require you to look
back and forth across each record. You can eliminate this problem by
hiding the fields you do not need to see, and then redisplaying them when
you have finished entering the gender data.

Hiding Fields

A quick way to view two fields side by side (in this case, the First Name
and Gender fields) is to hide the fields that are in between (the Address
through Home Phone fields).
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Figure 2.14

Now that the First Name and Gender columns are next to each other, you
can refer to the first name in each record to enter the correct gender data.
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Enter the Gender field
values for the
remaining records by
looking at the First
Name field to
determine whether the
employee is male or
female.

@ Reduce the size of the
Gender column using
the Best Fit command.

Having Trouble?

Remember, to best fit data in
a column, you double-click its
right border.

Your screen should be
similar to Figure 2.15
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Figure 2.15

Redisplaying Hidden Fields

After you have entered the gender data for all of the records, you can
redisplay the hidden fields.
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You use the Unhide Columns dialog box to select the currently hidden
columns you want to redisplay. A checkmark in the box next to a column
name indicates that the column is currently displayed; column names
with no checkmarks indicate that they are currently hidden. You want to
unhide all hidden columns in your table.
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Figure 2.17

All of the fields are displayed again.

JCreating a Lookup Field

Next you decide to change the Location field in the Job table to a lookup
field that will make entering the location information easier, faster, and
less prone to errors. There are three club locations: Landis, Chesterfield,
Having Trouble? and River Mist. You want the club locations to be listed so that anyone
Refer to Concept 6 in Lab 1 entering a new employee record will merely have to choose from this list
to review Lookup fields. :

to enter the club location for that employee.

You will use the Lookup Wizard to change the existing Location field to
a lookup field that uses fixed values.

Creating a Lookup Field AC2.19
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Using g in the Fields &

Columns group of the In the first Lookup Wizard dialog box, you specify the source for the
Datasheet tab inserts a new values for the lookup field. You will enter your own values, the club
field column and starts the locations, for this field.

Lookup Wizard.
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The next step is to enter the values you want listed in the lookup field. You
also can add columns and adjust their widths to fit the values you enter, if
necessary. You only need one column, and the current width is sufficient
for the values you will enter.
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Figure 2.20

After entering the field values, you will move to the next step to enter a
field name and finish the wizard. You will leave the field name as
Location. Then you will check the field property settings established for
this field to see whether any changes are necessary.

Creating a Lookup Field AC2.21
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Click [ 2.
Click [ &=

Open the Lookup tab
in the Field Properties
section.

Your screen should be
similar to Figure 2.21
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Figure 2.21

The lookup list will display in a combo box (drop-down list) control on
forms. It gets its list values from the value list containing the values you
specified as the source. The other properties are set to the defaults for
lookup fields. The only change you want to make is to restrict the data
entry in that field to values in the lookup list. Then you will test that the
Location field is performing correctly.

www.mhhe.com/oleary ]




Change the Limit to
List property to Yes.

Having Trouble?

Select the property and click
at the end of the box to
open the drop-down list of
options.

Save the table design
and switch to
Datasheet view.

Additional Information:

If you do not save the table
design before switching
views, Access will prompt you
to save it. Click [ __ to
continue.

Click in the Location
field of the first
record.

Replace the current
location with Maldin

and press (Enter).

Your screen should be
similar to Figure 2.22

Click [ <.

Select Landis from the
list of values.

Press (Enter).

Your screen should be
similar to Figure 2.23
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A warning box advises you that the entry is not one of the listed items
because you restricted the field entries in the Location field to the lookup
values you specified.
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The Location lookup field is working correctly. Using a lookup field makes
entering repetitive information faster and more accurate.

,Finding and Replacing Data

Over the past few days, you have received several change-request forms to
update the employee records. Rather than have to scroll through all the
records to locate the ones that need to be modified, you can use the Find
and Replace feature.

~

Concept 5

Find and Replace

~

5 The Find and Replace feature helps you quickly find specific information and automatically replace it
with new information. The Find command will locate all specified values in a field, and the Replace
command will both find a value and automatically replace it with another. For example, in a table con-
taining supplier and item prices, you may need to increase the price of all items supplied by one man-
ufacturer. To quickly locate these items, you would use the Find command to locate all records with
the name of the manufacturer and then update the price appropriately. Alternatively, you could use
the Replace command if you knew that all items priced at $11.95 were increasing to $15.99. This com-
mand would locate all values matching the original price and replace them with the new price.

Finding and replacing data is fast and accurate, but you need to be careful when replacing not to
replace unintended matches.

Finding Data

The first change request is for Melissa Lettow, who recently married and
has both a name and address change. To quickly locate this record, you
will use the Find command.
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oa Close the Job table.

® Move to the Last Name
field of record 1 in the
Employee Records
table.

o .
® Click | in the Find
group of the Home tab.

Another Method

The keyboard shortcut is
+F

Your screen should be
similar to Figure 2.24
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Figure 2.24

You use the Find and Replace dialog box to specify the information you
are looking for and the way that you want Access to search the table. In
the Find What text box, you specify the criteria or a set of limiting
conditions records must meet by entering the text you want to locate. You
can enter a specific character string or use wildcards to specify the
criteria. Wildcards are symbols that are used to represent characters. The

symbol represents any collection of characters and the ? symbol
represents any individual character. For example, ?ar will locate any three-
letter text such as bar, far, and car. In contrast, *ar will locate the same
text, but in addition will expand the criteria to locate any text ending with
ar, such as star, popular, and modular.

You can further refine your search by using the options described in the
following table.
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Option Effect

Look In Searches the current field or the entire
table for the specified text.

Match Locates matches to the whole field, any
part of the field, or the start of the field.

Search Specifies the direction in which the table
will be searched: All (search all records),
Down (search down from the current inser-
tion point location in the field), or Up
(search up from the current insertion point
location in the field).

Match Case Finds words that have the same pattern of
uppercase letters as entered in the Find
What text box. Using this option makes the
search case sensitive.

Search Fields as Formatted Finds data based on its display format.

Because the insertion point is already in the field you want to search, the
Look In location is correctly specified. If you wanted to search on a
different field, you could click on the field you want in the datasheet
without closing the dialog box. You also can select the table name from
the Look In list if you want to search the entire table.

The other default options, to match the whole field and to search all
records, are also appropriately set.

First, you will use the * wildcard to find all records whose last name

begins with “1”.
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Type I* in the Find
What text box.

Click eight

times to move from
one located record to
the next.

Your screen should be
similar to Figure 2.25

.ny u n f ¥ Tozee Toom -
~ wame | Gt DdwoeslOda  Ostatisr Taslt  Dataiheet .~
[ S ‘n - EEE EE o) atoy  Tiwm A !“""‘""' ! vty
Woa' | ol 20 A 2. Sl Retvesh Wi P somns | £ rete 1 Tl
/4 J ¥ =t=iy e KOewe s Hwwes & Voge bane PR
Vemi  Cgbens < (2] Rn Tee LT o A Vs foz
» - *-
Impioyes (D « Lt Narme + Fursl Naws » Addrens . City o S » NPCO0y o MamaPhcng o Gender + BrthOdle « =
* 1 eme Oamon E389 5 At in wnea CA 2in (941) 555477 M 11
* 1308 Metand [ MOLL Willow Dr.  Maldn A FILIMO (A1) 3559301 M Vi1
+ e Framkiin Stepharve  BEVS. Litchiield Park  Maldn CA S22LING (341) 857038 een
* 19y Steee iet? 1011 1, Meliy 1n NverMint  CA 22203 (M1 5551912 M e
* sy Martines e 1920 First Ave. Vaien cA FUILING (M1) 5051088 ¥ 121039
. 13997 Gapasin <an MIIE Fountam St Maldn A SIS (M1 5550588 M i
+ e Martines " 1218/ 98!
* 22085 = ¥ M
. 20w /hm ' Ve
e Vaccars L Vaas
P " Y
Le!st ?'nf'ry beginning ’ /30197
with “L " iy
F san
BT Farguson " 2319
v 2 Mogan ] W
w24 M v STV V2
-
| (7] 3nwret Pk A Posmmattond
Socars 8 CHES b W[ S [ 4 Py - S
Samcning Poest CTRL < BRLAK 13 109 an o«

Figure 2.25

Using the wildcard located seven records whose last name starts with the
letter 1. The more specific you can make your criteria, the quicker you can
locate the information you want to find. In this case, you want to find a
specific last name, so you will enter the complete name in the Find What

text box.
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€) o ciick to

close the finished
searching
informational box.

® Click on the entry in
the Find What text box
to select it and type
lettow.

Additional Information

Because the Match Case
option is not selected in the
Find and Replace dialog box,
you can enter the text to be
located in uppercase,
lowercase, or mixed-case
letters—Access will ignore
the case and look for the
specified text.

i Click [Enane ].

Your screen should be
similar to Figure 2.26

Having Trouble?

If the Find command did not
locate this record, try it
again. Make sure that you
entered the name “lettow”
(uppercase or lowercase)
correctly and that Last Name
is the selected field in the
Look In box.
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